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1 介绍 

从 1975 年以来我一直在编写一些物理仿真器。以我几十年来一直在做物理仿真器的经验来说，我发现开发过的最好的

仿真器是面向实际应用的用户而不是面向软件公司。有一些软件公司销售的类似工具，他们致力于创造最高性能的 SPICE 程

序，我编写的 LTspice 显然要比他们更好。 

LTspice 是用来做公司内部 IC 设计的，而且已经成为了 Linear Technology Corporation 公司开发高性能模拟元件的

策略的一部分。 

不同寻常的是 LTspice 是免费发布的。出于慈善的目的，Linear Technology Corporation 没有免费发布 LTspice。我

们是一个营利性组织，免费发布 LTspice 是用来帮助客户用比其他更好的仿真软件来对 LTC 的元件进行仿真模拟。而且免费

发布的 LTspice 的版本也和用于公司内部 IC 设计的版本是一模一样的。没有任何一版软件被以任何形式人为地限制功能。 

LTspice 这些独有的特点让 LTspice 得到了广泛地应用。迄今为止在工业上，LTspice 也是压倒性地最广泛应用的

SPICE 程序。它也成为了 SPICE 程序的标准。 

LTspice XVII 是在 LTspice IV 的基础上，增加了给自带的多路监视器用的现代图形库。同时 XVII 版本还引入了： 

• 支持 64bit 操作系统。 

• UNICODE（在电路图，网表或是绘图中可以使用任何现有语言的字符）。 

• 新的元器件公式（如 IGBT，二极管慢恢复，和一个任意状态机）。 

• 改进的用户 GUI（图形化用户界面），如可以对大多数的 SPICE 命令进行编辑。 

• 可以在微软操作系统下显示原理图的缩略图和预览图。 

LTspice 的 XVII 版本是来自于 LTspice 通用版本发行的第 17 年。LTspice XVII 是通过 2016 年举行的一系列的国际研

讨会来发布的。第一次的公告是在越南河内于 2016 日年 5月 9 日发布的。 

---Mike Engelhardt / 2016 

 

[1]1975 年是当我还是青年时，在非弹性核相对论运动学用在回旋粒子加速器实验室的时候。 

 

 

 

 

1.1 软件安装 

LTspice XVII 可以运行在 32 位或 64 位的 windows7，8 或 10 的操作系统中。但是不支持 windows XP。Windows XP 用

户可以使用 LTspice IV1 版本，因为 Linear Technology Corporation 有零过时的传统，所以这个版本仍然可以使用的。 

LTspice XVII 可以在网址 http://www.linear.com 下载到。安装包的直接链接是

http://LTspice.linear.com/software/LTspiceXVII.exe。 

LTspice XVII.exe 是一个可以用于安装 LTspice XVII 的自解压的安装文件。 

LTspice XVII 经常更新。软件初次安装之后，如果你有网络权限，即可以用软件内置的菜单命令来将软件升级到最新

版本。更新过程将会首先从 Linear 公司的网站上下载一个包含软件发布时的歌文件大小和校验的主索引文件。如果发现有

文件缺失，或大小不同，或校验结果不一样，那么软件就会开始更新。如果你在你的安装中已经添加了一些元件，那么在升

级过程中数据库就会合并，当你运行自动升级的时候，这些额外添加的元件也不会丢失。 
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1] LTspice IV 将不在更新。  
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1.2 许可协议/免责声明 

版权 2001-2016 年归 Linear Technology Corporation 所有，保留所有权利。     

LTspice 是 Linear Technology Corporation 的模拟电路仿真软件。 

这个软件是受到版权保护的。你可以用它非独占的，非转让的，非转发许可的授权评测 LTC 的产品，也可以执行一些普通

的电路仿真。 

此软件归 Linear Technology Corporation 所有。你不得修改，改编，翻译，方向工程，反向编译，或是拆解 LTC 提供的

可执行软件或是元件模型。我们将不负责仿真中使用的 LTC 或是其他公司提供的第三方的模型的准确性。 

虽然我们已经尽了最大的努力来确保 LTspice 能按照描述的方式运行，但是我们并不能保证运行不出一点误差。对软件的

升级，修改或是修复都将会受到 LTC 的严格地处理。如果你想选择或是评测 LTC 产品，并在 LTspice 的安装或是使用过程中

遇到了问题，你可以在周一到周五的太平洋时间的每天上午 8点到下午 5点来拨打我们应用部门的电话（408）432-1900。

如果你不是在评测 LTC 公司的元件，我们是不能为普通的电路仿真提供技术支持的。原因是存在非常多的电脑形同，操作系

统的版本还有一些外围硬件，我们并不能保证 LTspice 能在这些所有的操作系统中正常运行。如果你用不了 LTspice，LTC

确实可以必要手段对 LTC 的开关电源 IC 提供一些设计支持。 

软件和相关的文档是以“AS IS”的方式提供的，没有任何形式的保证。Linear Technology Corporation 清楚地否认所

有其他的担保，暗示，包含，或是以特殊目的地适用性和适销性。 

在任何情况下 LTC 都不会承担无论直接或间接的因该产品的使用或无法而造成的损害赔偿责任,即使我们已经提前被告知

此类损害的可能性。 

只要是以整体的，带着所有文档，示例文件，没有更改或是额外添加的元件图形和元件模型的软件发布都是允许的。 

此软件是不允许半导体生产商用此软件对他们的元件进行设计，推广，演示或是销售的。必须要从 LTC 公司获得对于这些

应用情况使用软件的特定许可。 

 

 

 

 

 

 

 

 

 

2 操作模式 

LTspice XVII 是一个集成了 SPICE 仿真器的通用电路图创建程序。目的是创建一个电路（或者是以一个已经画好的示例电

路开始），并在仿真器中观察电路的运行状态。设计过程中会不断地利用仿真对电路进行改进，直到达成期望功能的电路。 

电路图最终都要转换成文本格式的网表文件传递到仿真器。然而网表文件通常是从 LTspice 中绘制的图形化的电路图中提取

出来的，一个输入的网表文件可以在没有电路图的情况下直接运行。操作的第二个模式有一些应用：  
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1) Linear technology 的滤波合成程序，滤波 CAD 可以合成一个网表用于 LTspice 在时域或是一个滤波电路的频率响

应的仿真。 

2) 与其他的 SPICE 程序相比，LTspice 简化了基准。 

3) 在比较老的仿真器中原理图并没有集成在 SPICE 仿真器中，一直以来一款专业的并附有经验的 SPICE 电路仿真器就

能够精通于直接用文字化的网表文件进行工作。 
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2.1 示例电路 

对于 LTspice XVII，有几种示例电路的来源，下面是路径： 

%HOMEPATH%\Documents\LTspiceXVII\examples\Educational  

这里给出了许多非商业化的 SPICE 仿真文件，并阐述了不同的分析类型，方法或是程序功能。 

在下面的这个路径中： 

%HOMEPATH%\Documents\LTspiceXVII\examples\jigs  

这里的示例仿真是针对于拥有 LTspice XVII 宏观模型的每个 linear technology 的元件。但要注意这些 jig 电路通常是为

了测试宏观模型 jigs 的，并不一定推荐参考设计。你需要审查 SMPS（开关电源）电路中的电容的值。您所在的当地的

Linear technology 的办公人员会针对于您的应用需求给出设计支持。 

 

要注意 LTspice XVII 包含可以在 windows explorer 和文件应用中预览的处理程序。 
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2.2 通用目的的原理图驱动 SPICE 

这个就是 LTspice XVII 仿真器的主要应用。只要在许可的限制范围之内，你可以自由地使用 LTspice XVII 用于你的原理图

绘制或是 SPICE 程序，甚至可以用于非 Linear Technology 生产的产品。许多公司都针对于他们自己的 EDA 工具推出了标准

化的可以用于 LTspice 的元件模型。 

  

LTspice XVII 允许用户绘制并仿真无限制的大小和和内容的电路。并支持行进波形，交叉探头，反向交叉探头和无限制的

层次结构。  
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2.3 外部生成的网表 

无论是你手动生产的或是从其他原理图绘制程序生成的网表文件，你都可以用 LTspice XVII 打开。这些文件的扩展名通常

是“.cir”，但可以理解为“.net”和“.sp”。为了提高可读性，用于网表的文字编辑器将 SPICE 语法着色。在菜单栏中

的 color preference 可以用来调整这个编辑器中的文字颜色。如果网表文件中的内容是 ASCII 格式，那么文件也将会被存

储成 ASCII 格式。否则文件就会是包含了许多现用语言字符的 UNICODE 格式，LTspice 能够轻松地读取 ASCII 格式和

UNICODE 格式的网表文件。 

 

  



LTspice XVII help 中文翻译版 

 

 

本文由微信公众号 电子帮 翻译而成，仅用于学习交流，不可用于一切商业目的活动！ 

2.4 效率报告 

如果一个时域的瞬时仿真中包含关键字“steady”的话，那么是可以从一个 DC-DC 转换器中获得效率报告的。当稳定状态被

仿真出来后，一个效率报告就会以注释文字的形式出现在原理图中。 

 

DC-DC 转换器的效率是以下面的方式获得的。为了识别输入和打印，这里应该有一个精确的电压源和一个电流源。假定电压

源为输入，假定电流源为打印。 如果负载是一个带有 instant name 的电阻，打印也可以被识别出来。电路会一直运行到仿

真器感知到稳定状态。这就需要在 SMPS 的宏观模型中写入怎样检测稳定状态。通常是通过记录误差放大器在一个时钟周期

内的平均值在几个循环中减小到一个小值来检测。然后在时钟边沿，记录存储在每个电抗中的能量，并且模拟运行另外十个

时钟周期，而不是当前消耗在每个器件中的功率。在最后一个周期的时钟边沿，再次记录存储在每个电抗中的能量，并停止

模拟。经过调整存储在电抗中的能量值，传递到负载的打印功率和由输入电压供给的输入功率的比率就是效率。因为也记录

了每个元件的功率消耗，所以是可以看到能量的加和是接近于零的。  
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在 Edit Simulation Command editor 中选中“stop simulation if steady state is detected”，通常你就可以计算出你

自己画的 SMPS 电路图的效率。在仿真结束后，使用菜单栏中的 View=>Efficiency Report 来调出效率报告。 

自动检测电路的稳定状态并不是总能工作，有时候稳定状态检测的条件过于严苛，有时又过于宽松。你可以通过调整参数

sstol 或者简单地交互式地设置效率集成的限值。 
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2.5 命令行开关 

下面的表格总结了可以用于 LTspice 可执行的 XVIIx64.exe(XVIIx86.exe on 32-bit systems)的命令行开关。 
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3 原理图编辑器 

3.1 原理图编辑器 

LTspice XVII 包含一个通用的原理图编辑程序。它允许那你起草原理图，创建元器件符号，生成网表文件，探测仿真数

据。并支持无限制的原理图大小和层次结构。 
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3.1.1 原理图编辑基础 

原理图编辑程序是用来创建一个新的原理图或是修改一个提供的示例电路。原理图的大小和层次的深度只受电脑的资源限

制。 

程序附带了 2000 多个元件符号。这些符号涵盖了 LTC 公司大部分的电源芯片，运放，比较器和许多用于电路设计的通用元

件。你也可以将你希望导入程序的元件绘制出自己的元件符号。 

 

LTspice 原理图编辑是一个“动词-名词”接口，而不是一个“名词-动词”。意思就是不再是首先要选择对象（名词），然

后再进行移动，拖拽，复制或删除（动词）。首先选择操作，然后再选择对象。因此当你想要移动，镜像，旋转，拖动或是

删除对象时，首先选择移动，拖动或删除命令。然后你可以通过点击来选中对象。也可以通过拖动一个方框来同时选择多个

对象。程序将保持移动、拖动或删除模式，直到单击鼠标右键或按下 Esc 键。“动词-名词”的方法减少了编辑原理图所用

到的鼠标语法的数量。一旦掌握了方法，用户用 LTspice 编辑原理图要比铅笔在纸上画妖快得多。 

Undo：撤销最后一条命令 

Redo：重做最后一条撤销的命令 

Text：将文本放置在的原理图上。这只是用信息对原理图进行注释。这个文本对电路没有电气影响。 
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SPICE Directive：放在原理图中的文本将包含在网表文件中。这使得原理图编辑器和 SPICE 网表可以混合使用。它可以让

你设置仿真选项，集成包含模型的文件，定义新的模型，或是使用任何有效的 SPICE 命令。你甚至可以用它来运行一个没有

符号的子电路，方法是在原理图上声明模型的实例（一个以“X”开头的 SPICE 命令），并加以定义。 

SPICE Analysis：输入/编辑一个仿真命令。 

Resister：在原理图上放置一个新的电阻。 

Capacitor：在原理图上放置一个新的电容。 

Inductor：在原理图上放置一个新的电感。 

Diode：在原理图上放置一个新的二极管。 

Component：在原理图上放置一个新的元件。这条命令会弹出一个对话框，供你浏览和预览元件库。这是电阻器，电容器，

电感器和二极管命令的一种更通用的形式。 

Rotate：旋转一个选中的对象，注意当没有选中对象时这个命令符号是灰色的。 

Mirror：镜像一个选中的对象，注意当没有选中对象时这个命令符号是灰色的。 

Draw Wire：点击鼠标左键开始画线。每次点击鼠标都会顶一个新的线段。单击现有线段，将新线段与现有线段连接起来。

右键单击用来取消当前连线。再次右击以退出此命令。你可以穿过电阻等元件画线。电线将自动切断，使电阻现在与电线串

联。 

Label Net：指定一个节点名称，这样网表产生时就不会对这个节点生成任意的名字。 

Place GND：放置一个地的符号。这个是节点“0”，用于整个电路中。 

Delete：用过点击对象或者是在对象上面拖出个方框来进行删除。 

Duplicate：通过单击对象或是在对象上面拖出个方框来进行复制。如果你在 LTspice 中同时打开了两个电路图，你可以从

一个原理图中复制一个电路到另一个电路中。在一个原理图窗口中点击复制命令，然后激活第二个原理图窗口并按住

Ctrl+V。 

Move：在你想要移动的对象上单击或是拖动出个方框，然后你就可以将这些对象移动到一个新的位置。 

Paste：当对象已经被“Duplicate”命令选中时，它将在一个新的原理图窗口中启用。 

Drag：在你想要拖动的对象上单击或是拖动出个方框，然后你就可以将这些对象拖动到一个新的位置，相应连接的线也会随

着新位置进行形变。 

Draw=>Line：在原理图上画一条线。这些线对电路没有电气影响，但是可以用注释电路。 

Draw=>Rectangle：在原理图上画一个长方形。这些线对电路没有电气影响，但是可以用注释电路。 

Draw=>Circle：在原理图上画一个圆圈。这些线对电路没有电气影响，但是可以用注释电路。 

Draw=>Arc：在原理图上画一个弧线。这些线对电路没有电气影响，但是可以用注释电路。 

Note：图形化的说明；直线、矩形、圆和弧；在默认情况下，会对齐到与用于电线和引脚的电气触点相同的网格上。在放置

这些图形时同时按住 Ctrl 键，就可以取消自动对齐。 
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3.1.2 标注一个节点名字 

电路中的每个节点都需要一个唯一的名称。您可以指定节点的名称，这样网表就不会为你编造节点的名称。请注意，在编辑

原理图时，自动生成的节点名会随着电路拓扑的变化而变化。 

一些设计人员喜欢为许多节点进行标记。我自己喜欢的，以及我向其他人推荐的方式是不标记任何节点，只通过交叉探测绘

制数据。这类似于我确定电路范围的方式：在放置波形表笔之前，我不标记任何节点。节点“0”是电路全局接地，要用特

殊的图形符号而不是名称“0”表示。 

还有一个为节点“COM”定义的图形符号，但是这个节点没有特殊的意义。也就是说，它不是 SPICE 全局公共节点，甚至不

是全局节点。有时将图形符号与与地面不同的节点关联起来是很方便的。 

如果给节点起一个以“$G_”开头的名称；例如“$G_VDD”；那么无论名称在电路层次结构中的什么位置出现，该节点都是

全局的。 

 

可以指定节点是输入、打印或双向类型的端口。这些端口类型将以不同的方式绘制，但对网表没有影响。指定端口类型可以

使电路更具可读性。全局节点也以不同的方式绘制，因为围绕名称绘制了一个框。 
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3.1.3 原理图颜色 

菜单命令工具=>颜色首选项。允许你设置用于显示原理图的颜色。您可以单击示例示意图中的一个对象，并使用红、绿和蓝

的滑块来根据你的首选项调整颜色。 
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3.1.4 放置元器件 

某些常用的元件：如电阻器、电容器和电感器，可以选择使用工具栏按钮将其放置在原理图上。对于大多数符号，使用菜单

命令 Edit=>Component 来启动一个对话框来浏览您希望的元件。 

符号浏览器包括一些重要的功能: 

1. 你可以输入符号名称的前几个字母，浏览器将跳转到该符号。 

2. 有一个按钮可以打开 LTC 公司模型的测试夹具。 

3. 显示符号及其描述。 

4. 可以选择控制面板中设置的任何符号搜索路径。
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3.1.5 设置快捷键 

菜单命令 Tools=>Control Panel=>Drafting Options=>Hot Keys 

允许你为大多数命令编写键盘快捷方式。只需鼠标单击一个命令，然后按下你希望为该命令编写的键或键组合。若要删除快

捷方式，请单击命令并按“Delete”键。

 

  



LTspice XVII help 中文翻译版 

 

 

本文由微信公众号 电子帮 翻译而成，仅用于学习交流，不可用于一切商业目的活动！ 

3.1.6 PCB 网表提取 

原理图菜单命令 Tools=>Export Netlist 

允许你为 PCB 布局生成 ASCII 网表。请注意你必须创建一组与 LTspice 符号具有相同管脚顺序的符号。一些 PCB 工具甚至没

有根据标准的 SPICE 管脚顺序定义它们的二极管到网表中。此外，LTspice 符号的管脚号通常与 LTC 公司产品的管脚号不

同，特别是当一个产品包含多个包时。 

以下格式是可用的：Accel, Algorex, Allegro, Applicon Bravo, Applicon Leap, Cadnetix, Calay, Calay90, CBDS, 

Computervision, EE Designer, ExpressPCB, Intergraph, Mentor, Multiwire, PADS, Scicards, Tango, Telesis, 

Vectron, and Wire List。 
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3.2 编辑元器件 

有三种编辑元件的方法： 

1． 专家模式：这个是你经常使用的模式。只需简单地指向你要编辑的的文本，如元件值，右键单击，然后输入你想要的文

本。当您指向文本时，如果可以编辑，鼠标光标将变成文本插入符号。 

2． 辅助模式：右键点击组件主体将进入辅助模式。这将调用一个 GUI，该 GUI 将帮助你编辑该类型的组件。当您不确定

SPICE 语法的目的时（例如为电压源输入分段线性数据），或者当您想从建模的设备列表中选择半导体时，它非常有

用。 

3． 超级专家模式：指向符号体，按住控制键，鼠标右键单击将进入超级专家模式。然后可以完全控制每个属性。您可以创

建任何您希望的属性和字符串，并且可以从原理图中选择该属性是否可见。  
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3.2.1 专家模式 

编辑一个可见的属性 

大多数可见的元件属性字段都可以通过使用鼠标指向它并单击右键来编辑。当鼠标指针指向文本时，它将变成一个文本插入

符号。这是更改组件值的一种方便方法。 
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3.2.2 辅助模式 

专门的元件编辑器 

许多元件类型，如电阻、电容、电感、二极管、双极晶体管、MOSFET 晶体管、JFET 晶体管、独立电压源、独立电流源和分

层电路块都有专门的编辑器。这些编辑器可以访问相关组件的适当数据库。要使用这些编辑器，请右键单击元件的主体。
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3.2.3 超级专家模式 

通用属性编辑器 

有时需要直接访问每个可用的元件属性来编辑其内容和可见性。可以通过将鼠标放在符号体上、按住 control 键并单击鼠标

右键来访问允许您这样做的编辑器。将出现一个显示所有可用符号属性的对话框。每个字段旁边都有一个复选框，用于指示

该字段是否应该在原理图上可见。 

 

属性 SpiceModel、Value、Value2、SpiceLine 和 SpiceLine2 都是元件的整体值的一部分。根据 SPICE 在网络上列出元件的

方式，组件将生成如下图所示的 SPICE 行: 



LTspice XVII help 中文翻译版 

 

 

本文由微信公众号 电子帮 翻译而成，仅用于学习交流，不可用于一切商业目的活动！ 

<name> node1 node2 [...] <SpiceModel> 

+ <Value> <Value2> <SpiceLine> <SpiceLine2> 

如果前缀属性字符与引用指示符的第一个字符不同，则在引用指示符的前面加上前缀。前缀字符和 InstName 将分开“§”

字符。例如如果你有一个前缀属性的“M”和一个 InstName 属性“Q1”,这个名字在网表将 M§Q1。这允许您使用与 SPICE

使用不同的前导字符的引用指示符来标识设备的类型。 

以上规则有三个例外。有一个特殊的符号，跳线，它不转换成电路元素，而是一个指向网表生成器的指令，对于相同的电相

同的节点有两个不同的名称。另一个例外是定义了一个前缀为“X”的符号，并定义了一个值和 Value2 属性。这样的组件网

络列出了两行 SPICE： 

.lib <SpiceModel> 

<name> node1 node2 [...] <Value2> 

这允许自动包含元件调用的子电路定义的库的符号被定义。网表编译器删除重复的.lib 语句。注意，这些元件在原理图上

是不可编辑的。第三个异常是一个符号，这个符号定义了一个前缀为“X”的符号和一个定义了 ModelFile 属性的符号。这

样的元件也可以列出两行 SPICE： 

.lib <ModelFile> 

<name> node1 node2 [...] <SpiceModel> <Value> <Value2> <SpiceLine> <SpiceLine2> 

当您想要自动包含库文件而又想要具有可编辑符号的实例时，请使用此方法。如果符号属性 SpiceModel 存在，并且是指定

为<ModelFile>的文件中的子电路的名称，那么在原理图上编辑符号的实例时，所有子电路名称的下拉列表将可用。 
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3.3 创建新的元件符号 

符号可以用来表示如电阻器或电容器那样的原始元件；存储在单独文件中的子电路；或者另一页原理图。本节描述如何定义

自己的新符号。要启动新符号，请使用菜单命令 File=> new symbol。  
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3.3.1 画元件主体 

您可以将符号的主体绘制为一系列直线、矩形、圆和弧。这些物体对电路没有电影响。您还可以使用对电路没有影响的

draw => text 命令在符号上绘制文本。这些物体的锚点是用小红圈画出来的，这样你就知道在拖动它们的时候要抓什么

了。您可以在菜单命令 View=>Mark Object anchor 中切换红色标记。 
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3.3.2 添加管脚 

引脚允许电气连接到符号。使用菜单命令 Edit=>Add Pin/Port 添加新管脚。 

 

“引脚标签位置”决定引脚标签如何显示。“上”、“下”、“左”和“右”是文本位置调整。例如，如果大头针标签是顶

部对齐的，大头针(标签的文本对齐的锚点)将位于标签的上方。如果符号表示来自库的 SPICE 原语元素或子电路，则 pin 标

签对电路没有直接的电气影响。但是，如果符号表示层次结构原理图的低层原理图，则 pin 名称与低层原理图中的 net 名称

一样重要。 

“Netlist Order”确定此引脚用于 SPICE 的 Netlist 顺序。 
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3.3.3 添加属性 

你可以使用菜单命令 Edit=> attributes =>Edit attributes 为符号定义默认属性。最重要的属性称为“前缀”。这决定了

符号的基本类型。如果符号用于表示 SPICE 原语，则该符号应该具有适当的前缀，R表示电阻、C 或电容，M表示 MOSFET，

等等。如果要用符号表示库中定义的子电路，前缀应该是“X”。 

 

符号的属性可以作为原理图中的元件在符号的实例中重写。例如，如果你有一个前缀属性为“M”的 MOSFET 符号，你可以在

一个实例的基础上覆盖前缀为“X”，这样晶体管就可以被建模为子电路。 

有一个特殊的属性组合，将导致所需的库自动包括在每个使用符号的原理图中: 

Prefix: X 

SpiceModel: <name of file including the spicemodel> 

     Value: <What ever you want visible on the schematic> 

    Value2: <The value as you want in the netlist> 

Value2 将与包括 spicemodel 在内的文件中定义的子电路名称相一致，并且可以将其他参数传递给子电路。当以这种方式定

义符号时，不能编辑符号作为原理图上的组件的实例，使其具有不同的属性。 
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如果您希望符号表示分层示意图的另一页，则所有属性都应留空。符号类型应从“单元格”更改为“块”。不需要设置属性

值。 

可以指定一个符号属性 ModelFile。这用于将作为库包含在 netlist 中的文件的名称。如果 prefix 属性是“X”，并且在模

型文件中定义了符号属性 SpiceModel，那么在示意图上编辑符号的实例时，所有子电路名称的下拉列表将可用。 
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3.3.4 属性可见性 

你可以使用菜单命令 edit => attributes =>Attribute 窗口编辑属性的可见性。在使用此对话框选择属性之后，你将能够

根据符号的需要对其进行定位。 

 

您可以通过右键单击属性的文本来修改已经可见的属性的文本对齐方式和内容。 
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3.3.5 自动生成元件符号 

符号可以在两种情况下自动生成: 

1. 编辑原理图时，可以执行菜单项层次结构=>打开此工作表的符号。当没有找到符号时，LTspice 将询问你是否希望自动

生成一个符号。这个符号可以用来在一些更高层次的原理图中调用这个电路表。请注意，如果你编辑了原理图的端口，那么

该符号将不再对原理图正确地进行网表，你应该删除该符号并重新生成它。 

2. 当编辑包含子电路定义的 ASCII 网络列表时，将光标放在包含子电路名称的行上，右键单击并执行上下文菜单项

“Create Symbol”。对于大多数用户来说，这是你应该考虑的添加定义为子电路的第三方模型的唯一方法，因为所有的细

节都是为你处理的。 
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3.4 层次结构 

原理图分层绘制具有强大的优势。在保持较小原理图的可读性的同时，可以将较大的电路绘制在一页原理图上。那些重复的

电路可以以概括的方式处理。电路可以存储成模块，以便以后的项目调用。 
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3.4.1 层次结构的规则 

在高层级的原理图中以模块的形式调用一个原理图的方法就是创建一个同样名字的原理图模块图形符号，然后将这个图形符

号放置在高层级的原理图上。例如，如果你有一个叫做 XYZ.asc 的顶层原理图，和另一个你想要放在顶层 XYZ.asc 中的叫做

preamp.asc 的原理图，那么你就要创建一个叫做 preamp.asy 的模块符号，然后再将这个符号放置到顶层 XYZ.asc 的原理图

中。原理图之间的电气连接是通过顶层原理图的线到可以匹配到低层原理图中节点名字。用于模块原理图的符号名字和相应

的原理图必须要保持一致。而且不能包含空格字符。

 

LTspice 会在顶层原理图中寻找模块和符号来完成顶层原理图的构建。你为低层原理图模块创建的符号不会定义任何属性。 
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3.4.2 浏览层次结构 

以 File=>Open 命令打开的都被定义为顶层原理图。你可以在这上面添加 SPICE 命令，运行仿真，并引用任一低层原理图。

要打开一个在高层级原理图中的原理图模块，首先要打开一个高层及的原理图，然后将鼠标移动到模块符号的主体上。当在

符号的主体上进行鼠标右键单击的时候，就会探出一个特殊的对话框让你打开原理图。当你用这种方式打开原理图的时候，

你可以在这个模块中使用交叉电压探针和电流探针。注意你应该提前在 Control Pannel 中的 Save Defaults Pane 勾选

"Save Subcircuit Node Voltages" 和"Save Subcircuit Device Currents"。另外，如果你在顶层原理图上高亮了一个节

点，那么该节点也会在低层原理图模块中高亮出来。 

 

注意，对话框还允许你输入参数，以传递到 preamp.asc 中的电路实例。 
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4 波形查看器 

LTspice XVII 包括了一个集成的波形查看器，它可以实现仿真数据绘图方式的完全控制。  
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4.1 数据轨迹选择 

有三种选择数据轨迹选择方式： 

1． 直接从原理图中探测。 

2． 使用菜单命令 Plot Setting=>Visible Trace. 

3． 使用菜单命令 Plot Setting=>Add Trace. 

无论是用上述的哪种方式，撤销和重做命令允许你查看选中的不同的波形轨迹。 

1．直接从原理图中机型探测： 

 

探测电路图是最简单的方法。你只需要简单地点一根电线就可以画出那根电线上的电压。像那些有两个端子连接的元件（如

电阻，电容或是电感），你可以通过点击元件主体来描绘出通过它们的电流。如果你保存了所有的子电路电压和电流，那么

它可以在电路的任何层级上工作。你也可以通过单击元件符号上的特定的管脚来绘制出电流波形。如果你双击同一个电压或

是电流，那么所有其他的轨迹将会被删除，被双击的轨迹将会自动绘制出来。你可以在选择了删除命令之后，通过单击轨迹

波形的标签来进行删除。下面的屏幕截图展示了如何指向一个元件管脚的电流。注意，当鼠标指针指向管脚电流时，它会变
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成一个看起来像一个电流钳的图标。按照惯例，如果电流进入引脚，则电流方向为正。
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也可以用鼠标来指示电压差，你可以单击一个节点并将鼠标拖动到另一个节点。您将在第一个节点上看到红色的电压探针，

在第二个节点上看到黑色的探针。这使你可以绘制不同基准的电压:

 

还有一种原理图探测技术是绘制一个元件的瞬时功率图。实现的方法是按住 ALT 键并单击元件的符号主体。瞬时功率将会以

电压和电流的表达式的方式绘制。他将会在自己的标度上以瓦特为单位绘制出来。当鼠标指针指向一个可以绘制的功率时，
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就会变成一个类似于温度计的图标。你可以通过单击轨迹标签来找到平均功率。

 

你也可以探测导线中的电流。通过按住 ALT 键并单击连线来实现。鼠标指针变成电流钳形仪表，指示它指向这个电流，红色

箭头显示正电流的方向。 
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2．使用菜单命令 Plot Setting=>Visible Trace： 

注意，很有可能只列出了和模式匹配的轨迹的名称。当有许多轨迹并且你只知道部分名字时，这样就很有用。 

在一个仿真绘图开始时，菜单命令 Plot Setting=>Visible Trace 会探出一个对话框。你可以选择初始的轨迹进行绘制，也

可以随机的绘制轨迹列表中的任意一条。 
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3．使用菜单命令 View=>Add Trace： 

命令 Plot Setting=>Add Trace 和命令 Plot Setting=>Visible Trace 是类似的。但是你不能用它来删除一个已经可见的轨

迹。它有两个好用的功能。一个是允许你在对话框的顶部附近的编辑框中输入一串字符。在对话框中只会显示与模式匹配的

轨迹名字。当你只记住了部分轨迹的名字时，这一个功能就对查找轨迹非常有用。此外，编写跟踪数据的表达式要容易一

些，因为您可以单击对话框中的名称，而不是键入其名称。 
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4.2 放大缩小 

每当有新数据要绘制时，LTspice XVII 都可以自动放大或缩小。若要放大某个区域，只需在你希望看到更大区域上简单地

拖动出个方框即可。 

 

值得注意的是缩放框的大小会显示在底部的状态栏上，这样你就可以在不设置附带的游标的情况下快速测量波形的差异。 

工具栏和菜单栏上也有用于所缩小，平移和返回自动缩放的命令。你可以使用撤销和重做命令来查看不同的缩放设置。 

另一种缩放模式是按住 CTRL 键的同时移动鼠标或是旋转鼠标滚轮。软件将缩放和平移当前绘图的位图，以显示完整呈现后

的绘图。这种模式适用于需要几秒钟重新绘制的巨大波形文件。 
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4.3 波形运算 

对波形数据可以进行三种数学运算: 

1. 绘制表达式的轨迹。 

2. 计算轨迹的平均值或均方根。 

3. 显示跟踪的傅里叶变换。 

1. 绘制表达式的轨迹。 

View=>Visible Trace 和 View=>Add Trace 命令都允许输入轨迹数据表达式。另一种绘制仿真数据轨迹表达式的方法是将鼠

标移动到跟踪的标签并右击。弹出的对话框允许你设置轨迹的颜色，并允许你将光标附加到波形上。LTspice 将对表达式进

行量纲分析，并将其绘制在标有这些单位的垂直轴上。例如，下面你可以看到表达式-

2*p*pow(V(out),2)/abs(V(n001))/Ie(x1:Q1)以Ω的尺寸。具有相同单位的绘图窗格中的所有波形都绘制在相同的轴上。 
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两个电压的差值；例如，V(a)-V(b)；可以同等地写成 V(a,b)。在实际应用中可以使用以下的表达式： 

Function Name Description 

abs(x) Absolute value of x 

acos(x) Arc cosine of x 

arccos(x) Synonym for acos() 

acosh(x) Arc hyperbolic cosine 

asin(x) Arc sine of x 

arcsin(x) Synonym for sin() 

asinh(x) Arc hyperbolic sine 

atan(x) Arc tangent of x 

arctan(x) Synonym for atan() 

atan2(y,x) Four quadrant arc tangent of y/x 

atanh(x) Arc hyperbolic tangent 

buf(x) 1 if x > .5, else 0 

ceil(x) Integer equal or greater than x 

cos(x) Cosine of x 

cosh(x) Hyperbolic cosine of x 

d() Finite difference-based derivative 

exp(x) e to the x 

floor(x) Integer equal to or less than x 

hypot(x,y) sqrt(x**2 + y**2) 
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if(x,y,z) If x > .5, then y else z 

int(x) Convert x to integer 

inv(x) 0. if x > .5, else 1. 

limit(x,y,z) Intermediate value of x, y, and z 

ln(x) Natural logarithm of x 

log(x) Alternate syntax for ln() 

log10(x) Base 10 logarithm 

max(x,y) The greater of x or y 

min(x,y) The smaller of x or y 

pow(x,y) x**y 

pwr(x,y) abs(x)**y 

pwrs(x,y) sgn(x)*abs(x)**y 

rand(x) Random number between 0 and 1 depending on the integer value 

of x. 

random(x) Similar to rand(), but smoothly transitions between values. 

round(x) Nearest integer to x 

sgn(x) Sign of x 

sin(x) Sine of x 

sinh(x) Hyperbolic sine of x 

sqrt(x) Square root of x 

table(x,a,b,c,d,...) Interpolate a value for x based on a look up table given as a 

set of pairs of points. 
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对于复杂 的数据，

以下函数 是行不通

的：

atan2(,), sgn(), u(), buf(),  inv(),uramp(), int(),   floor(), ceil(), rand(), min(,), limit(,), if(,,), 和 

table(...)。 

函数 Re(x)和 Im(x)可用于复杂数据，返回的复数实部分别等于实部或虚部，虚部等于零。 

函数 Ph(x)和 Mag(x)也可用于复杂数据，返回的复数实部分别等于参数的相角或大小，虚部等于零。 

函数 conj(x)也可用于复杂数据，并返回 x 的复共轭。 

下列操作，按求值的优先次序排列，可用于实际数据: 

Operand Description 

& Convert the expressions to either side to Boolean, then AND. 

| Convert the expressions to either side to Boolean, then OR. 

^ Convert the expressions to either side to Boolean, then XOR. 

> TRUE if expression on the left is greater than the expression on the 

right, otherwise FALSE. 

< TRUE if expression on the left is less than the expression on the right, 

otherwise FALSE. 

>= TRUE if expression on the left is greater than or equal the expression on 

the right, otherwise FALSE. 

<= TRUE if expression on the left is less than or equal the expression on 

the right, otherwise FALSE. 

+ Addition 

- Subtraction 

tan(x) Tangent of x. 

tanh(x) Hyperbolic tangent of x 

u(x) Unit step, i.e., 1 if x > 0., else 0. 

uramp(x) x if x > 0., else 0. 

white(x) Random number between -.5 and .5 smoothly transitions between 

values even more smoothly than random(). 
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* Multiplication 

/ Division 

** Raise left hand side to power of right hand side. 

! Convert the following expression to Boolean and invert. 

@ Step selection operator 

TRUE 在数值上等于 1 FALSE 等于 0。如果值大于 0.5，则将值转换为 1，否则将值转换为 0。 

步骤选择操作符“@”在.step、.temp 或.dc 分析中有多个模拟运行时非常有用。它从特定的运行中选择数据。例如，无论

选择哪个步骤进行绘制，V(1)@3 将绘制第三次运行时的数据。 

对于复杂数据，只有+、-、*、/、**和@可用。也对复杂数据,逻辑异或操作,据悉,^求幂,* *。 

以下常量是内部定义的: 

 

Name Value 

E 2.7182818284590452354 

pi 3.14159265358979323846 

K 1.3806503e-23 

Q 1.602176462e-19 

在绘制瞬态分析波形数据时，理解关键字“时间”。类似地，“freq”和“omega”在绘制 AC 分析数据时也可以理解。w 可

以作为 omega 的同义词。 

2. 计算轨迹的平均值或均方根： 

波形查看器可以集成轨迹以获得显示区域上的平均值和均方根值。首先将波形放大到感兴趣的区域，然后将鼠标移动到跟踪

的标签，按住 CTRL 键并单击鼠标左键。 
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注:RMS 平均值仅在集成量的物理单位为伏特或安培时才报告，以避免在集成电源时使需要平均值的人感到困惑。 

3.显示跟踪的傅里叶变换： 

你可以使用菜单命令 View=>FFT 对各种数据轨迹执行快速傅里叶变换。 
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LTspice 使用一种专有的 FFT 算法，允许任意数量的数据点，不限于 2 的幂。 

当你希望对仿真数据进行 FFT 时，你可能希望关闭波形压缩，规定最大时间步长，甚至可能使用双精度波形文件格式来降低

数值噪声下限。下面的 netlist 显示 LTspice 的 FFT 算法的固有噪声下限超过 300dB。 
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4.4 用户自定义函数 

菜单命令 Plot Setting=>Edit Plot Defs File 允许你在波形查看其中输入自己的函数定义和参数定义。这些函数保存在文

件%HOMEPATH%\Documents\LTspiceXVII\plot.defs 中。 

语法与用于参数化电路的.param 和.func 语句相同。例如, .func Pythag(x,y){√x * x + y * y)}。是定义函数 Pythag()

为其两个参数之和的平方根。 

同样地.param twopi = 2*pi 是定义两个 pi为 6.28318530717959。注意它使用了波形查看器内部定义的常数 pi。 
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4.5 轴向控制 

当鼠标移动到数据绘图区域之外时，光标变为标尺。这表示你正在指向该轴的属性。当你点击左键时，你可以进入一个对话

框，手动输入轴的范围和绘图的性质。例如，对于实际数据，如果您将鼠标移动到屏幕底部并单击鼠标左键，你可以输入一

个对话框来更改绘制的水平数量。这让你可以画参数图。 

对于复杂的数据，你可以选择绘制相位、分组延迟或不针对右垂直轴绘制任何内容。通过将鼠标移动到复杂数据的左垂直

轴，可以将复杂数据的表示形式从 Bode 更改为 Nyquist 或 Cartesian。 
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4.6 绘图窗格 

多个绘图窗格可以显示在一个窗口上。这允许更好地区分轨迹，并允许不同的轨迹独立地自动伸缩。可以通过拖动标签在窗

格之间拖动跟轨迹。在释放鼠标按钮时按住 CTRL 键，可以在另一个窗格上创建轨迹的副本。 
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4.7 颜色设置 

菜单命令 Tools=>Color Preferences colors 允许你设置用于绘制数据的颜色。单击示例绘图的主体，然后使用红色，绿色

和蓝色的滑块来调整你首选项中的颜色。 
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4.8 附带的游标 

每个绘图窗口最多有两个附带的游标。你可以通过鼠标左键单击轨迹标签将光标加到轨迹上。你也可以通过右键单击轨迹标

签并选择"1st & 2nd"来将两个游标驾到单个轨迹上。你还可以通过右键单击轨迹的标签并使用附加的光标下拉框将第一个

或是第二个游标或是两个游标附加到任何轨迹上。附加的游标可以用鼠标拖动或用光标键移动。 

 

当有活动的附加游标时，将出现一个 readout 显示，该显示将读取游标上的数据并报告差异。  
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注意还有一个独立于附加游标示值读数的鼠标游标示值读数。当你将鼠标移到波形窗口上时，鼠标的位置将在状态栏上显示

出来。如果你像缩放那样拖动鼠标，状态栏上会显示框的大小。这可以让你快速地测量出鼠标光标之间的差异。如果横坐标

是时间，那么时间差也可以被转换成频率。 
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你可以用这种方式测量差异，而不用执行缩放，只需在释放鼠标左键之前按下 Esc 键或是鼠标右键。 
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附加游标还可以用于读取.step/.d/.temp 的哪个轨迹属于哪个仿真运行。你可以使用向上/向下键盘光标键将光标从一个数

据集导航到另一个数据集，然后右键单击光标以查看该运行的步骤信息。 
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4.9 保存绘图配置 

菜单命令 Plot Settings=>Save Plot Setting/Open Plot Setting Files，允许你将绘图配置读写到磁盘。绘图设置文件

是扩展名为.plt 的 ASCII 文件。默认的文件名是通过将数据文件的扩展名”.plt”替换成”.raw”，如果在第一次打开数

据文件时存在这样的文件名，则读取该绘图设置文件进行初始绘图配置。 

每个分析类型.tra，.ac，.noise 等，在绘图设置文件中都有自己的项。将设置从一种分析类型加载到另一种分析类型是不

可能的。但是你可以使用来自相同分析类型的另一个仿真的绘图设置文件。 
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4.10 快速存取文件格 

在仿真过程中，LTspice 通常使用一种压缩的二进制文件格式，允许在不修改文件其余部分的情况下追加其他仿真数据。但

是一旦仿真完成，为了在文件中添加单个新的绘图轨迹，这种文件格式的访问速度可能会很慢。 

为了缩减这个时间，你可以将文件转换成另一种快速访问的格式。这种格式只能在仿真完成后，没有新数据添加到文件时才

可以执行。但是一旦文件转换成这种格式，新轨迹的加载时间通常会减少一个因子，该因子等于文件中保存的数据轨迹的数

量。例如，如果你有一个包含 2000 个数据轨迹的 5GB 文件，那么添加一个新的跟踪可能需要 4 分钟。但是在将其转换为快

速访问格式之后，这 4 分钟的加载时间将减少到 1 秒。这使得交叉探测大型电路与庞大的仿真数据文件具有交互性。从快速

访问格式文件加载轨迹所需的确切时间更多地取决于物理内存的数量，而不是硬盘速度。 

若要将波形窗口转换为快速访问格式，请将波形窗口设置为活动窗口，并执行菜单命令 Files=>Convert to Fast Access。

转换过程将需要与要转换的文件大小相等的空闲磁盘空间，但转换后的文件仅比原始文件大 11 字节。 

转换过程可能需要很长时间，并且会占用你物理内存的四分之一。实际上，将文件转换为快速访问格式要比初始仿真所需的

时间更长。转换所需的确切时间取决于硬盘碎片的状态和物理内存的数量等因素。在转换过程中，您可能会发现你的计算机

对鼠标和键盘的响应不是很好。可以使用以下命令行语法在批处理命令中转换文件: 

XVIIx64.exe -FastAccess <file> 

其中<file>是要转换为快速访问格式的.raw 文件的名称。 

这种格式只支持真实数据，不支持. ac 分析中的复杂数据。  
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4.11 内存、RAM 和地址空间 

LTspice 是第一个基于 PC 的 SPICE 程序，它在硬盘上实现了自己的 64 位地址空间，允许用户查看几乎无限大的波形数据文

件。 

LTspice XVII(XVIIx86.exe)的 32 位版本可以处理包含许多 Gb数据的数据文件，但一次只能处理大约 3G 的页面，以便在波

形查看器中绘图。 

64 位版本的 LTspice XVII(XVIIx64.exe)可以使用与已安装的内存一样多的内存，但仍然将大部分数据保存在磁盘上，以便

查看超出物理内存的波形文件。注意，目前的 64位处理器在 32位处理器上只有一些额外的地址行。 
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5 LTspice 

LTspice XVII 是以原理图驱动的电路仿真程序。LTspice 仿真器最初是基于 Berkeley SPICE 3F4/5 开发的。模拟器经过了

完整的重写，以提高模拟器的性能，修复 bug，并对模拟器进行扩展，使其能够运行行业标准的半导体和行为模型。增加了

数字仿真能力，包括协同仿真。对模拟 SPICE 仿真器进行了大量的改进，例如在稀疏矩阵求解器中进行并行处理和动态装

配，以及生成目标代码，使 LTspice XVII 成为业界最高级的模拟仿真器。 

LTspice 旨在用作你的通用 SPICE 仿真器。可以用内置的原理图捕捉来绘制新的电路。使用已建立的 SPICE 语法，仿真命令

和参数作为文本放置在原理图上。仿真过程中或仿真结束后，点击原理图节点上的鼠标，即可绘制出电路节点和元件电流波

形。 

补充本文档的一个宝贵参考资料是 Giuseppe Massobrio 和 Paolo Antognetti, McGraw Hill, 1993 年和后来的重印的

SPICE 的第二版半导体器件建模。那本书记录了已经被用于各种商业 SPICE 程序包括 LTspic 程序中的半导体元件方程和扩

展。对于 BSIM 3 和 4元件，请参阅加州大学伯克利分校 CAD 组提供的相关文档。 

LTspice 是凌特半导体公司的注册商标。 
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5.1 介绍 

电路说明 

电路通过一个网表文本文件进行定义。网表中包含电子元件，节点，模型定义和其他 SPICE 命令的列表。 

网表通常以图形化方式输入。要开始一个新的原理图，选择菜单命令 File=>Open。将出现一个 windows 文件浏览窗口。选

择现有的原理图并将其保存在新名称下，或者键入新名称以创建新的空白原理图文件。LTspice 使用许多不同类型的文件和

文档。你需要创建一个文件名扩展名为“.asc”的文件。schematic capture 命令位于 Edit 菜单下。命令的键盘快捷键列

在 Schematic Editor Overview 下。 

当仿真一个原理图时，网表信息将从原理图图形信息提取到与原理图同名但文件扩展名为“.net”的文件中。LTspice 将读

取此网表。 

你还可以打开、模拟和编辑手动或外部生成的网表文本。LTspice 会认为扩展名为”.net”,”.cir”或是”.sp”文件为网

表文件。 

本节的帮助文档记录了网表中使用的语法，但偶尔会给出原理图层次的建议。  
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5.1.1 一般机构和惯例 

要分析的电路是用一个叫做网表的文本文件来描述。网表中的第一行假定为是注释，可以被忽略。网表的最后一行通常

以”.END”结束，也可以省略。在这一行之后的任何行都可以被忽略。 

注释和结束之间的行顺序无关。行可以是注释、电路元件声明或仿真指令。让我们从一个例子开始: 

* This first line is ignored 

* The circuit below represents an RC circuit driven 

* with a 1MHz square wave signal 

R1 n1 n2 1K ; a 1KOhm resistor between nodes n1 and n2 

C1 n2 0 100p ; a 100pF capacitor between nodes n2 and ground 

V1 n1 0 PULSE(0 1 0 0 0 .5μ 1μ) ; a 1Mhz square wave 

.tran 3μ ; do a 3μs long transient analysis 

.end 

前两行是注释。任何以“*”开头的行都是注释，可以被忽略。以“R1”开头的这条线表示节点 n1 和 n2 之间有一个 1K 的电

阻。注意分号";"，可用于在一行中间开始注释。以“C1”开头的这条线表示节点 n2 和地面之间有一个 100pF 的电容。节点

“0”是全局电路的公共基准。 

下面是 LTspice 词典的概述: 

• 前导空格、空格和制表符将被忽略。 

• 下面 A-Z 的字符和下面微软的 OEM 字符也都忽略。 

• 第一个非空白的字符定义了电路元件的类型。 

Leading Character  Type of line 

* Comment 

A Special function device  

B Arbitrary behavioral source  

C Capacitor  

D Diode  

E Voltage dependent voltage source  

F Current dependent current source  

G Voltage dependent current source  

H Current dependent voltage source  

I Independent current source  
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J JFET transistor  

K Mutual inductance  

L Inductor  

M MOSFET transistor  

O Lossy transmission line  

Q Bipolar transistor  

R Resistor  

S Voltage controlled switch  

T Lossless transmission line  

U Uniform RC-line  

V Independent voltage source  

W Current controlled switch  

X Subcircuit Invocation 

Z MESFET or IGBT transistor  

. A simulation directive, For example: .options reltol=1e-4 

+ A continuation of the previous line. The "+" is removed and the remainder 

of the line is considered part of the prior line. 

数字不仅可以用科学符号来表示；例如,1 e12；也使用工程乘数。也就是 1000.0 或者 1e3 也可以写成 1K。下面是一个理解

乘数的表格: 

Suffix Multiplier 

T  1e12 

G  1e9 

Meg  1e6 
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K  1e3 

mil  25.4e-6 

m  1e-3 

u(or μ) 1e-6 

n  1e-9 

p  1e-12 

f  1e-15 

后缀不区分大小写。数字或工程乘法器后面的未识别字母将被忽略。因此，10、10V、10V 和 10Hz 都表示相同的数字，M、

MA、MSec 和 MMhos 都表示相同的比例因子(0.001)。一个常见的错误是绘制一个值为 1M 的电阻器，考虑到一个 1 兆欧姆的

电阻器，然而，1M 被解释为一个 1毫欧姆的电阻器。这对于与标准 SPICE 实践的兼容性是必要的。 

LTspice 将接受表格 6K34 中表示 6.34K 的数字。这适用于上面的任何乘数。切换到 Tools=>Control Panel=>SPICE 并取消

勾选“Accept 3K4 as 3.4K”即可关闭。 

节点名可以是任意的字符串。全局电路公共节点(接地)为“0”，“GND”为特殊同义词。注意，由于节点是字符串，“0”

和“00”是不同的节点。 

在手册的以下部分中，需要填充特定信息的数据字段周围都用尖括号括起来；例如“<srcname>”将是某个特定源的名称。

方括号表示所包含的数据字段是可选的。 
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5.2 点命令 

仿真指令—点命令 

要运行模拟，不仅要定义电路，而且要定义需要执行的分析类型。有六种不同类型的分析:线性化的小信号交流、直流扫

描、噪声、直流工作点、小信号直流传递函数和瞬态分析。在运行模拟时，必须精确地指定这六种分析中的一种。 

虽然电路拓扑通常是原理图中画出的，但命令通常作为文本放在原理图上。所有这些命令都以点开头，称为“点命令”。 
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5.2.1 .AC--对直流工作点进行线性化的小信号交流分析 

LTspice 的小信号(线性)交流分析计算交流复节点电压作为频率的函数。首先，找到电路的直流工作点。接下来，对电路中

所有非线性器件的小信号模型进行了线性化，得到了该工作点的小信号模型。最后，以独立电压源和电流源为驱动信号，在

给定频率范围内的频域内求解线性化电路。 

这种分析模式适用于滤波器、网络、稳定性分析和噪声考虑。你可以在这里找到一个基本的例子。 

Syntax: .ac <oct, dec, lin> <Nsteps> <StartFreq> <EndFreq>  

        .ac list <FirstFreq> [<NextFreq> [<NextFreq> ...]] 

频率在频率 StartFreq 和频率 EndFreq 之间进行扫频。步骤数由关键字“oct”、“dec”或“lin”和 Nsteps 定义，如下表

所示: 

Keyword Nsteps 

oct No. of steps per octave  

dec No. of steps per decade  

lin Total number of linearly spaced steps between StartFreq and 

EndFreq 

语法”.ac list <Freq>"，与.step 结合使用单个分析频率。它允许你将复杂数据绘制为阶跃参数的函数，如本示例所示。 
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5.2.2 .BACKANNO--将子电路引脚名称标注到端口电流 

语法:.backanno 

该指令自动包含在由原理图生成的每个网表中。它指示 LTspice 在.raw 文件中包含信息，这些信息可用于通过管脚名称引

用端口电流。这允许你通过单击符号的管脚来交叉探测管脚的电流。 
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5.2.3 .DC--执行直流源扫描分析 

它在扫描源的直流值时执行直流分析。它可用于计算放大器的直流传递函数或绘制晶体管的特性曲线以进行模型验证。 

Syntax: .dc <srcnam> <Vstart> <Vstop> <Vincr> 

        + [<srcnam2> <Vstart2> <Vstop2> <Vincr2>] 

<srcnam>是一个独立的电压或电流源，在<Vincr> step size 下，从<Vstart>扫到<Vstop>。在下面的例子中，绘制了默认

的 BSIM3v3.2.4 特征曲线: 

* Example .dc sweep 

* 

M1 2 1 0 0 nbsim 

Vgs 1 0 3.5 

Vds 2 0 3.5 

.dc Vds 3.5 0 -0.05 Vgs 0 3.5 0.5 

.model nbsim NMOS Level=8 

.save I(Vds) 

.end 
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5.2.4 .END--网表文本的结束 

这个指令标志着网表文本的结束。这一行之后的所有行都将被忽略。不要把它作为原理图上的文本，因为网表提取器会在最

后提供它。 
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5.2.5 .ENDS--子电路定义的结束 

这个指令标志着子电路定义的结束。更多信息可以参见. subckt。  
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5.2.6 .FOUR--在.TRAN 分析之后计算傅里叶分量 

Syntax: .four <frequency> [Nharmonics] [Nperiods] <data trace1> [<data trace2> ...] 

Example: .four 1kHz V(out) 

此命令在暂态分析之后执行。它是为了与遗留的 SPICE 仿真兼容而提供的。此命令的打印将打印在.log 文件中。使用菜单

命令“View=>Spice Error Log”查看打印。对于大多数目的，波形查看器中内置的 FFT 功能更有用。 

如果存在整数次谐波，则分析包含该次谐波的个数。如果没有指定，谐波的数量默认为 9。 

傅里叶分析的周期是从最后一次，趋于，到趋于之前的一个周期，除非在非谐波之后给出一个整数 nperiod。如果 n周期为

-1，则在整个仿真数据范围内进行傅里叶分析。 
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5.2.7 .FUNC--用户自定义函数 

Syntax: .func <name>([args]) {<expression>} 

Example: .func Pythag(x,y) {sqrt(x*x+y*y)} 

.func 指令允许创建用于用户参数化电路和行为源的用户定义函数。为了清晰起见，这对于将名称与函数关联起来以及将子

电路参数化以便将抽象电路保存在库中非常有用。 

.func 语句可以包含在子电路定义中，以将函数的范围限制为该子电路和该子电路调用的子电路。 

要使用这些用户定义的函数调用参数替换和表达式求值，请将表达式括在花括号中。封闭的表达式将被浮点值替换。 

下面是一个同时使用.func 和.param 语句的示例。 

* Example deck using a .func statement 

.func myfunc(x,y) {sqrt(x*x+y*y)} 

.param u=100 v=600 

V1 a 0 pulse(0 1 0 1n 1n .5μ 1μ) 

R1 a b {myfunc(u,v/3)} 

C1 b 0 100p 

.tran 3μ 

.end 

在仿真开始前对所有参数进行了替换评估。  
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5.2.8 .FERRET--下载一个给定 URL 的文件 

这个命令允许你通过指定 URL 以批处理模式下载文件。当你不希望必须将浏览器指向每个文件或希望阻止浏览器对文件进行

任何转换时，这是非常方便的。下载的文件将位于与源原理图或网表相同的目录中。此命令对仿真没有影响。 
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5.2.9 .GLOBAL--声明全局节点 

Syntax: .global <node1> [node2 [node3] [...]] 

Example: .global VDD VCC 

.global 命令允许你声明子电路中提到的某些节点不是子电路的本地节点，而是绝对全局节点。 

注意，全局电路公共基准是 node“0”，不需要.global 语句。此外“$G_”形式的节点名也是没有在.global 语句中声明的

全局节点。 
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5.2.10 .IC--设置初始条件 

.ic 指令允许指定瞬态分析的初始条件。可指定节点电压和电感电流。将初始条件作为约束条件，得到了直流解。请注意，

虽然在其他 SPICE 程序中，电感器通常被视为直流分析中的短路，但如果指定了初始电流，则在 LTspice 中将电感器视为无

穷大阻抗电流源 

Syntax: .ic [V(<n1>)=<voltage>] [I(<inductor>)=<current>] 

Example: .ic V(in)=2 V(out)=5 V(vc)=1.8 I(L1)=300m 
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5.2.11 .INCLUDE--包含另一个文件 

Syntax: .include <filename> 

该指令包含指定的文件，就好像该文件已经输入到网表而不是.include 命令中一样。这对于包含模型库或子电路非常有

用。 

可以为文件名输入绝对路径名。否则，LTspice 首先在目录%HOMEPATH%\Documents\LTspiceXVII\lib\sub 中查找，然后在包

含调用网表的目录中查找，最后在库搜索路径中列出的目录列表中查找。 

假设没有文件名扩展名。如果文件名为"myfile.lib"，你必须使用".inc myfile.lib" 而不是 ".inc myfile"。 

可以将以下格式的 URL 指定为文件名: 

.inc http://www.company.com/models/library.lib 

库文件”.lib”将被 http 传输到电路目录并包含在其中。对于以后的仿真，为了避免每次运行仿真时都下载文件，可以编

辑.inc 语句到 

.inc library.lib 

注意，如果你指定的 URL 不存在，大多数 web 服务器不会返回错误，而是返回一个 html web 页面，显示在 web 浏览器中，

解释错误。LTspice 不能总是将这些页面作为错误条件读取，因此当仿真尝试将仿真中包含的 html 语言错误页面作为有效

的 SPICE 语法进行处理时，你可能会得到一些神秘的错误消息。  
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5.2.12 .LIB--包括一个库 

Syntax: .lib <filename> 

该指令包含命名文件的模型和子电路定义，就好像该文件已经输入到 netlist 而不是.lib 命令中一样。全局范围的电路元

件被忽略。 

可以为文件名输入绝对路径，否则 LTspice 将首先在目录%HOMEPATH%\Documents\LTspiceXVII\lib\cmp 中查找，然后再目

录%HOMEPATH%\Documents\LTspiceXVII\lib\sub 中查找，最后在包含这个文件名的网表目录中查找。 

假设没有文件扩展名，如果文件名是"myfile.lib"，你必须使用".lib myfile.lib"而不是".lib myfile"。 

你也可以以下面的格式用一个 URL 来作为文件名： 

.lib http://www.company.com/models/library.mod 

库文件”.mod”将被 http 传输到电路目录并作为一个库包含。对于后续的仿真，为了避免每次运行仿真时都下载文件，可

以编辑.lib 语句 

.lib library.mod 

注意，如果你指定的 URL 不存在，大多数 web 服务器不会返回错误，而是返回一个 html web 页面，显示在 web 浏览器中，

解释错误。LTspice 不能总是将这些页面作为错误条件读取，因此当仿真尝试将仿真中包含的 html 语言错误页面作为有效

的 SPICE 语法进行处理时，你可能会得到一些神秘的错误消息。 

加密库 

LTspice 可以生成和读取一种特殊形式的加密库。这允许一个用户准备另一个用户可以在仿真中使用的库，而无需透露库的

实现。已作出合理的努力，使加密库难以被未经授权的关注所解码，但如果没有其他原因，而只是在软件中实现，就不能认

为它是完全安全的。 

要准备一个加密库，你需要使用命令行选项“-encrypt”从命令行调用 LTspice。你需要首先备份这个库，因为它将被加密

版本替换。不存在将加密库转换回明文的实用程序。下面总结了两个步骤: 

为库文件做一份备份。删除你加密的版本。 

在命令行中键入\XVIIx64.exe -encrypt <filename> 

文件<filename>将被加密版本替换。加密过程需要几分钟。 

这个过程完成后，你有一个加密的 ASCII 文件。可以在“* Begin:”行上面添加版权声明，但是文件的前 9 行必须保持不

变，并且你添加的每一行版权声明都必须以字符“*”开头。 

那么，这里有一个由 LTspice 编写的加密文件: 

* LTspice Encrypted File 

*  

* This encrypted file has been supplied by a 3rd 

* party vendor that does not wish to publicize 

* the technology used to implement this library. 

*  

* Permission is granted to use this file for 

* simulations but not to reverse engineer its 

* contents. 

*  
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* Begin: 

50 3E 46 0F FA 6E 67 FF B8 4D D9 62 14 32 60 24 

36 71 35 0B 66 4F AD 52 B8 F5 9E 22 9F C0 18 8B 

FB FE 1D... 

你也可以转换成：* LTspice Encrypted File 

*  

* This encrypted file has been supplied by a 3rd 

* party vendor that does not wish to publicize 

* the technology used to implement this library. 

*  

* Permission is granted to use this file for 

* simulations but not to reverse engineer its 

* contents. 

*  

* Copyright © 2005 Acme SPICE Modeling 

* For additional information, see 

* www.acmespicemodels.com 

* 

* Begin: 

50 3E 46 0F FA 6E 67 FF B8 4D D9 62 14 32 60 24 

36 71 35 0B 66 4F AD 52 B8 F5 9E 22 9F C0 18 8B 

FB FE 1D... 
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5.2.13 .LOADBIAS--加载之前解决的直流解决方案 

Syntax: .loadbias <filename> 

.loadbias 命令是对.savebias 命令的补充。首先运行一个执行.savebias 命令的仿真。然后将.savebias 命令更改

为.loadbias 命令。  
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5.2.14 .MACHINE--任意状态机 

LTspice XVII 包含了一个任意状态机，并引入了一种称为精巧编程语言的新编程语言。有五个新命令: 

   .mach[ine] [<tripdt>] ; tripdt is an optional temporal tolerance  

   .state <name> <value>  

   .rule <old state> <new state> <condition>  

   .output (node) <expression>  

   .endmach[ine] ; end of block 

.mach 和.endmach 语句之间的语句顺序没有什么区别，这在声明性语言中是很常见的(与 C这样的过程性语言相比)，但是声

明的第一种状态是初始状态，规则是按顺序检查的。 

为状态赋值的意义在于，可以在打印的表达式中提到它。 

规则可以有很多，也可以很少。如果机器处于<旧状态>，且<条件>的表达式的值大于.5，则机器前进到<新状态>。每个时间

步骤只执行一条规则。字符'*'作为<旧状态>的值匹配任何状态。首先要检查这些规则。 

output 语句实现需要外部设备读取当前数据的当前源。如下面的例子所示，通常使用 1K 的地面参考电阻，但是你可能希望

向地面添加一些平行电容以减缓过渡。表达式>可以组合组合逻辑和/或状态。 

任意状态机最简单的例子是没有状态的状态机。这是一个逆变器的例子: 

   * inverter state machine example  

   V1 1 0 pulse(0 1 0 1u 1u .5m 1m)  

   R1 2 0 1K ; an impedance for the .output statement  

   .machine  

   .output (2) V(1) < .5  

   .endmachine  

   .tran 3m  

   .end 

这里有一个例子除以 2 与复位: 

 * divide by 2 example  

   V1 1 0 pulse(0 1 0 1u 1u .5m 1m)  

   V2 c 0 pulse(0 1 0 1u 1u 5m 10m)  

   R1 2 0 1K  

   R2 3 0 1K  

   R3 4 0 1K  

   .machine  

   .state S0a 0  

   .state S0b 0  

   .state S1a 1  

   .state S1b 1  

   .rule S0a S0b V(1) < .5  

   .rule S0b S1a V(1) > .5  

   .rule S1a S1b V(1) < .5  

   .rule S1b S0a V(1) > .5  

   .rule * S0a V(c) > .5  

   .output (2) V(1) < .5  

   .output (3) V(1) > .5  
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   .output (4) state  

   .endmachine  

   .tran 30m  

   .end 

注:当前监控未实现。如果状态机打印连接到引脚，则引脚的电流监控将不正确。 
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5.2.15 .MEASURE--评估用户定义的电量 

.MEASURE 语句有两种基本的不同类型。指横坐标上的一个点(自变量沿横轴标绘，即和. measure 语句，这些语句引用横坐

标上的一个范围。第一个版本(指向横坐标上的一个点的版本)用于在特定的点或满足条件时打印数据值或其表达式。使用以

下语法: 

Syntax: .MEAS[SURE] [AC|DC|OP|TRAN|TF|NOISE] <name> 

+ [<FIND|DERIV|PARAM> <expr>] 

+ [WHEN <expr> | AT=<expr>]] 

+ [TD=<val1>] [<RISE|FALL|CROSS>=[<count1>|LAST]] 

注意，可以选择性地声明.meas 语句应用于的分析类型。这允许你仅对特定的分析类型使用特定的. meas 语句。要为结果提

供一个可在其他.meas 语句中使用的参数名，需要使用该名称。下面的例子.meas 语句引用了横坐标上的一个点: 

.MEAS TRAN res1 FIND V(out) AT=5m 

打印 t=5ms 时的 V(out)值，标记为 res1。 

.MEAS TRAN res2 FIND V(out)*I(Vout) WHEN V(x)=3*V(y) 

第一次满足条件 V(x)=3*V(y)时，打印表达式 V(out)*I(Vout)的值。这是 res2。 

.MEAS TRAN res3 FIND V(out) WHEN V(x)=3*V(y) cross=3 

在满足条件 V(x)=3*V(y)的情况下，第三次打印 V(out)的值。这个标签是 res3。 

.MEAS TRAN res4 FIND V(out) WHEN V(x)=3*V(y) rise=last 

当 V(x)增加 wrt3 *V(y)时，当 V(x)接近条件 V(x)=3*V(y)时，打印 V(out)的值。这个标签是 res4。 

.MEAS TRAN res5 FIND V(out) WHEN V(x)=3*V(y) cross=3 TD=1m 

第三次在条件中打印 V(out)的值满足 V(x)=3*V(y)，但直到时间超过 1ms 才开始计数。这个标签是 res5。 

.MEAS TRAN res6 PARAM 3*res1/res2 

打印 3*res1/res2 的值。这个表单对于打印其他.meas 语句结果的表达式很有用。并不是说基于直接模拟数据的表达式(如

V(3))会出现在待求值的表达式中，但如果存在，则数据取自最后一个模拟点。结果将被标记为 res6。 

请注意，上面的示例在引用横坐标上的一点时，请求的结果基于纵坐标数据(因变量)。如果没有请求纵坐标信息，则.MEAS

语句将在发生测量条件的横坐标上打印点: 

.MEAS TRAN res6 WHEN V(x)=3*V(y) 

第一次打印满足条件 V(x)=3*V(y)。这个标签是 res6。 

另一种类型的. meas 语句是指横坐标上的一个范围。使用以下语法: 

Syntax: .MEAS [AC|DC|OP|TRAN|TF|NOISE] <name> 

+ [<AVG|MAX|MIN|PP|RMS|INTEG> <expr>] 

+ [TRIG <lhs1> [[VAL]=]<rhs1>] [TD=<val1>] 

+ [<RISE|FALL|CROSS>=<count1>] 

+ [TARG <lhs2> [[VAL]=]<rhs2>] [TD=<val2>] 

+ [<RISE|FALL|CROSS>=<count2>] 
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横坐标上的范围由“三角”和“TARG”定义的点指定。如果省略三角点，则默认为模拟的开始。类似地，TARG 点默认设置

为模拟数据的末尾。如果省略了三角函数、TARG 和前面的三个点，则. meas 语句将在整个数据范围内运行。可以在一段时

间内完成的测量操作类型为 

Keyword Operation performed over interval 

AVG Compute the average of <expr> 

MAX Find the maximum value of <expr> 

MIN Find the minimum value of <expr> 

PP Find the peak-to-peak of <expr> 

RMS Compute the root mean square of <expr> 

INTEG Integrate <expr> 

如果没有指定测量操作，则. meas 语句的结果是三角函数和 TARG 点之间沿横坐标的距离。下面是例子 interval .MEAS 语

句: 

.MEAS TRAN res7 AVG V(NS01) 

+ TRIG V(NS05) VAL=1.5 TD=1.1u FALL=1 

+ TARG V(NS03) VAL=1.5 TD=1.1u FALL=1 

打印 V(NS01)的平均值，从 V(NS05)第一次下降到 1.1us 后的 1.5V，从 V(NS03)第一次下降到 1.1us 后的 1.5V。这个标签是

res7。 

对于。ac 分析，只考虑表达式的复数值的实部，将复杂数据的条件表达式转换为真实条件。 

同样，. meas 语句的结果可以用于另一个. meas 语句。在本例中，计算 3dB 带宽: 

.MEAS AC tmp max mag(V(out));找到峰值响应并称之为“tmp” 

.MEAS AC BW trig mag(V(out))=tmp/sqrt(2) rise=1 

+ targ mag(V(out))=tmp/sqrt(2) fall=last 

打印两个点之间的频率差 3dB 从峰值响应。注:. ac 分析的数据很复杂，.measurement 语句的结果也很复杂。而等式仅指复

数的实部，即“mag(V(out))=tmp/sqrt(2)”等价于 Re(mag(V(out)) =Re(tmp/sqrt(2))。 

当测试一个条件时，例如“当<cond1> = <cond2>”，您将希望条件通过等式，而不仅仅是满足它。这与以下事实有关:由于

存储数字时使用的进动是有限的，因此不应该要求浮点等式。 

AVG、RMS 和 INTEG 操作对于. noise 分析与分析类型是不同的，因为噪声更有意义地集成在正交除以频率中。因此，AVG 和

RMS 都给出了 RMS 噪声电压，INTEG 给出了综合总噪声。因此，如果添加 SPICE 指令 

.MEAS NOISE out_totn INTEG V(onoise) 

.MEAS NOISE in_totn INTEG V(inoise) 
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完整的输入和打印引用的 rms 噪声将打印在.log 文件中。 

. meas 语句在仿真完成后进行后处理。这允许您编写. meas 语句的脚本并在数据集上执行它们。为此，将波形窗口设置为

活动窗口并执行菜单命令文件=> execute . meas 脚本。在仿真后的后处理中，. meas 语句的另一个结果是，. meas 语句

打印的准确性受到压缩后波形数据的准确性的限制。你可能需要调整压缩设置以获得更精确的. meas 语句打印。 

. meas 语句通常只是作为 SPICE 指令放在示意图上，或者与其他模拟命令和电路定义一起放在 netlist 中。打印被放在. 

Log 文件中，可以使用菜单命令 View=>SPICE Error Log。如果仿真包含.step 命令，则为每个步骤执行.measure 语句，并

将结果打印为.log 文件中的表。这些.measure 结果的表格可以像法线波形一样通过以下步骤绘制: 

i)仿真完成后，执行 menu 菜单命令 View=>SPICE Error Log 

ii)右键单击.log 文件，执行上下文菜单命令 Plot .step'ed .meas data。 
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5.2.16 .MODEL--定义 SPICE 模型 

定义二极管、晶体管、开关、有损耗传输线或均匀 RC 线的模型 

有些电路元件，例如晶体管，有许多参数。晶体管不是为晶体管的每个实例定义每个晶体管参数，而是按模型名称分组并具

有共同的参数。相同模型的晶体管可以有不同的尺寸，并且电气性能可以根据实例的大小进行缩放。 

Syntax: .model <modname> <type>[(<parameter list>)] 

参数列表取决于模型的类型。以下是模型类型列表: 

 
Associated Circuit Element 

SW  Voltage Controlled Switch 

CSW  Current Controlled Switch 

URC  Uniform Distributed RC Line 

LTRA  Lossy Transmission Line 

D  Diode 

NPN  NPN Bipolar Transistor 

PNP  PNP Bipolar Transistor 

NJF  N-channel JFET model 

PJF  P-channel JFET model 

NMOS  N-channel MOSFET 

PMOS  P-channel MOSFET 

NMF  N-channel MESFET 

PMF  P-channel MESFET 

NIGBT  N-channel IGBT 

PIGBT  P-channel IGBT 

VDMOS  Vertical Double Diffused Power MOSFET 

参见电路元件的描述，了解哪些参数是特定于实例的，哪些参数是模型的公共参数。 
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5.2.17 .NET--在.AC 分析中计算网络参数 

该语句与小信号(. ac)分析一起用于计算 2 端口网络的输入和输出导纳、阻抗、y 参数、z参数、h参数和 s 参数。它也可

以用来计算一个单端口网络的输入导纳和阻抗。这必须与. ac 语句一起使用，该语句决定网络分析的频率扫描。 

Syntax: .net [V(out[,ref])|I(Rout)] <Vin|Iin> [Rin=<val>] [Rout=<val>] 

网络输入由独立电压源<Vin>或独立电流源<Iin>指定。可选的输出端口是用节点 V(out)或电阻 I(路由器)指定的。端口将被

终止与电阻 Rin 和路由器。如果未指定，终端阻抗默认为 1欧姆，但指定了 Rser 的电压源或指定了电阻的输出端口的情况

除外。在这两种情况下，终端电阻默认为设备阻抗。. net 语句中指定的终止值将覆盖. net 计算的设备阻抗，但不覆盖正

常的. ac 节点电压和电流。也就是说，对于. ac 分析中计算的正常电压和电流，. net 语句不会对网络施加终止阻抗。 

请参见安装在%HOMEPATH%\Documents\LTspiceXVII\examples\Educational\S-param.asc 上的示例文件。它建议使用电压源

V4, Rser 设置所需的源阻抗，使用电阻 router 设置输出端，使用.net 语句简单地读取“.net I(router) V4”。.net 语句

中没有指定 Rin 或路由器值，输入/输出设备提供默认的终止值。这种安排使得. ac 分析的节点电压和电流与以. net 语句

相同的方式终止的网络相对应。 
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5.2.18 .NODESET--为初始直流解决方案提供提示 

节点集指令提供了查找直流操作点的提示。如果一个电路有多个可能的直流状态，例如触发器，那么寻找直流解的迭代过程

可能永远不会收敛。一个.NODESET 指令可以用来引导电路到一个或另一个状态。基本上，在使用节点集指令上指定的电压

完成解决方案传递之后，对后续迭代传递的约束将被移除。 

Syntax: .NODESET V(node1)=<voltage> [V(node2)=<voltage [...]] 
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5.2.19 .NOISE--进行噪音分析 

这是一个频域分析，计算约翰逊噪声，射击噪声和闪烁噪声。输出数据为单位平方根带宽的噪声谱密度。 

Syntax: .noise V(<out>[,<ref>]) <src> <oct, dec, lin> <Nsteps> <StartFreq> <EndFreq>  

        .noise V(<out>[,<ref>]) <src> list <FirstFreq>[ <NextFreq> [<NextFreq> ...]] 

V(<out>[，<ref>])是计算总输出噪声的节点。可以表示为 V(n1, n2)来表示两个节点之间的电压。<src>是引用输入噪声的

独立源的名称。<src>为无噪声输入信号。参数<oct, dec, lin>， <Nsteps>， <StartFreq>， and <EndFreq>以.ac 指令

使用的方式定义感兴趣的频率范围和分辨率。 

输出数据跟踪 V(onoise)是上述语法中指定的输出节点的噪声频谱电压密度。如果输入信号是一个电压源，那么数据跟踪

V(inoise)就是输入参考的噪声电压密度。如果将输入指定为电流源，则数据跟踪降噪是指输入电流源信号的噪声。可以绘

制出每个分量的噪声贡献。这些贡献被引用到输出。您可以通过除以数据跟踪“增益”来将它们引用到输入。 

波形查看器可以通过<Ctrl-Key> +鼠标左键单击相应的数据跟踪标签来集成带宽上的噪声。 

语法”。噪声 V(<out>[，<ref>]) <src> list <Freq>"与.step 结合使用时，单个分析频率是有用的。它允许您绘制噪声密

度作为阶跃参数的函数，如本例所示。 
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5.2.20 .OP--找到直流工作点 

执行电容开路和电感短路的直流工作点解决方案。为了找到电路的工作点，通常将直流解作为另一种分析的一部分来执行。

如果只希望找到此操作点，请使用.op。结果将出现在一个对话框中。在.op 仿真之后，当你指向某个节点或当前时，.op 解

决方案将出现在状态栏上。 

一般非线性电路的工作点不能保证像牛顿-拉弗森迭代那样用逐次线性逼近得到。如果直接牛顿迭代失败，LTspice 会尝试

许多其他方法来找到一个操作点。下面是禁用特定方法所需的方法和选项设置的表。 

Method Directive to disable 

Direct Newton Iteration   .options NoOpIter  

Adaptive Gmin Stepping   .options GminSteps=0 

Adaptive Source Stepping  .options SrcSteps=0  

Pseudo Transient   .options pTranTau=0  
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5.2.21 .OPTIONS—设置仿真选项 

Keyword Default Description 

abstol 1pA Absolute current error tolerance  

baudrate (none) Used for eye diagrams. Tells the waveform viewer how to wrap the abscissa time to 

overlay the bit transitions. 

chgtol 10fC Absolute charge tolerance  

cshunt 0. Optional capacitance added from every node to ground  

cshuntintern cshunt  Optional capacitance added from every device internal node to ground.  

defad 0. Default MOS drain diffusion area  

defas 0. Default MOS source diffusion area  

defl 100μm Default MOS channel length  

defw 100μm Default MOS channel width  

delay 0. Used for eye diagrams. Shifts the bit transitions in the diagram.  

fastaccess false Convert to fastaccess file format at end of simulation. 

flagloads false Flags external current sources as loads. 

Gmin 1e-12 Conductance added to every PN junction to aid convergence. 

gminsteps 25 Set to zero to prevent gminstepping for the initial DC solution. 

gshunt 0. Optional conductance added from every node to ground. 

itl1 100 DC iteration count limit. 

itl2 50 DC transfer curve iteration count limit. 

itl4 10 Transient analysis time point iteration count limit 

itl6 25 Set to zero to prevent source stepping for the initial DC solution. 
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srcsteps 25 Alternative name for itl6. 

maxclocks Infin. maximum number of clock cycles to save 

maxstep Infin. Maximum step size for transient analysis 

meascplxfmt bode Complex number format of .meas statement results. One of "polar", "cartesian", or 

"bode". 

measdgt 6 Number of significant figures used for .measure statement output. 

method trap Numerical integration method, either trapezoidal or Gear 

minclocks 10 minimum number of clock cycles to save 

MinDeltaGmin 1e-4 Sets a limit for termination of adaptive gmin stepping. 

nomarch false Do not plot marching waveforms 

noopiter false Go directly to gmin stepping. 

numdgt 6 Historically "numdgt" was used to set the number of significant figures used for 

output data. In LTspice, if "numdgt" is set to be > 6, double precision is used 

for dependent variable data. 

pivrel 1e-3 Relative ratio between the largest column entry and an acceptable pivot value. 

pivtol 1e-13 Absolute minimum value for a matrix entry to be accepted as a pivot. 

reltol .001 Relative error tolerance. 

srcstepmethod 0 Which source stepping algorithm to start with. 

sstol .001 Relative error for steady-state detection. 

startclocks 5 Number of clock cycles to wait before looking for steady state. 

temp 27°C Default temperature for circuit element instances that don't specify temperature. 

tnom 27°C Default temperature at which device parameters were measured for models that 

don't specify this temperature. 
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topologycheck 1 Set to zero to skip check for floating nodes, loops of voltage sources, and non-

physical transformer winding topology 

trtol 1.0 Set the transient error tolerance. This parameter is an estimate of the factor by 

which the actual truncation error is overestimated. 

trytocompact 1 When non-zero, the simulator tries to condense LTRA transmission lines' history 

of input voltages and currents. 

vntol 1μV Sets the absolute voltage error tolerance. 

plotreltol .0025 Sets the relative error tolerance for waveform compression. 

plotvntol 10μV Sets the absolute voltage error tolerance for waveform compression. 

plotabstol 1nA Sets the absolute current error tolerance for waveform compression. 

plotwinsize 300 Number of data points to compress in one window. Set to zero to disable 

compression. 

ptrantau .1 Characteristic source start-up time for a damped pseudo transient analysis to 

find the operating point. Set to zero to disable pseudo transient. 

ptranmax 0 If set non-zero, that time of the damped pseudo transient analysis is used as the 

operating point whether the circuit has settled or not. 
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5.2.22 .PARAM——用户定义的参数 

.param 指令允许创建用户定义的变量。为了清晰起见，这对于将名称与值关联起来以及将子电路参数化以便将抽象电路保

存在库中非常有用。 

.param 语句可以包含在子电路定义中，以将参数值的范围限制在该子电路中。 

要调用参数替换和表达式求值，请将表达式括在花括号中。封闭的表达式将被浮点值替换。 

下面是一个使用.param 语句和直接在子电路调用线上传递参数的示例。 

* 

* This is the circuit definition 

.params x=y y=z z=1k*tan(pi/4+.1) 

X1 a b 0 divider top=x bot=z 

V1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ) 

 

* this is the definition of the subcircuit 

.subckt divider n1 n2 n3 

r1 n1 n2 {top} 

r2 n2 n3 {bot} 

.ends 

* 

 

.tran 3μ 

.end 

参数替换模式是一种符号声明性语言。参数不是作为计算值传递给子电路，而是通过表达式和关系本身传递。遇到花括号

时，根据作用域内可用的所有关系计算封闭表达式，并将其简化为浮点值。 

提供以下功能和操作: 

Function Name Description 

abs(x) Absolute value of x 

acos(x) Real part of the arc cosine of x, e.g., acos(-5) 

returns 3.14159, not 3.14159+2.29243i 

arccos(x) Synonym for acos() 

acosh(x) Real part of the arc hyperbolic cosine of x, e.g., 

acosh(.5) returns 0, not 1.0472i 

asin(x) Real part of the arc sine of x, e.g., asin(-5) 

returns -1.57080, not -1.57080+2.29243i 

arcsin(x) Synonym for asin() 
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asinh(x) Arc hyperbolic sine 

atan(x) Arc tangent of x 

arctan(x) Synonym for atan() 

atan2(y,x) Four quadrant arc tangent of y/x 

atanh(x) Arc hyperbolic tangent 

buf(x) 1 if x > .5, else 0 

cbrt(x) Cube root of (x) 

ceil(x) Integer equal or greater than x 

cos(x) Cosine of x 

cosh(x) Hyperbolic cosine of x 

exp(x) e to the x 

fabs(x) Same as abs(x) 

flat(x) Random number between -x and x with uniform 

distribution 

floor(x) Integer equal to or less than x 

gauss(x) Random number from Gaussian distribution with sigma 

of x. 

hypot(x,y) sqrt(x**2 + y**2) 

if(x,y,z) If x > .5, then y else z 

int(x) Convert x to integer 

inv(x) 0. if x > .5, else 1. 

limit(x,y,z) Intermediate value of x, y, and z 
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ln(x) Natural logarithm of x 

log(x) Alternate syntax for ln() 

log10(x) Base 10 logarithm 

max(x,y) The greater of x or y 

mc(x,y) A random number between x*(1+y) and x*(1-y) with 

uniform distribution. 

min(x,y) The smaller of x or y 

pow(x,y) Real part of x**y, e.g., pow(-.5,1.5) returns 0., 

not 0.353553i 

pwr(x,y) abs(x)**y 

pwrs(x,y) sgn(x)*abs(x)**y 

rand(x) Random number between 0 and 1 depending on the 

integer value of x. 

random(x) Similar to rand(), but smoothly transitions between 

values. 

round(x) Nearest integer to x 

sgn(x) Sign of x 

sin(x) Sine of x 

sinh(x) Hyperbolic sine of x 

sqrt(x) Real part of the square root of x, e.g., sqrt(-1) 

returns 0, not 0.707107i 

table(x,a,b,c,d,...) Interpolate a value for x based on a look up table 

given as a set of pairs of points. 

tan(x) Tangent of x. 
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tanh(x) Hyperbolic tangent of x 

u(x) Unit step, i.e., 1 if x > 0., else 0. 

uramp(x) x if x > 0., else 0. 

以下操作按求值优先级的相反顺序分组: 

Operand Description 

& Convert the expressions to either side to Boolean, then AND. 

| Convert the expressions to either side to Boolean, then OR. 

^ Convert the expressions to either side to Boolean, then XOR. 

> True if expression on the left is greater than the expression on the 

right, otherwise false. 

< True if expression on the left is less than the expression on the right, 

otherwise false. 

>= True if expression on the left is greater than or equal the expression on 

the right, otherwise false. 

<= True if expression on the left is less than or equal the expression on 

the right, otherwise false. 

+ Floating point addition 

- Floating point subtraction 

* Floating point multiplication 

/ Floating point division 

** Raise left hand side to power of right hand side, only real part is 

returned, e.g., -2**1.5 returns zero, not 2.82843i 

在仿真开始前对所有参数进行了替换评估。  
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5.2.23 .SAVE--限制已保存数据的数量 

一些仿真，特别是时域仿真，可以生成大量的数据。通过使用.save 指令只保存感兴趣的特定节点电压和设备电流，可以限

制输出量。 

Syntax: .save V(out) [V(in) [I(L1) [I(S2)]]] [dialogbox] 

指令.save I(Q2)将保存双极晶体管 Q2 的基极、集电极和发射极电流。若要保存单个终端电流，请指定 Ic(Q2)。 

通配符“*”和“?”'可用于指定与模式匹配的数据跟踪。例如,“。保存 V(*) Id(*)"将保存每个电压和每个漏电流。 

如果指定了关键字“对话框”，那么将显示一个包含所有可用默认节点和流的列表的对话框，允许用户从列表中选择应该保

存的节点和流。如果网表是从原理图生成的，那么可以在原理图中指向并单击节点和元件，以突出显示对话框中选中的节点

和元件。 
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5.2.24 .SAVEBIAS--将操作点保存到磁盘 

Syntax: .savebias <filename> [internal] 

+ [temp=<value>] [time=<value> [repeat]] [step=<value>] 

+ [DC1=<value>] [DC2=<value>] [DC3=<value>] 

此命令将文本文件写入磁盘，该磁盘将在后续模拟中使用.loadbias 命令重新加载。如果您的电路有一个难以解决的直流工

作点，您可以将该解决方案保存到磁盘，以便下次分析可以在继续进行其余的模拟之前节省查找直流解决方案的时间。 

可以添加关键字“internal”来表示还应该保留某些设备的内部节点，以便保存 DC解决方案的更完整版本。 

如果要从.tran 分析中保存特定的 DC操作点，可以指定一个时间。在规定时间后的第一个解决时间点将被写入。修改器

“repeat”将导致 DC 解决方案在此时间指定的每个时间段之后写入。该文件将只包含最近解决的 DC 点。DC1、DC2 和 DC3

可用于从.dc 扫描分析中提取单个操作点。 

savebias 命令以.nodeset 命令的形式写入文本文件。注意，nodeset 语句只是解决方案的建议。也就是说，求解器将使用

nodeset 语句中给定的节点电压开始迭代该解决方案，但是将继续迭代，直到它确信该解决方案是有效的。如果您想从 DC

操作点重新启动.tran 解决方案，可以将文件从.nodeset 编辑为.ic，以强制解决程序从这个 DC 状态开始。 

由于所有电路电抗的集成状态都没有保存在.savebias 文件中，所以这种技术的成功程度各不相同。 
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5.2.25 .STEP--参数扫描 

此命令导致在逐步执行温度、模型参数、全局参数或独立源时重复执行分析。步骤可以是线性的、对数的，或者指定为一个

值列表。 

示例:.step oct v1 1 20 5 

步进独立电压源 V1 从 1 到 20 对数每八度 5 点。 

例如:. stepi1 10u 100u 10u 

阶跃独立电流源 I1 从 10u 到 100u，阶跃增量为 10u。 

示例:. stepparam RLOAD LIST 5 10 15 

在全局参数 Rload 分别为 5、10 和 15 的情况下，进行三次仿真。 

例如:.step NPN 2N2222(VAF) 50 100 25 

步骤 NPN 模型参数 VAF 从 50 到 100，步骤 25。 

例子:.step temp -55 125 10 

一步的温度从-55°C到 125°C以一步。步骤扫描的嵌套深度可以达到三层。 
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5.2.26 .subckt——定义一个子电路 

作为定义电路的辅助，重复电路可以包含在子电路定义中，并作为同一电路中的多个实例使用。在模拟运行之前，通过用子

电路定义中的电路元素替换子电路的每次调用，将电路扩展为平面网络列表。子电路的大小和复杂性没有限制。 

子电路定义的结束必须是.ends 指令 

下面是一个使用子电路的例子: 

* 

* This is the circuit definition 

X1 a b 0 divider 

V1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ) 

* this is the definition of the subcircuit 

.subckt divider n1 n2 n3 

r1 n1 n2 1k 

r2 n2 n3 1k 

.ends 

.tran 3  

.end 

展开后运行： 

* Expand X1 into two resistor network 

r:1:1 a b 1k 

r:1:2 b 0 1k 

* 

v1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ) 

.tran 3μ 

.end 

注意，基于子电路名和子电路定义元素名的唯一名称是为通过子电路展开插入的电路元素而生成的。 
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5.2.27 .TEMP--温度扫描 

这是温度阶跃命令的一种古老形式。它对列出的每个温度执行模拟。 

The syntax: .TEMP <T1> <T2> ... 

等同于 

.STEP TEMP LIST <T1> <T2> ... 
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5.2.28 .TF--求直流小信号传递函数 

这是一种分析模式，通过独立源的微小变化，找到节点电压或支路电流的直流小信号传递函数。 

Syntax: .TF V(<node>[, <ref>]) <source> 

        .TF I(<voltage source>) <source> 

Examples: 

.TF V(out) Vin 

.TF V(5,3) Vin 

.TF I(Vload) Vin 
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5.2.29 .TRAN——执行非线性瞬态分析 

执行瞬态分析。这是对电路最直接的模拟。它主要计算电路通电后的情况。测试信号通常作为独立的信号源使用。 

Syntax: .TRAN <Tstep> <Tstop> [Tstart [dTmax]] [modifiers] 

        .TRAN <Tstop> [modifiers] 

第一种形式是传统的.tran SPICE 命令。Tstep 是波形的绘图增量，也可用作初始步长猜测。LTspice 使用波形压缩，因此

该参数的值很小，可以忽略或设置为零。Tstop 是模拟的持续时间。瞬态分析总是在等于零的时刻开始。但是，如果指定了

Tstart，则不保存 0到 Tstart 之间的波形数据。这是一种通过忽略启动瞬变来管理波形文件大小的方法。最后一个参数

dTmax，是积分电路方程所需要的最大时间步长。如果指定了 Tstart 或 dTmax，则必须指定 Tstep。 

可以在.tran 行上放置几个修饰符。 
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5.2.30 .WAVE——将选定的节点写入.Wav 文件 

LTspice 可以编写.wav 波形文件。然后，这些文件可以被监视或用作另一个仿真的输入。 

Syntax:  .wave <filename.wav> <Nbits>  <SampleRate> V(out) [V(out2) ...] 

Example: .wave C:\output.wav 16 44.1K V(left) V(right) 

<文件名。wav>是你希望创建的.wav 文件的完整绝对路径，或者是从包含模拟示意图或 netlist 的目录计算的相对路径。双

引号可用于指定包含空格的路径。<Nbits>是采样位的个数。有效的范围是 1 到 32 位。 

<SampleRate>是每模拟一秒要写入的样本数量。有效范围为 1 ~ 4294967295 个样品次之。语法的其余部分列出希望保存的

节点。每个节点都将是.wav 文件中的独立通道。通道的数量可能只有一个，也可能多达 65535 个。可以写入设备电流，例

如 Ib(Q1)和节点电压。wav 模拟数字转换器具有-1 到+1 伏特或安培的全量程范围。 

请注意，有可能编写的。wav 文件无法在您的 PC 声音系统上播放，原因是频道数、采样率或位元数(由于您的 PC 的编解码

器的限制)。但是这些.wav 文件仍然可以在 LTspice 中用作另一个模拟的输入。参见章节 LTspice=>电路元件=>V。用于

将.wav 文件播放到 LTspice 仿真中的信息的电压源和电流源。如果您想在 PC声卡上播放.wav 文件，请记住更受欢迎的.wav

文件格式有 1 或 2个通道;8 位或 16 位/通道;采样率为 11025 Hz, 22050 Hz，或 44100 Hz。 
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5.3 瞬态分析选项 

.TRAN 修饰符 

UIC:  跳过直流操作解决方案，使用用户指定的初始条件。 

steady:  达到稳态后停止仿真。 

nodiscard: 在达到稳态之前，不要删除暂态仿真部分。 

startup:  求解独立电压源和电流源关闭时的初始工作点，然后启动暂态分析，在模拟的前 20us 中打开这些

源。 

Step:  计算电路的阶跃响应 
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5.3.1 UIC 

使用初始条件。通常，在开始暂态分析之前，先进行直流工作点分析。这个指令抑制这个初始化。某些电路元件的初始条件

可以在实例基础上指定。Uic 并不是 SPICE 特别推荐的特性。跳过直流工作点分析将导致非物理初始条件。例如，考虑一个

与电容并联的电压源。若未指定，则节点电压取零。然后，在第一个时间步，一个无限的电流需要充电电容器。仿真器找不

到足够短的时间步长使当前非奇异，并发出“时间步长太小收敛失败”的消息。 
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5.3.2 startup 

这类似于 SPICE 最初的“uic”。这意味着独立的来源应该增加在第一个 20μs仿真。然而，直流工作点分析是使用.ic 指

令上指定的约束来执行的。 
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5.3.3 steady 

达到稳态后停止仿真。这是效率计算报告所必需的。将稳态检测写入 SMPS 宏模型中。通常，它们是为了寻找零误差放大器

输出电流平均超过一个时钟周期。该算法考虑了误差放大器的输出依从性范围。被认为是零电流的峰值电流的比例由 sstol

选项指定。 

自动稳态检测可能会因为太过临界或不够临界而失败。可以交互指定稳态如下:仿真一开始，执行菜单命令 simulation 

=>Efficiency Calculation=>Mark Start。第一次执行这个命令时，您告诉 LTspice 您将手动指定集成限制。当电路看起来

达到稳定状态后，再次执行该命令。这将清除历史记录并重新启动效率计算。然后，一段时间后，如您所看到的，超过 10

个时钟周期，执行模拟=>效率计算=>标记结束。每次执行模拟=>效率计算=>标记 Start 时，重新启动效率计算并清除波形历

史记录。这是防止数据文件变得太大和绘图速度变慢的好方法，因此建议您定期执行模拟=>效率计算=>标记 Start，只要您

积累了大量不想包含在效率集成中的数据。 

使用.ic 指令指定节点电压和电感电流，以缩短寻找稳态所需的瞬态分析的长度。 
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5.3.4 nodiscard 

在达到稳态之前，不要删除暂态仿真部分。 
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5.3.5 step 

计算电路的阶跃响应。此函数与一个电流源一起工作，该电流源用作带有一系列阶跃电流的负载。这个过程是: 

计算到稳定状态并丢弃历史记录，除非没有设置丢弃。 

坡道载荷步到下一个值列表中的 20 a /μs 水流的速度。 

计算稳定状态 

将步骤加载更改为列表中的下一个值，如果没有，则退出。 

由于电路的复杂性，自动阶跃跃迁可能无法检测到。在这种情况下，最好使用. tran 命令来运行瞬态仿真，并观察所需的

阶跃负载响应的开始和结束周期。使用 PWL 命令对输出负载电流进行编程，并在所需的时间段切换到不同的级别。例如: 

压水堆(0 0.5 m 0.5 1.01m 0.1 m 0.1 m 0.1 3.01m 0.5) 

负载电流从 0 时刻的 0.5A 开始，1ms 时保持 0.5A, 1.01ms 时切换到 0.1A, 3ms 时保持 0.1A, 3.01ms 时切换到 0.5A，保持

0.5A。 

PWL 几乎可以有无限对(时间、值)序列。 

 

  



LTspice XVII help 中文翻译版 

 

 

本文由微信公众号 电子帮 翻译而成，仅用于学习交流，不可用于一切商业目的活动！ 

5.4 电路元件 

电路元件快速参考表 

Component Syntax 

Special functions  Axx n1 n2 n3 n4 n5 n6 n7 n8 

+ <model> [extra parameters] 

Arbitrary behavioral source  Bxx n+ n- <V=... or I=...> 

Capacitor  Cxx n+ n- <capacitance> 

+ [ic=<val.>] [Rser=<val.>] 

+ [Lser=<val.>] [Rpar=<val.>] 

+ [Cpar=<val.>] [m=<val.>] 

Diode  Dxx A K <model> [area] 

Voltage dependent voltage  Exx n+ n- nc+ nc- <gain> 

Current dependent current  Fxx n+ n- <Vnam> <gain> 

Voltage dependent current  Gxx n+ n- nc+ nc- <transcond.> 

Current dependent voltage  Hxx n+ n- <Vnam> <transres.> 

Independent current source  Ixx n+ n- <current> 

JFET transistor  Jxx D G S <model> [area] [off] 

+[IC=<Vds,Vgs>] [temp=<T>] 

Mutual inductance  Kxx L1 L2 L3... <coeff.> 

Inductance  Lxx n+ n- <inductance> 

+ [ic=<val.>] [Rser=<val.>] 

+ [Rpar=<val.>] 

+ [Cpar=<val.>] [m=<val.>] 

MOSFET transistor  Mxx D G S B <model> [L=<len>] 

+ [W=<width>] [AD=<area>] 

+ [AS=<area>] [PD=<perim>] 

+ [PS=<perim>] [NRD=<value>] 

+ [NRS=<value>] [off] 
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+ [IC=<Vds, Vgs, Vbs> 

+ [temp=<T>] 

Lossy transmission line  Oxx L+ L- R+ R- <model> 

Bipolar transistor  Qxx C B E [S] <model> [area] 

+ [off] [IC=Vbe,Vce][temp=<T>] 

Resistor  Rxx n1 n2 <value> 

Voltage controlled switch  Sxx n1 n2 nc+ nc- <model> 

+ [on,off] 

Lossless transmission line  Txx L+ L- R+ R- ZO=<value> 

+ TD=<value> 

Uniform RC-line  Uxx n1 n2 ncommon <model> 

+ L=<len> [N=<lumps>] 

Independent voltage source  Vxx n+ n- <voltage> 

Current controlled switch  Wxx n1 n2 <Vnam> <model> 

+ [on,off] 

Subcircuit  Xxx n1 n2 n3... <subckt name> 

MESFET or IGBT transistors  Zxx D G S model [area] [off] 

+ [IC=<Vds,Vgs>] 
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5.4.1 A.特殊函数 

符号名字：INV, BUF, AND, OR, XOR, SCHMITT, SCHMTBUF, SCHMTINV, DFLOP, VARISTOR, 和 MODULATE 

Syntax: Annn n001 n002 n003 n004 n005 n006 n007 n008 <model> [instance parameters] 

这些是凌特公司专有的特殊功能/混合模式仿真元件。因为随着 LTspice 可用的每一组新模型的出现，它们经常会发生变

化，所以其中大多数以及它们的行为都是没有文档记录的。然而，由于它们的应用广泛，我们在这里记录其中一些。 

INV、BUF、AND、OR 和 XOR 是通用的理想化的门逻辑器件。所有的门都有 8个终端。这些门不需要外部电源。电流的来源或

沉没从互补的输出，终端 6 和 7，并返回通过设备共同，终端 8。终端 1到 5 是输入。未使用的输入和输出将连接到终端

8。数字设备编译器将此识别为未使用该终端的标志，并将其从模拟中删除。这就导致了一种潜在的混乱局面，即当输入接

地或零电压时，门和门的作用是不同的。如果接地是门的公共，那么接地输入不是在逻辑错误的条件下，只是不属于模拟的

一部分。这样实现这些门的原因是，这允许一个设备充当 2-、3-、4-或 5-输入门，具有真实的、反向的或互补的输出，对

于未使用的终端没有模拟速度损失。也就是说，和设备相当于 12 种不同类型的和门。门默认为 0V/1V 逻辑，逻辑阈值为

0.5 v，无传播延迟，输出阻抗为 1Ohm。使用这些实例参数设置输出特性: 

Name Default Description 

Vhigh 1 Logic high level 

Vlow 0 Logic low level 

Trise 0 Rise time 

Tfall Trise Fall time 

Tau 0 Output RC time constant 

Cout 0 Output capacitance 

Rout 1 Output impedance 

Rhigh Rout Logic high level impedance 

Rlow Rout Logic low level impedance 

注意，并不是所有的参数都可以同时在同一个实例上指定，例如，输出特征要么是调整上升时间，要么是 RC 时间常数，而

不是两者都是。 

传播延迟默认为 0，并使用实例参数 Td 进行设置。输入保持时间等于传播延迟。 

输入逻辑阈值默认为.5*(Vhigh+Vlow)，但可以使用实例参数 Ref 进行设置。保持时间等于传播延迟。 

当使用两个以上输入时，独占 XOR 设备具有非标准行为:仅当所有输入中的一个为真时，输出为真。使用 XOR 与多个 XOR 设

备的关联属性来实现具有两个以上输入的 XOR 块。 

施密特触发器具有与门相似的输出特性。它们的跳闸点由实例参数 Vt和 Vh 指定。低跳闸点是 Vt-Vh，高跳闸点是 Vt+Vh。 
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默认情况下，gates 和 Schmitt 触发器设备不向模拟引擎提供时间步长信息。也就是说，当它们要改变状态时，它们不会查

看，并确保状态改变的两边都有一个时间步长。可以设置实例参数 tripdt 来规定模拟器跨状态更改的最大时间步长。 

变阻器是一种电压控制的变阻器。其击穿电压由端子 1 和端子 2 之间的电压决定。其击穿阻抗由实例参数 rclamp 指定。参

见示例原理图。\examples\Educational\varistor.asc。 

调制装置是一个电压控制振荡器。参见示例示意图\examples\Educational\PLL.asc。瞬时振荡频率由调频输入的电压决

定。电压到频率的转换是线性的，由两个实例参数 mark 和 space 进行设置。Mark 为调频输入 1V时的频率，space 为输入

0V 时的频率。幅值由 AM输入上的电压设置，如果该输入未使用(连接到调制公用)，则默认为 1V。 

LTspice 的 schematic capture 方面以一种特殊的方式列出了这些设备的符号。所有未连接的终端都自动连接到终端 8。另

外，如果终端 8 没有连接，那么它连接到节点 0。 
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5.4.2 B. 任意行为电压或电流源 

符号名称: BV, BI 

Syntax: Bnnn n001 n002 V=<expression> [ic=<value>] 

        + [tripdv=<value>] [tripdt=<value>] 

        + [laplace=<expression> [window=<time>] 

        + [nfft=<number>] [mtol=<number>]] 

        Bnnn n001 n002 I=<expression> [ic=<value>] 

        + [tripdv=<value>] [tripdt=<value>] [Rpar=<value>] 

        + [laplace=<expression> [window=<time>] 

        + [nfft=<number>] [mtol=<number>]] 

第一个语法指定行为电压源，下一个语法指定行为电流源。对于当前源，可以使用 Rpar 实例参数指定并行电阻。 

Tripdv 和 tripdt 控制步进抑制。如果源的电压在 tripdt 秒内变化超过 tripdv 伏特，则该模拟时间步骤将被拒绝。 

表达式可以包含以下内容: 

•节点电压，例如，V(n001) 

•节点电压差异，例如 V(n001, n002) 

•电路元件电流;例如，I(S1)，通过开关 S1 或 Ib(Q1)的电流，Q1 的基电流。然而，我们假设电路元件电流是准静态变化

的，即通过参考器件的电流与行为源输出之间不存在瞬时反馈。类似地，在小信号线性交流分析中，假设这种器件电流的任

何交流分量为零。 

•关键字“time”表示模拟中的当前时间。 

•关键字“pi”的意思是 3.14159265358979323846。 

•以下功能: 

Function Name Description 

abs(x)  Absolute value of x  

absdelay(x,t[,tmax])  x delayed by t. Optional max delay notification tmax. 

acos(x)  Real part of the arc cosine of x, e.g., acos(-5) returns 3.14159, not 

3.14159+2.29243i 

arccos(x)  Synonym for acos()  

acosh(x)  Real part of the arc hyperbolic cosine of x, e.g., acosh(.5) returns 0, 

not 1.0472i 

asin(x)  Real part of the arc sine of x, asin(-5) is -1.57080, not -

1.57080+2.29243i 

arcsin(x)  Synonym for asin()  

asinh(x)  Arc hyperbolic sine  

atan(x)  Arc tangent of x  
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arctan(x)  Synonym for atan()  

atan2(y,x)  Four quadrant arc tangent of y/x 

atanh(x)  Arc hyperbolic tangent 

buf(x)  1 if x > .5, else 0 

ceil(x)  Integer equal or greater than x 

cos(x)  Cosine of x  

cosh(x)  Hyperbolic cosine of x 

ddt(x)  Time derivative of x  

delay(x,t[,tmax]  Same as absdelay()  

dnlim(x,y,z)  Similar to max(x,y) but with a continuous 1st derivative transition width 

z 

exp(x)  e to the x  

floor(x)  Integer equal to or less than x 

hypot(x,y)  sqrt(x**2 + y**2)  

idt(x[,ic[,a]])  Integrate x, optional initial condition ic, reset if a is true. 

idtmod(x[,ic[,m[,o]]] Integrate x, optional initial condition ic, reset on reaching modulus m, 

offset output by o. 

if(x,y,z)  If x > .5, then y else z 

int(x)  Convert x to integer 

inv(x)  0. if x > .5, else 1. 

limit(x,y,z)  Intermediate value of x, y, and z 

ln(x)  Natural logarithm of x 

log(x)  Alternate syntax for ln() 

log10(x)  Base 10 logarithm  

max(x,y)  The greater of x or y  

min(x,y)  The smaller of x or y  

pow(x,y)  Real part of x**y, e.g., pow(-1,.5)=0, not i. 

pwr(x,y)  abs(x)**y  

pwrs(x,y)  sgn(x)*abs(x)**y  

rand(x)  Random number between 0 and 1 depending on the integer value of x. 

random(x)  Similar to rand(), but smoothly transitions between values. 

round(x)  Nearest integer to x  

sdt(x[,ic[,assert]]) Alternate syntax for idt() 

sgn(x)  Sign of x  

sin(x)  Sine of x  

sinh(x)  Hyperbolic sine of x  

sqrt(x)  Square root of x  

table(x,a,b,c,d,...)  Interpolate a value for x based on a look up table given as a set of pairs 

of points. 

tan(x)  Tangent of x.  

tanh(x)  Hyperbolic tangent of x 
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u(x)  Unit step, i.e., 1 if x > 0., else 0. 

uplim(x,y,z)  Similar to min(x,y) but with a continuous 1st derivative transition width 

z 

uramp(x)  x if x > 0., else 0. 

white(x)  Random number between -.5 and .5 smoothly transitions between values even 

more smoothly than random(). 

!(x)  Alternative syntax for inv(x) 

~(x)  Alternative syntax for inv(x) 

下列运算，按求值先后次序排列: 

Operand Description 

&  Convert the expressions to either side to Boolean, then AND. 

|  Convert the expressions to either side to Boolean, then OR.  

^  Convert the expressions to either side to Boolean, then XOR. 

    

>  True if expression on the left is greater than the expression on the right, otherwise false. 

<  True if expression on the left is less than the expression on the right, otherwise false. 

>=  True if expression on the left is greater than or equal the expression on the right, otherwise 

false. 

<=  True if expression on the left is less than or equal the expression on the right, otherwise 

false. 

    

+  Floating point addition 

-  Floating point subtraction 

    

*  Floating point multiplication 

/  Floating point division 

    

**  Raise left hand side to power of right hand side. Only the real part is returned, e.g., -1**1.5 

gives zero not i. 

    

!  Convert the following expression to Boolean and invert. 

True 在数值上等于 1 False 等于 0。如果值大于 0.5，则将值转换为 1，否则将值转换为 0。 

注意,LTspice 使用插入符号字符,^,布尔 XOR 和乘方的“* *”。此外，LTspice 还区分了指数运算、x**y 和函数

pwr(x,y)。一些第三方模拟器对行为求幂的实现不正确，将-3**3 错误地计算为 27，而不是-27，可能是为了避免将负数求

幂为非整数幂的问题。LTspice 通过返回求幂结果的实部来处理这个问题。例如，-2**1.5 等于 0，这是正确答案

2.82842712474619i 的实部。这意味着当你导入一个第三方模式针对第三方模拟器,您可能需要翻译的语法如 x ^ y x * * 

y,甚至压水式反应堆(x,y)。 

如果定义了一个可选的拉普拉斯变换，该变换将应用于行为电流或电压的结果。拉普拉斯变换必须单独一个函数 s。逻辑异

或操作,^,据悉,意思是乘方,* *,当用于拉普拉斯表达式。用根号(-1)*2*pi*f 替换 s得到频率 f 处的频率响应。时域特性
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是由瞬时电流(或电压)与脉冲响应的历史卷积得到的。拉普拉斯传递函数在时域脉冲响应中的数值反演是一个潜在的计算约

束过程，也是当前数值研究的一个课题。在 LTspice 中，脉冲响应是由频域响应中离散设定值的 FFT 得到的。这一过程容易

出现 FFT 的常见伪影，如频谱泄漏和尖桩栅栏，这是离散 FFT 的常见现象。LTspice 使用一种专有的算法，利用它对频域响

应有一个精确的解析表达式，并选择点和窗口使这些工件精确地衍射到零。然而，LTspice 必须猜测适当的频率范围和分辨

率。建议首先允许 LTspice 对此进行猜测。窗口的长度和使用的 FFT 数据点的数量将在.log 文件中报告。然后，您可以通

过显式设置 nfft 和窗口长度来调整算法的选择。窗口值的倒数是频率分辨率。nfft 乘以此分辨率的值是考虑的最高频率。

注意脉冲响应与行为源的卷积也可能是一个计算约束过程。 
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5.4.3 C.电容 

符号名称: CAP, POLCAP 

语法: Cnnn n1 n2 <capacitance> [ic=<value>] 

+ [Rser=<value>] [Lser=<value>] [Rpar=<value>] 

+ [Cpar=<value>] [m=<value>] 

+ [RLshunt=<value>] [temp=<value>] 

可以指定等效串联电阻，串联电感，并联电阻，并联闭合电容。等效电路如下： 

 

电容实例参数 

Name Description 

Rser  Equivalent series resistance  

Lser  Equivalent series inductance  

Rpar  Equivalent parallel resistance  

Cpar  Equivalent parallel capacitance 

RLshunt Shunt resistance across Lser  

m  Number of parallel units  

temp  Instance temperature(for tempcos in a corresponding .model statement) 

ic  Initial voltage(used only if uic is flagged on the .tran card) 

计算上最好将寄生 Rpar、Rser、RLshunt、Cpar 和 Lser 包含在电容器中，这样比简单地估算他们要好。LTspice 使用专有

的电路仿真技术来方针这种没有任何内部节点的物理电容器模型。这使得仿真矩阵更小，求解速度更快，并且在短时间内奇

异的可能性更小。 

需要注意的是，由于电容元件包含了这些寄生特性，因此它对于压电晶体的宏观基本原理是非常有用的。 

还有一个通用的非线性电容器可用。与其指定电容，不如编写电荷的表达式。 

LTspice 将编译这个表达式并对所有变量进行符号微分，找到与电容对应的偏导数。 

语法: Syntax: Cnnn n1 n2 Q=<expression> [ic=<value>] [m=<value>] 
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有一个特殊的变量 x，它表示设备上的电压。因此，100pF 恒容可以写成 

Cnnn n1 n2 Q=100p*x 

在零电压下，电容由 100p 突变为 300p，可以写成 

Cnnn n1 n2 Q=x*if(x<0,100p,300p) 

该装置用于快速评估一种新的假设电荷模型的行为，例如晶体管。 
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5.4.4 D.二极管 

符号名称: DIODE, ZENER, SCHOTTKY, VARACTOR, LED, TVS. 

语法: Dnnn anode cathode <model> [area] [off] [m=<val>] [n=<val>] [temp=<value>] 

Examples: 

D1 SW OUT MyIdealDiode 

.model MyIdealDiode D(Ron=.1 Roff=1Meg Vfwd=.4) 

D2 SW OUT dio2 

.model dio2 D(Is=1e-10) 

实例参数 M设置并行元件的数量，而实例参数 N设置串行元件的数量。 

二极管需要.model 来指定其特性。有两种可用的二极管。一个是一个传导区域线性模型，产生一个理想二极管的计算重量

轻的表示。它有三个线性传导区域:通、关和反向击穿。正向传导和反向击穿可以用 Ilimit(revIlimit)来指定一个电流极

限，从而实现非线性。tanh()用来拟合正向传导的斜率至极限电流。可以指定参数 epsilon 和 revepsilon 来平滑地切换开

关和导电状态。之间符合二次函数等状态,二极管的电流-电压曲线是连续值和斜率和过渡发生在指定的电压值 ε 的去向前

传导和 revepsilon 之间的过渡,反向击穿。 

以下为该类型二极管的模型参数: 

Name Description Units Default 

Ron  Resistance in forward conduction  Ω 1.0  

Roff  Resistance when off  Ω 1/Gmin 

Vfwd  Forward threshold voltage to enter 

conduction 

V  0.0  

Vrev  Reverse breakdown voltage  V  Infin. 

Rrev  Breakdown impedance  Ω Ron  

Ilimit  Forward current limit  A  Infin. 

Revilimit  Reverse current limit  A  Infin. 

Epsilon  Width of quadratic region  V  0.0  

Revepsilon Width of reverse quad. region  V  0.0  

如果模型中指定了 Ron、Roff、Vfwd、Vrev 或 Rrev，则使用此理想化模型。 

另一个可用的模型是标准伯克利 SPICE 半导体二极管，但扩展到处理更详细的击穿行为和重组电流。面积因子决定了指定模

型的等效并行设备的数量。下面是该二极管的模型参数。 

Name Description Units Default Example 

Is  saturation current  A  1e-14 1e-7 
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Rs  Ohmic resistance  Ω  0.0  10. 

N  Emission coefficient  -  1.0  1.0 

Tt  Transit-time  sec  0.0  2n 

Cjo  Zero-bias junction cap.  F  0.0  2p 

Vj  Junction potential  V  1.0  0.6 

M  Grading coefficient  -  0.5  0.5 

Eg  Activation energy  eV  1.11  1.11 Si  

0.69 Sbd 

0.67 Ge  

Xti  Sat.-current temp. exp  -  3.0  3.0 jn  

2.0 Sbd 

Kf  Flicker noise coeff.  -  0.0    

Af  Flicker noise exponent  1.  1.0    

Fc  Coeff. for forward-bias depletion 

capacitance formula 

-  0.5    

BV  Reverse breakdown voltage  V  Infin. 40. 

nbv  Reverse breakdown emission 

coefficient  

-  1.0  2.0 

Ibv  Current at breakdown voltage  A  1e-10   

Ibvl  Low-level reverse breakdown knee 

current  

A  0.0    

nbvl  Low-level reverse breakdown 

emission coefficient  

-  1.0    

Tnom  Parameter measurement temp.  °C  27  50 

Isr  Recombination current parameter  A  0.0    

Nr  Isr emission coeff.  -  2.0    

Ikf  High-injection knee current  A  Infin.   

Tikf  Linear Ikf temp coeff.  /°C  0.0    

Trs1  linear Rs temp coeff.  /°C  0.0    

Trs2  Quadratic Rs temp coeff.  /°C
2
 0.0    

Tbv1  Breakdown voltage temp coeff.  /°C  0.0    

Tbv2  Quadratic breakdown voltage temp 

coeff.  

/°C
2
 0.0    
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Perim Default perimeter  m  0.0    

Isw  Sidewall Is  A  0.0    

ns  Sidewall emission coefficient  -  1.0    

Rsw  Sidewall series resistance  Ω  0.0    

Cjsw  Sidewall Cjo  F  0.0    

Vjsw  Sidewall Vj  V  Vj    

mjsw  Sidewall mj  -  0.33    

Fcs  Sidewall Fc  -  Fc    

Vp  Soft reverse recovery parameter  -  0.0  0.65 

根据 Teng 和 S. Pan 在 1996 年 2 月 15 日出版的《电子通讯》第 32 卷第 4 期中提出的“模拟二极管反向恢复的修正电荷控

制方程”，软反向恢复参数 Vp 给二极管充电增加了 dQ/dt 阻尼。 

可以用电压和电流额定值对模型进行注释。此信息显示在原理图捕获 GUI 中，以帮助选择设备，但不会直接影响仿真中的电

气行为。可以指定以下参数。 

Name Description Units 

Vpk  Peak voltage rating V 

Ipk  Peak current rating A 

Iave Ave current rating  A 

Irms RMS current rating  A 

diss Maximum power dissipation rating W 
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5.4.5 E.电压相关的电压源 

Symbol Names: E, E2 

有三种电压相关的电压源电路元件。 

Syntax: Exxx n+ n- nc+ nc- <gain> 

该电路元件断言节点 n+和节点 n-之间的输出电压，该电压取决于节点 nc+和 nc-之间的输入电压。这是一个线性相关的源，

仅由常数增益指定。 

Syntax: Exxx n+ n- nc+ nc- table=(<value pair>, <value pair>, ...) 

查找表用于指定传递函数。该表是一组数字对的列表。该对的第二个值是当控制电压等于该对的第一个值时的输出电压。当

控制电压在指定的点之间时，输出线性插值。如果控制电压超出查表范围，则输出电压外推为查表最后一个点的恒压。 

Syntax: Exxx n+ n- nc+ nc- Laplace=<func(s)> 

+ [window=<time>] [nfft=<number>] [mtol=<number>]  

这个电路元件的传递函数由它的拉普拉斯变换来表示。拉普拉斯变换必须是 s 的函数。频率 f处的频率响应是用根号(-

1)*2* f 替换 s得到的。时域特性是由频域响应的傅里叶变换得到的脉冲响应得到的。LTspice 必须猜测适当的频率范围和

分辨率。响应必须在高频率下降，否则报告错误。建议首先允许 LTspice 对此进行猜测，然后通过减少 reltol 或显式设置

nfft 和窗口来检查准确性。窗口值的倒数是频率分辨率。nfft 乘以此分辨率的值是考虑的最高频率。逻辑异或操作,“^”

据悉,意味着求幂“* *”中使用拉普拉斯表达式。 

Syntax: Exxx n+ n- value={<expression>} 

这是行为源的另一种语法，任意行为电压源 B。 

Syntax: Exxx n+ n- POLY(<N>) <(node1+,node1-) (node2+,node2-)+ ... (nodeN+,nodeN-)> <c0 c1 c2 c3 c4 ...> 

这是一种用多项式进行任意行为建模的古老方法。它对于运行遗留 opamp 模型非常有用。 

注:用带有电阻的 G 源来近似 E源比用 E源要好。与电压控制电压源相比，采用电阻分路的电压控制电流源计算速度更快，

收敛问题更少。此外，由此产生的非零输出阻抗更能代表实际电路。   
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5.4.6 F.电流相关电流源 

符号名称: F 

语法: Fxxx n+ n- <Vnam> <gain> 

这个电路元件在节点 n+和节点 n-之间施加电流。施加的电流等于增益值乘以通过指定为<Vnam>的电压源的电流。 

语法: Fxxx n+ n- value={<expression>} 

这是行为源的另一种语法，任意行为电压源 B。 

语法: Fxxx n+ n- POLY(<N>) <V1 V2 ... VN> <c0 c1 c2 c3 c4 ...> 

这是一种用多项式进行任意行为建模的古老方法。它对于运行遗留行为模型非常有用。 
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5.4.7 G.电压相关电流源 

符号名称:G, G2 

有三种电压相关的电流源电路元件。 

语法: Gxxx n+ n- nc+ nc- <gain> 

该电路元件断言节点 n+和节点 n-之间的输出电流依赖于节点 nc+和 nc-之间的输入电压。这是一个线性相关的源，仅由常数

增益指定。 

语法:Gxxx n+ n- nc+ nc- table=(<value pair>， <value pair>，…) 

这里使用一个查询表来指定传递函数。该表是一组数字对的列表。该对的第二个值是当控制电压等于该对的第一个值时的输

出电流。当控制电压在指定的点之间时，输出线性插值。如果控制电压超出查表范围，则输出电流外推为查表最后一点的恒

流。 

语法: Gxxx n+ n- nc+ nc- Laplace=<func(s)> [window=<time>] [nfft=<number>] [mtol=<number>] 

这个电路元件的传递函数由它的拉普拉斯变换来表示。拉普拉斯变换必须是 s 的函数。频率 f处的频率响应是用根号(-

1)*2* f 替换 s得到的。时域特性是由脉冲响应得到的，脉冲响应是由频域响应的傅里叶变换得到的。LTspice 必须猜测适

当的频率范围和分辨率。响应必须在高频率下降，否则报告错误。建议首先允许 LTspice 对此进行猜测，然后检查减少

reltol 或显式设置 nfft 和窗口的准确性。窗口值的倒数是频率分辨率。nfft 乘以此分辨率的值是考虑的最高频率。逻辑异

或操作,“^”据悉,意味着求幂“* *”中使用拉普拉斯表达式。 

语法:Gxxx n+ n- value={<expression>} 

这是行为源的另一种语法，任意行为电压源 B。 

语法: Gxxx n+ n- POLY(<N>) <(node1+,node1-) (node2+,node2-) ... (nodeN+,nodeN-)> <c0 c1 c2 c3 c4 ...> 

这是一种用多项式进行任意行为建模的古老方法。它对于运行遗留行为模型非常有用。 
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5.4.8 H.电流相关电压源 

符号名称:H 

语法:Hxxx n+ n- <Vnam> <transresistance> 

这个电路元件在节点 n+和节点 n-之间施加电压。施加的电压等于跨阻值乘以通过电压源的电流<Vnam>。 

语法:Hxxx n+ n- value={<expression>} 

这是行为源的另一种语法，任意行为电压源 B。 

语法:Hxxx n+ n- POLY(< n >) <V1 V2…V3> <c0 c1 c2 c3 c4…> 

这是一种用多项式进行任意行为建模的古老方法。 
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5.4.9 I.电流源 

符号名称: CURRENT 

语法: Ixxx n+ n- <current> [AC=<amplitude>] [load] 

这个电路元件在节点 n+和节点 n-之间产生恒定电流。如果源被标记为负载，则源将被迫耗散，也就是说，如果节点 n+和节

点 n-之间的电压变为零或负值，则电流变为零。此选项的目的是对电源上的电流负载进行建模，如果输出电压为零，则电

源上的电流负载不会产生电流。 

在交流分析中，交流值作为源在分析频率处的幅值。 

语法: Ixxx n+ n- PULSE(Ioff Ion Tdelay Trise Tfall Ton Tperiod Ncycles) 

时变脉冲电流源 

Name Description Units 

Ioff Initial value A 

Ion Pulsed value A 

Tdelay Delay sec 

Tr Rise time sec 

Tf Fall time sec 

Ton On time sec 

Tperiod Period sec 

Ncycles Number of cycles(Omit for free-running pulse 

function) 

cycles 

语法: Ixxx n+ n- SINE(Ioffset Iamp Freq Td Theta Phi Ncycles) 

时变正弦波电流源。 

Name Description Units 

Ioffset DC offset A 

Iamp Amplitude A 

Freq Frequency Hz 

Td Delay sec 

Theta Damping factor 1/sec 

Phi Phase of sine wave degrees 
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Ncycles Number of cycles(Omit for free-running pulse 

function) 

cycles 

对于小于 Td 或完成 Ncycles 后的运行次数，输出电流由 Ioffset+Iamp*sin(pi*phi/180)给出，否则输出电流由 

(Ioffset +国际* exp () - time-Td *θ)*罪(2 * p *频率* (time-Td) + p *φ/ 180) 

阻尼因子，是衰减时间常数的倒数。 

语法: Ixxx n+ n- EXP(I1 I2 Td1 Tau1 Td2 Tau2) 

时变指数电流源 

Name Description Units 

I1  Initial value  A  

I2  Pulsed value  A  

Td1  Rise delay time  sec 

Tau1 Rise-time constant sec 

Td2  Fall delay time  sec 

Tau2 Fall-time constant sec 

对于小于 Td1 的次数，输出电流为 I1。对于 Td1 和 Td2 之间的时间，电流由>给出 

I1 + (I2-I1) * (1-exp (- (time-Td1) / Tau1)) 

对于 Td2 之后的时间，电流由 

I1 + (I2-I1) * (1-exp (- (time-Td1) / Tau1))——(I2-I1) * (1-exp (- (time-Td2) / Tau2)) 

语法: Ixxx n+ n- SFFM(Ioff Iamp Fcar MDI Fsig) 

时变单频调频电流源。 

Name Description Units 

Ioff DC offset  A  

Iamp Amplitude  A  

Fcar Carrier frequency Hz 

MDI  Modulation index  -  

Fsig Signal frequency  Hz 
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电流是 

Ioff+Iamp*sin((2.*p*Fcar*time)+MDI*sin(2.*p*Fsig*time)). 

Syntax: Ixxx n+ n- tbl=(<voltage, current>, <voltage, current>, ...) 

电流还可以通过一个查找表指定为输出节点之间的电压的函数。这对于建模负载的特性非常有用。 

Syntax: Ixxx n+ n- <value> step(<value1>, [<value2>], [<value3>, ...]) [load] 

这是当前源的一种特殊形式。电流被指定为在阶跃负载响应瞬态分析中使用的电流列表。在此模式下，仿真计算到列表中第

一个电流<value1>处达到稳态为止。然后，将电流逐步转移到列表中的下一个值<value2>。模拟一直进行到该电流达到稳定

状态。然后，将电流逐步转移到下一个值，并重复此过程，直到列表耗尽。如果.tran 命令没有指定“step”，则使用原始

的<值>。 

语法:Ixxx n+ n- R=<value> 

这根本不是一个电流源，而是一个电阻。它是用来建模电阻负荷时，负荷是作为一个电流源。 

语法:Ixxx n+ n- PWL(t1 i1 t2 i2 t3 i3…) 

任意分段线性电流源。 

对于 t1 之前的时间，电流是 i1。对于 t1 和 t2 之间的时间，电流在 i1 和 i2 之间线性变化。可以有任意数量的时间，给定

的当前点。对于最后一次之后的时间，电流就是最后一次电流。 

语法:Ixxx n+ n- wavefile=<filename> [chan=<nnn>] 

这允许将.wav 文件用作 LTspice 的输入。<filename>是.wav 文件的完整绝对路径，或者是从包含模拟示意图或 netlist 的

目录计算的相对路径。双引号可用于指定包含空格的路径。wav 文件可能包含最多 65536 个通道，编号为 0到 65535。可以

将 Chan 设置为指定使用哪个通道。默认情况下，使用第一个通道 number 0。wav 文件被解释为具有从-1A 到 1A 的完整范

围。 

这个源只在.tran 分析中有意义。 
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5.4.10 J.JFET 晶体管 

Symbol Names: NJF, PJF 

Syntax: Jxxx D G S <model> [area] [off] [IC=Vds, Vgs] [temp=T] 

例子: 

J1 0 in out MyJFETmodel 

.model MyJFETmodel NJF(Lambda=.001) 

J2 0 in out MyPJFETmodel 

.model MyPJFETmodel PJF(Lambda=.001) 

JFET 晶体管需要.model 卡来指定其特性。注意，模型卡关键字 NJF 和 PJF 指定晶体管的极性。面积因子决定了指定模型的

等效并行设备的数量。 

JFET 模型是由 Shichman 和 Hodges 的 FET 模型推导而来，扩展到包括栅结复合电流和冲击电离。直流特性由 VTO 和 BETA 参

数定义，这两个参数决定了漏极电流随门极电压的变化;决定输出电导;为两个栅结的饱和电流。包括两个欧姆电阻，Rd 和

Rs。采用非线性耗尽层电容法模拟电荷存储过程;其变化为结电压的-1/2 次方，由参数 Cgs、Cgd 和 PB 定义。增加了拟合参

数 B。参见 A. E. Parker 和 D. J. Skellern，计算机仿真器的改进 FET 模型，IEEE Trans CAD，第 9卷 5，第 551-553

页，1990 年 5月。 
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5.4.11 K.互感 

符号名称:无，这是放在图式上的文本。 

语法: Kxxx L1 L2 [L3 ...] <coefficient> 

L1 和 L2 是电路中电感的名称。互耦系数必须在-1到 1 之间。 

这条线 

K1 L1 L2 L3 L4 1。 

这六行是同义词吗 

K1 L1 L2 1。 

K2 L2 L3 1。 

K3 L3 L4 1。 

K4 L1 L3 1。 

K5 L2 L4 1。 

K6 L1 L4 1。 

建议开始设计时，互耦系数为 1。这将消除泄漏电感，可以环在非常高的频率，如果没有阻尼和减缓模拟。 
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5.4.12 L.电感 

Symbol Names: IND, IND2 

Syntax: Lxxx n+ n- <inductance> [ic=<value>] 

+ [Rser=<value>] [Rpar=<value>] 

+ [Cpar=<value>] [m=<value>] [temp=<value>] 

可以指定等效串联电阻、串联电感、并联电阻和并联闭合电容。等效电路如下: 

 

电感实例参数 

Name Description 

Rser Equivalent series resistance 

Rpar Equivalent parallel resistance 

Cpar Equivalent parallel capacitance 

m Number of parallel units 

ic Initial current(used only if uic flagged on the .tran card) 

tc1 Linear inductance temperature coeff. 

Tc1 Quadratic inductance temperature coeff. 

temp Instance temp 

将器件寄生 Rpar、Rser 和 Cpar 包含在电感器中比显式地绘制它们要好。LTspice 使用专有的电路模拟技术来模拟这种没有

任何内部节点的物理电感。这使得仿真矩阵更小，计算速度更快，并且不太可能在所有时间步长的情况下都是奇异的。 

默认情况下，LTspice 将向电感提供损耗，以帮助 SMPS 瞬态分析。对于 smp，这些损失通常没有什么后果，但如果需要，可

以关闭。在“工具=>控制面板=>Hacks!”页上，取消勾选“如果没有给出 Rpar，则提供最小电感阻尼”。此设置将在程序

调用之间被记住。对于互感声明中没有提到的电感器，还有一个默认的 1毫欧姆串联电阻。该 Rser 允许 LTspice XVII 将电

感集成为诺顿等效电路，而不是 Thevenin 等效电路，以减少电路线性化矩阵的大小。如果不希望 LTspice 引入最小电阻，

则必须显式地为该电感设置 Rser=0。这将要求 LTspice 在瞬态分析中使用更笨重的等效电感器 Thevenin。 
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在 LTspice 中有两种形式的非线性电感。一种是用通量表达式指定的行为电感。电感的电流由表达式中的关键字“x”表

示。下面是一个 netlist 中的例子。 

* 

L1 N001 0 通量=1m*tanh(5*x) 

I1 0 N001 PWL(0 01 1) 

.tran 1 

.end 

在上面的例子中，I1提供了一个单位 dI/dT，这样电感就可以作为节点 N001 上的电压读出。 

LTspice 中还有一种非线性电感是基于 John Chan 等人首先提出的模型建立的滞回型铁芯模型。在 IEEE 计算机辅助设计学

报，第 10卷。1991 年 4月 4 日第 4号，但以美国专利 7 502 723 的方法予以扩展。该模型只定义了三个参数的滞回线: 

Name Description Units 

Hc Coercive force Amp-turns/meter 

Br Remnant flux density Tesla 

Bs Saturation flux density Tesla 

给出了磁滞回线主回路的上、下分支 

 

和 

 

这些函数如下图所示。Hc 和 Br 是主磁滞回线与 H 轴和 b轴的交点。废话是渐近的 b轴相交线,Bsat(H)= b +μ0·H,H 趋于

无穷。 
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初始磁化曲线为 

Bmag(H) = .5·(Bup(H) + Bdn(H)) 

根据所引用的文献，通过对上述方程的各种翻译得到小环。岩心的绝对渗透率和微分渗透率是 H 的函数，H的历史值如下图

所示。44 t, Br = .10T)。 

 

除芯材性能参数 Hc、Br、Bs 外，还要求芯材的机械尺寸: 

Name Description Units 

Lm Magnetic Length(excl. gap) meter 

Lg Length of gap meter 
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A Cross sectional area meter**2 

N Number of turns - 

注意，如果指定一个非零间隙，磁场 H与线圈中的电流不成比例。LTspice 是在截面面积均匀、间隙薄或均匀分布的情况

下，求解铁芯和间隙中的磁场。 

下面是一个例子，显示电感与电流的 L1，电感线圈上的缺口核心。你可以读出电感为 V(n001)，因为电流源 I1 提供单位

dI/dt。岩心遵循初始磁化曲线，所以你可以看到，随着电流的增加，渗透率首先从初始值增加，然后随着电流的饱和而下

降。由于间隙使电感不敏感的确切渗透率的核心，你必须真正放大 V(n001)，以看到它确实增加。峰值是当核内的 H等于它

的 Hc。 

* 

L1 N001 0 Hc=16。b =。44 Br =。10 = 0.0000251 

+ Lm=0.0198 Lg=0.0006858 N=1000 

I1 0 N001 PWL(0 01 1) 

.tran 5 

.options maxstep = 10 u 

.end 
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5.4.13 M.MOSFET 

符号名称：NMOS, NMOS3, PMOS, PMOS3 在 LTspice 中有两种基本不同类型的 MOSFET，单片 mosfts 和一种新的垂直双扩散功

率 MOSFET 模型。 

集成的单片 MOSFET: 

Syntax: Mxxx Nd Ng Ns Nb <model> [m=<value>] [L=<len>] 

+ [W=<width>] [AD=<area>] [AS=<area>] 

+ [PD=<perim>] [PS=<perim>] [NRD=<value>] 

+ [NRS=<value>] [off] [IC=<Vds, Vgs, Vbs>] 

+ [temp=<T>] 

M1 Nd Ng Ns 0 MyMOSFET 

.model MyMOSFET NMOS(KP=.001) 

M1 Nd Ng Ns Nb MypMOSFET 

.model MypMOSFET PMOS(KP=.001) 

垂直双扩散功率 MOSFET: 

Syntax: Mxxx Nd Ng Ns <model> [L=<len>] [W=<width>] 

+ [M=<area>] [m=<value>] [off] 

+ [IC=<Vds, Vgs, Vbs>] [temp=<T>] 

Example: 

M1 Nd Ng Ns Si4410DY 

.model Si4410DY VDMOS(Rd=3m Rs=3m Vto=2.6 Kp=60 

+ Cgdmax=1.9n Cgdmin=50p Cgs=3.1n Cjo=1n 

+ Is=5.5p Rb=5.7m) 

MOSFET 的模型卡指定了要使用的类型。模型卡关键字 NMOS 和 PMOS 指定了一个单片 N或 P 通道 MOSFET 晶体管。模型卡关键

字 VDMOS 指定一个垂直双扩散功率 MOSFET。 

单片 mosfet 是四种终端器件。Nd、Ng、NS、Nb 为排水、浇口、源、体;即。衬底;节点。L和 W 是通道的长度和宽度，单位

是米。以及排水和源扩散的面积，单位为平方米。注意后缀 u指定 μmμm 和 p广场。如果没有指定任何 L、W、AD 或 AS，

则使用默认值。PD 和 PS 是排水和源结点的周长，单位为米。NRD 和 NRS 分别表示排水和源扩散的等效平方数;这些值乘以. 

model 控制线上指定的片状电阻 RSH。PD 和 PS 默认为 0,NRD 和 NRS 默认为 1。OFF 表示用于直流分析的设备的初始条件。使

用 IC=VDS、VGS、VBS 的初始条件规范用于. tran 控制线上的 UIC 选项，当需要从静态工作点以外的地方开始进行瞬态分析

时。可选的温度值是该设备运行时的温度，并覆盖. option 控制线上的温度规范。温度规范仅适用于 1、2、3 和 6级

mosfet，不适用于 4、5 或 8级 BSIM 设备。 

LTspice 包括 7种不同类型的单片 MOSFET 和一种垂直双扩散功率 MOSFET。 

有七个单片 MOSFET 器件模型。模型参数级别指定要使用的模型。默认级别是 1。 

1 Shichman-Hodges 
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(参见 A. Vladimirescu 和 S. Liu, MOS 集成电路使用 SPICE2 仿真，ERL Memo No。(1980 年 10 月，加州大学伯克利分校电

子研究实验室 M80/7) 

3 MOS3，半经验模型(参见第 2级参考) 

4 BSIM(见 B. J. Sheu, D. L. Scharfetter, and P. K. Ko, SPICE2 BSIM 的实施)。话务量的备忘录。(1985 年 5月，加

州大学伯克利分校电子研究实验室，ERL M85/42) 

5 BSIM2(见 Jeng - chie，深亚微米 mosfet ERL 设计与建模备忘录编号:ERL M90/90，加州大学伯克利分校电子研究实验

室，1990 年 10 月) 

(参见 T. Sakurai 和 A. R. Newton，用于电路分析的简单 MOSFET 模型及其在 CMOS 栅延迟分析和串连 MOSFET 结构中的应

用，ERL Memo No。(1990 年 3 月，加州大学伯克利分校电子研究实验室，ERL M90/19) 

8 加州大学伯克利分校 BSIM3v3.3.0 截至 2005 年 7 月 29 日 

9 加州大学伯克利分校 BSIM 研究小组的 BSIMSOI3.2(绝缘体上的硅)，2004 年 2 月。 

12 EKV 2.6 基于洛桑联邦理工学院的代码。参见 http://legwww.epfl.ch/ekv 和《EPFL-EKV MOSFET 仿真模型方程，2.6

版》，M. Bucher, C. Lallement, F. Theodoloz, C. Enz, F. Krummenacher, EPFL-DE-LEG, 1997 年 6月。 

14 BSIM4.6.1 来自加州大学伯克利分校 BSIM 研究小组，2007 年 5 月 18 日。 

来自广岛大学和 STARC 的 HiSIMHV 1.2 版本。 

1 级至 3 级 mosfet 的直流特性由器件参数 VTO、KP、LAMBDA、PHI 和 GAMMA 定义。如果过程参数(NSUB, TOX，…)给定，则

计算这些参数，但是用户指定的值总是覆盖这些参数。VTO 对于增强模式为正(负)，对于损耗模式 n 通道(p 通道)器件为负

(正)。电荷存储模型由三个常数电容器,CGSO,CGDO,和 CGBO 代表重叠的参数的非线性 thin-oxide 电容分布在大门口,来源,

排水,和大部分地区,以及非线性耗尽层的功放衬底连接分为底和边缘,而不同的乔丹和 MJSW 权力结电压分别由参数决定的

CBD,CBS,CJ,CJSW、乔丹、MJSW 和铅。通道电容在仿真的各个方面都被实现为基于 Yang-Chatterjee 电荷的模型，但是

SPICE 日志文件中报告了遗留的 Meyer 电容。在 Level=1 模型中，薄氧化层电荷存储效应略有不同。只有在指定了 Tox 时，

这些电压相关的电容才包括在内。 

描述节点的参数之间存在一定的重叠，例如反向电流可以通过 is [Amp]或 Js[Amp/m/m]来指定。第一个是绝对值，第二个乘

以 Ad，分别给出漏极和源极连接的反向电流。同样的思路也适用于零偏结电容 CBD 和 CBS[Farad]， CJ[Farad/m/m]。寄生

漏源串联电阻可以表示为 RD和 RS[欧姆]，也可以表示为 RSH[欧姆/平方]，后者乘以器件线上输入的 NRD 和 NRS 的平方个

数。 

MOSFET 1、2、3 级参数: 

Name Description Units Default Example 

Vto Zero-bias threshold voltage V 0 1.0 

Kp Transconductance parameter A/V2 2e-5 3e-5 

Gamma Bulk threshold parameter V½ 0. 0.37 

Phi Surface inversion potential V 0.6 0.65 
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Lambda Channel-length modulation (level 

1 and 2) 

1/V 0. 0.02 

wd Lateral diffusion width reduction m 0. 0.5u 

Rd Drain ohmic resistance Ω 0. 1. 

Rs Source ohmic resistance Ω 0. 1. 

Rg Gate ohmic resistance Ω 0. 1. 

Rb Bulk ohmic resistance Ω 0. 1. 

Rds Drain-Source shunt resistance Ω 0. 1Meg 

Cbd Zero-bias B-D junction 

capacitance 

F 0. 20f 

Cbs Zero-bias B-S junction 

capacitance 

F 0. 20f 

Is Bulk junction saturation current A 1e-14 1e-15 

N Bulk diode emission coefficient - 1.   

Pb Bulk junction potential V 0.8 0.87 

tt Bulk junction transit time s 0 1n 

Cgso Gate-source overlap capacitance 

per meter channel width 

F/m 0. 4e-11 

Cgdo Gate-drain overlap capacitance 

per meter channel width 

F/m 0. 4e-11 

Cgbo Gate-bulk overlap capacitance per 

meter channel width 

F/m 0. 2e-10 

Rsh Drain and source diffusion sheet 

resistance 

Ω 0. 10. 

Cj Zero-bias bulk junction bottom 

capacitance per square meter of 

junction area 

F/m2 0. 2e-4 

Mj Bulk junction bottom grading 

coefficient 

- 0.5 0.5 

Cjsw Zero-bias bulk junction sidewall 

capacitance per meter of junction 

perimeter 

F/m 0. 1p 

Mjsw Bulk junction sidewall grading 

coefficient 

- .50 level 1 

.33 level 2,3 
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Js Bulk junction saturation current 

per square-meter of junction area 

A/m2 0. 1u 

Jssw Bulk junction saturation current 

per meter of sidewall 

A/m 0. 1n 

Tox Oxide thickness m 1e-7 1e-7 

Nsub Substrate doping 1/cm3 0. 4e15 

Nss Surface state density 1/cm2 0. 1e+10 

Nfs Fast surface state (levels 2 & 3) 1/cm2 0. 1e+10 

Xd Depletion layer width (level 3) m 0. 100n 

TPG Type of gate material: 

 +1 opp. to substrate 

 -1 same as substrate 

  0 Al gate 

- 1   

Xj Metallurgical junction depth 

(levels 2 & 3) 

m 0. 1μ 

Ld Lateral diffusion m 0. 0.8μ 

Uo Surface mobility cm2/V/s 600 700 

Ucrit Critical field for mobility 

degradation (level 2) 

V/cm 1e4 1e4 

Uexp Critical field exponent in 

mobility degradation (level 2) 

- 0. 0.1 

Utra Transverse field coefficient 

(level 2) 

- 0. 0.3 

Vmax Maximum carrier drift velocity 

(levels 2 & 3) 

m/s 0. 5e4 

Neff Total channel-charge exponent 

(level 2) 

- 1. 5. 

Kf Flicker noise coefficient - 0. 1e-26 

Af Flicker noise exponent - 1. 1.2 

Nlev Noise equation selector - 0 1 

Gdsnoi Shot noise coefficient for nlev=3 - 1. 2. 

Fc Coefficient for forward-bias 

depletion capacitance formula 

- 0.5   

Delta Width effect on threshold voltage 

(levels 2 & 3) 

- 0. 1. 
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Theta Mobility modulation (level 3) - 0. 0.1 

Eta Static feedback (level 3) - 0. 1. 

Kappa Saturation field (level 3)   0.2 0.5 

Tnom Parameter measurement temperature °C 27 50 

L Default length m defl 20u 

W Default width m defw 20u 

Ad Default drain area m2 defad 200p 

As Default source area m2 defas  200p 

Pd Default drain perimeter m 0. 20u 

Ps Default source perimeter m 0. 20u 

Nrd Default drain squares - 0. 1 

Nrs Default source squares - 0. 1 

Nrg Default gate squares - 0. 1 

Nrb Default bulk squares - 0. 1 

Lmin Bin length lower limit m 0. 10u 

Lmax Bin length upper limit m 0. 20u 

Wmin Bin width lower limit m 0. 10u 

Wmax Bin width upper limit m 0. 20u 

 

离散垂直双扩散 MOSFET 晶体管(VDMOS)广泛应用于板级开关电源，其性能与上述单片 MOSFET 模型有质的不同。具体来说，

(i) VDMOS 晶体管的体二极管与外部端子的连接方式与单片 MOSFET 的衬底二极管的连接方式不同，(ii)单片 MOSFET 模型的

简单分级电容无法对栅漏电容(gate-drain 电容，Cgd)非线性进行建模。在 VDMOS 晶体管中，Cgd 突然改变约为零门漏电压

(Vgd)。当 Vgd 为负时，Cgd 的物理基础是一个电容，栅极为一个电极，漏极为另一个电极。这种电容是相当低的，由于厚

度的非导体模具。但当 Vgd 为正时，模具是导电的，Cgd 的物理基础是具有栅氧化层厚度的电容器。 
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传统上，精密的子电路被用来复制功率 MOSFET 的行为。为了提高计算速度、收敛的可靠性和编写模型的简便性，编写了一

种新的 spice 设备来封装这种行为。直流模型与一级单片 MOSFET 是相同的，除了长度和宽度默认为 1，以便跨导可以直接

指定而不缩放。AC 模型如下。门源电容取常数。根据经验，这是一个很好的近似功率 mosfet 如果门源电压不驱动负。栅极

漏极电容的经验发现形式如下: 

 

对于正 Vgd, Cgd 随着 Vgd 的双曲正切而变化。对于负 Vdg, Cgd 随着 Vgd 的反正切而变化。模型参数 a、Cgdmax、Cgdmax 对

栅极漏极电容进行了参数化。源漏电容由连接在源漏电极上、源漏电阻和漏电阻外部的体二极管的分级电容提供。 

Name Description Units Default Example 

Vto Threshold voltage V 0 1.0 

Kp Transconductance parameter A/V2 1. .5 

Phi Surface inversion potential V 0.6 0.65 

Lambda Channel-length modulation 1/V 0. 0.02 

mtriode Conductance multiplier in triode 

region(allows independent fit of 

triode and saturation regions 

- 1. 2. 

subthres Current(per volt Vds) to switch 

from square law to exponential 

subthreshold conduction 

A/V 0. 1n 

BV Vds breakdown voltage V Infin. 40 

IBV Current at Vds=BV A 100pA 1u 

NBV Vds breakdown emission 

coefficient 

- 1. 10 

Rd Drain ohmic resistance Ω 0. 1. 

Rs Source ohmic resistance Ω 0. 1. 
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Rg Gate ohmic resistance Ω 0. 2. 

Rds Drain-source shunt resistance Ω Infin. 10Meg 

Rb Body diode ohmic resistance Ω 0. .5 

Cjo Zero-bias body diode junction 

capacitance 

F 0. 1n 

Cgs Gate-source capacitance F 0. 500p 

Cgdmin Minimum non-linear G-D 

capacitance 

F 0. 300p 

Cgdmax Maximum non-linear G-D 

capacitance 

F 0. 1000p 

A Non-linear Cgd capacitance 

parameter 

- 1. .5 

Is Body diode saturation current A 1e-14 1e-15 

N Bulk diode emission coefficient - 1.   

Vj Body diode junction potential V 1. 0.87 

M Body diode grading coefficient - 0.5 0.5 

Fc Body diode coefficient for 

forward-bias depletion 

capacitance formula 

- 0.5   

oneway Behavioral modeling flag to 

indicate current can only flow 

in one direction in the channel 

- - - 

tt Body diode transit time sec 0. 10n 

Eg Body diode activation energy for 

temperature effect on Is 

eV 1.11   

Xti Body diode saturation current 

temperature exponent 

- 3.   

L Length scaling - 1.   

W Width scaling - 1.   

Kf Flicker noise coefficient - 0.   

Af Flicker noise exponent - 1.   

nchan[*] N-channel VDMOS - (true) - 

pchan[*] P-channel VDMOS - (false) - 
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Tnom Parameter measurement 

temperature 

°C 27 50 

Lmin Bin length lower limit m 0. 10u 

Lmax Bin length upper limit m 0. 20u 

Wmin Bin width lower limit m 0. 1 

Wmax Bin width upper limit m 0. 10 

*]模型名称 VDMOS 用于 n 通道和 p 通道设备。极性默认为 n通道。若要指定 P-channel，请用关键字“pchan”标记模型，

例如，“”。xyz VDMOS(Kp = 3 pchan)模型定义了一个 p通道晶体管。 

可以用额定电压和标称性能对模型进行注释。此信息显示在原理图捕获 GUI 中，以帮助选择设备，但不影响模拟中的电气行

为。可以指定以下参数。 

Name Description Units 

Vds Drain-source voltage rating V 

Ron Nominal on resistance Ω 

Qg Nominal gate charge required to get to Ron C 

mfg Name of manufacturer - 
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5.4.14 O.有损传输线 

Symbol Name: LTLIN 

Syntax: Oxxx L+ L- R+ R- <model> 

Example: 

O1 in 0 out 0 MyLossyTline 

.model MyLossyTline LTRA(len=1 R=10 L=1u C=10n) 

 这是一条单导体损耗传输线。N1和 N2 是端口 1 的节点。N3 和 N4 是端口 2 上的节点。需要一张模型卡来定义这种电路元件

的电气特性。 

损耗传输线模型参数 

Name Description Units/Type Default 

R Resistance per unit length Ω 0. 

L Inductance per unit length H 0. 

G Conductivity per unit length 1/Ω 0. 

C Capacitance per unit length F 0. 

Len Number of unit lengths - 0. 

Rel Relative rate of change of 

derivative to set a breakpoint 

  1. 

Abs Absolute rate of change of 

derivative to set a breakpoint 

  1. 

NoStepLimit Don't limit time- step to less 

than line delay 

(flag) not set 

NoControl Don't attempt complex time-

step control 

(flag) not set 

LinInterp Use linear interpolation (flag) not set 

MixedInterp Use linear interpolation when 

quadratic seems to fail 

(flag) not set 

CompactRel Reltol for history compaction   RELTOL 

CompactAbs Abstol for history compaction   ABSTOL 

TruncNr Use Newton-Raphson method for 

time-step control 

(flag) not set 

TruncDontCut Don't limit time-step to keep 

impulse-response errors low 

(flag) not set 
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5.4.15 Q.双极型晶体管 

Symbol Names: NPN, PNP, NPN2, PNP2 

Syntax: Qxxx Collector Base Emitter [Substrate Node] model [area] [off] [IC=<Vbe, Vce>] [temp=<T>] 

Example: 

Q1 C B E MyNPNmodel 

.model MyNPNmodel NPN(Bf=75) 

双极晶体管需要模型卡来指定其特性。模型卡关键字 NPN 和 PNP 表示晶体管的极性。 

双极结晶体管模型是对 Gummel 和 Poon 的积分电荷控制模型的一种改进。改进后的 Gummel-Poon 模型扩展了原始模型，包括

了高偏压水平、准饱和和基体导电性下的几个效应。当没有指定某些参数时，该模型自动简化为 Ebers-Moll 模型。直流模

型由决定正向电流增益特性的 Bf、Nf、Ise、Ikf 和 Ne 参数定义，决定反向电流增益特性的 Br、Nr、Isc、Ikr 和 Nc 参数定

义，决定正向和反向区域输出电导的 Vaf 和 Var 参数定义。包括三个欧姆电阻 Rb, Rc 和 Re，其中 Rb 可以是高电流相关

的。基础电荷存储采用正向和反向传输时间、Tf 和 Tr 建模，如果需要，正向传输时间 Tf 与偏置相关;和非线性耗尽层电

容，这是由 Cje, Vje 和 Mje 决定的 B-E 结，Cjc, Vjc，和 MJC 的 B-C 结和 Cjs, Vjs，和 Mjs 的集电极-基体结。饱和电流

的温度依赖性由能量间隙(如)和饱和电流温度指数(XTI)决定。在此基础上，用温度指数 XTB 对基极电流的温度依赖性进行

了建模。假设所指定的值是在温度 TNOM 下测量的，该温度 TNOM 可以在. options 控制线上指定，也可以被.model 线上的规

范覆盖。 

修改后的 Gummel-Poon 模型中使用的 BJT 参数如下所示。 

Modified Gummel-Poon BJT Parameters 

Name Description Units Default 

Is Transport saturation current A 1e-16 

Ibc Base-collector saturation current A Is 

Ibe Base-emitter saturation current A Is 

Bf Ideal maximum forward beta - 100 

Nf Forward current emission coefficient - 1. 

Vaf Forward Early voltage V Infin. 

Ikf Corner for forward beta high current roll-off A Infin. 

nk High current roll-off coefficient - .5 

Ise B-E leakage saturation current A 0. 

Ne B-E leakage emission coefficient - 1.5 

Br Ideal maximum reverse beta - 1. 

Nr Reverse current emission coefficient - 1. 



LTspice XVII help 中文翻译版 

 

 

本文由微信公众号 电子帮 翻译而成，仅用于学习交流，不可用于一切商业目的活动！ 

Var Reverse Early voltage V Infin. 

Ikr Corner for reverse beta high current roll-off A Infin. 

Isc B-C leakage saturation current A 0 

Nc B-C leakage emission coefficient - 2 

Rb Zero-bias base resistance Ω 0 

Irb Current where base resistance falls halfway to its min 

value 

A Infin. 

Rbm Minimum base resistance at high currents Ω Rb 

Re Emitter resistance Ω 0. 

Rc Collector resistance Ω 0. 

Cje B-E zero-bias depletion capacitance F 0. 

Vje B-E built-in potential V 0.75 

Mje B-E junction exponential factor - 0.33 

Tf Ideal forward transit time sec 0. 

Xtf Coefficient for bias dependence of Tf - 0. 

Vtf Voltage describing Vbc dependence of Tf V Infin. 

Itf High-current parameter for effect on Tf A 0. 

Ptf Excess phase at freq=1/(Tf*2*Ω)Hz ° 0. 

Cjc B-C zero-bias depletion capacitance F 0. 

Vjc B-C built-in potential V 0.75 

Mjc B-C junction exponential factor - 0.33 

Xcjc Fraction of B-C depletion capacitance connected to 

internal base node 

- 1. 

Xcjc2 Fraction of B-C depletion capacitance connected 

between internal base node and extrinsic collector 

- 0 

extsub Extrinsicness of more intrinsic collector node used 

for substrate capacitance charge division 

- 0 

Tr Ideal reverse transit time sec 0. 

Cjs Zero-bias collector-substrate capacitance F 0. 

Xcjs Fraction of Cjs connected internally to Rc F 0. 

Vjs Substrate junction built-in potential V 0.75 
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Mjs Substrate junction exponential factor - 0. 

Xtb Forward and reverse beta temperature exponent - 0. 

Eg Energy gap for temperature effect on Is eV 1.11 

Xti Temperature exponent for effect on Is - 3. 

Kf Flicker-noise coefficient - 0. 

Af Flicker-noise exponent - 1. 

Fc Coefficient for forward-bias depletion capacitance 

formula 

- 0.5 

subs Geometry selector if LPNP is not used: 1 means 

vertical 2 means lateral 

- NPN: 1 

PNP: 2 

BVcbo Collector-base breakdown voltage - Infin. 

nBVcbo Collector-base breakdown voltage coefficient - 5 

BVbe Base-emitter breakdown voltage V Infin. 

Ibvbe Current at base-emitter breakdown voltage A 1e-10 

nbvbe Base-emitter breakdown coefficient - 1. 

Tnom Parameter measurement temperature °C 27 

Cn Quasi-saturation temperature coefficient for hole 

mobility 

2.42 NPN 

2.2  PNP 

D Quasi-saturation temperature coefficient for 

scattering-limited hole carrier velocity 

.87 NPN 

.52 PNP 

Gamma Epitaxial region doping factor   1e-11 

Qco Epitaxial region charge factor Coul 0. 

Quasimod Quasi-saturation flag for temperature dependence - (not set) 

Rco Epitaxial region resistance Ω 0. 

Vg Quasi-saturation extrapolated bandgap voltage at 0°K V 1.206 

Vo Carrier mobility knee voltage V 10. 

Tre1 Re linear temperature coefficient 1/°C 0. 

Tre2 Re quadratic temperature coefficient 1/°C2 0. 

Trb1 Rb linear temperature coefficient 1/°C 0. 

Trb2 Rb quadratic temperature coefficient 1/°C2 0. 

Trc1 Rc linear temperature coefficient 1/°C 0. 
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Trc2 Rc quadratic temperature coefficient 1/°C2 0. 

Trm1 Rmb linear temperature coefficient 1/°C 0. 

Trm2 Rmb quadratic temperature coefficient 1/°C2 0. 

Iss Substrate junction saturation current A 0. 

Ns Substrate junction emission Coefficient - 1. 

Tvaf1 Vaf linear temperature coefficient 1/°C 0. 

Tvaf2 Vaf quadratic temperature coefficient 1/°C2 0. 

Tvar1 Var linear temperature coefficient 1/°C 0. 

Tvar2 Var quadratic temperature coefficient 1/°C2 0. 

Tikf1 Ikf linear temperature coefficient 1/°C 0. 

Tikf2 Ikf quadratic temperature coefficient 1/°C2 0. 

Trbm1 Rbm linear temperature coefficient 1/°C 0. 

Trbm2 Rbm quadratic temperature coefficient 1/°C2 0. 

Tbvcbo1 BVcbo linear temperature coefficient 1/°C 0. 

Tbvcbo2 BVcbo quadratic temperature coefficient 1/°C2 0. 

可以用设备级别对模型进行注释。此信息显示在原理图捕获 GUI 中，以帮助选择设备，但不会直接影响模拟中的电气行为。

可以指定以下参数。 

Name Description Units 

Vceo Maximum collector-emitter voltage with the base 

floating 

V 

Icrating Maximum collector current A 

mfg Name of manufacturer - 

模型参数“level”可用于在 LTspice 中指定另一种类型的 BJT。 

由于 NXP(飞利浦)的原因，设置 Level=504 使用 MEXTRAM 504 晶体管。 

由于 Dr.-Ing 对源代码的慷慨贡献。德国柏林 danalysis 有限公司的 Dietmar 警告;LTspice 包括 VBIC 的一个版本。设置

Level=9 以使用备用设备。第 4级是第 9 级的同义词。Dr. Warning 提供了以下文档: 

垂直双极公司间模型 

VBIC 模型是对标准 Gummel-Poon (SGP)模型的扩展，其重点是当今现代半导体技术中的集成双极晶体管。利用 Kull 和

Nagel 改进的准饱和模型，也可以模拟开关晶体管的特殊输出特性。这是一个广泛使用的替代 SGP 模式的硅，SiGe 和 III-V 

HBT 设备。 
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VBIC 的能力与标准的 Gummel-Poon 模型相比 

o 集成衬底晶体管，用于集成工艺中的寄生器件 

o弱雪崩和基发射体击穿模型 

o改进了早期效果建模 

o Ic 和 Ib 的物理分离 

o改进的损耗电容模型 

o改进的温度模拟 

模型结构 

 

VBIC 参数 

由于 VBIC 模型是以 SGP 模型为基础的，所以可以从 SGP 参数入手，进行一些变换。以下参数来自 VBIC 1.2 版本，该版本是

LTSpice 在 4 端版本中实现的，没有多余的相位网络和自热效应。要从 SGP 切换到 VBIC，您应该将额外的参数级别设置为

9。 
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Name Description Unit Default 

Tnom Parameter measurement temperature °C 27. 

Rcx Extrinsic collector resistance Ω 0.1 

Rci Intrinsic collector resistance Ω 0.1 

Vo Epi drift saturation voltage V Infin. 

gamm Epi doping parameter   0.0 

hrcf High current RC factor   Infin. 

Rbx Extrinsic base resistance Ω 0.1 

Rbi Intrinsic base resistance Ω 0.1 

Re Intrinsic emitter resistance Ω 0.1 

Rs Intrinsic substrate resistance Ω 0.1 

Rbp Parasitic base resistance Ω 0.1 

Is Transport saturation current A 1e-16 

nf Forward emission coefficient   1. 

nr Reverse emission coefficient   1. 

Fc Fwd bias depletion capacitance limit   0.9 

Cbeo Extrinsic B-E overlap capacitance F 0.0 

Cje Zero bias B-E depletion capacitance F 0.0 

pe B-E built in potential V 0.75 

me B-E junction grading coefficient   0.33 

Aje B-E capacitance smoothing factor   -0.5 

Cbco Extrinsic B-C overlap capacitance F 0. 

Cjc Zero bias B-C depletion capacitance F 0. 

Qco Epi charge parameter C 0. 

Cjep B-C extrinsic zero bias capacitance F 0. 

pc B-C built in potential V 0.75 

mc B-C junction grading coefficient   0.33 

Ajc B-C capacitance smoothing factor   -0.5 

Cjcp Zero bias S-C capacitance F 0. 

ps S-C junction built in potential V 0.75 
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ms S-C junction grading coefficient   0.33 

Ajs S-C capacitance smoothing factor   -0.5 

Ibei Ideal B-E saturation current A 1e-18 

wbe Portion of IBEI from Vbei 1-WBE from Vbex   1. 

nei Ideal B-E emission coefficient   1. 

Iben Non-ideal B-E saturation current A 0. 

nen Non-ideal B-E emission coefficient   2. 

ibci Ideal B-C saturation current A 1e-16 

Nci Ideal B-C emission coefficient   1. 

ibcn Non-ideal B-C saturation current A 0. 

ncn Non-ideal B-C emission coefficient   1. 

avc1 B-C weak avalanche parameter 1 1/V 0. 

avc2 B-C weak avalanche parameter 2 1/V 0. 

isp Parasitic transport saturation current A 0. 

wsp Portion of ICCP   1. 

nfp Parasitic fwd emission coefficient   1. 

Ibeip Ideal parasitic B-E saturation current A 0. 

ibenp Non-ideal parasitic B-E saturation current A 0. 

ibcip Ideal parasitic B-C saturation current A 0. 

ncip Ideal parasitic B-C emission coefficient   1. 

Ibcnp Non-ideal parasitic B-C saturation current A 0. 

ncnp Non-ideal parasitic B-C emission 

coefficient 

  2. 

Vef Forward Early voltage   Infin. 

Ver Reverse Early voltage   Infin. 

Ikf Forward knee current A Infin. 

ikr Reverse knee current A Infin. 

Ikp Parasitic knee current A Infin. 

tf Ideal forward transit time s 0.  

Qtf Variation of TF with base-width modulation   0. 
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Xtf Coefficient for bias dependence of TF   0. 

Vtf Voltage giving VBC dependence of TF V Infin. 

Itf High current dependence of TF A Infin. 

tr Ideal reverse transit time sec 0. 

Td Forward excess-phase delay time Sec 0. 

kfn B-E Flicker Noise Coefficient   0. 

afn B-E Flicker Noise Exponent   1. 

bfn B-E Flicker Noise 1/f dependence   1.0 

Xre Temperature exponent of RE   0. 

Xrbi Temperature exponent of RBI   0. 

Xrci Temperature exponent of RCI   0. 

Xrs Temperature exponent of RS   0. 

Xvo Temperature exponent of VO   0. 

Ea Activation energy for IS V 1.12 

Eaie Activation energy for IBEI V 1.12 

Eaic Activation energy for IBCI/IBEIP V 1.12 

Eais Activation energy for IBCIP V 1.12 

Eane Activation energy for IBEN V 1.12 

Eanc Activation energy for IBCN/IBENP V 1.12 

Eans Activation energy for IBCNP V 1.12 

Xis Temperature exponent of IS   3. 

Xii Temperature exponent of 

IBEI,IBCI,IBEIP,IBCIP 

  3. 

Xin Temperature exponent of 

IBEN,IBCN,IBENP,IBCNP 

  3. 

Tnf Temperature exponent of NF   0. 

Tavc Temperature exponent of AVC2   0. 

rth Thermal resistance K/W 0. 

Cth Thermal capacitance Ws/K 0. 

Vrt Punch-through voltage of internal B-C 

junction 

V 0. 
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Art Smoothing parameter for reach-through   0.1 

Ccso Fixed C-S capacitance F 0. 

qbm Select SGP qb formulation   0. 

nkf High current beta rolloff   0.5 

Xikf Temperature exponent of IKF   0. 

Xrcx Temperature exponent of RCX   0. 

Xrbx Temperature exponent of RBX   0. 

Xrbp Temperature exponent of RBP   0. 

Isrr Separate IS for fwd and rev   1. 

Xisr Temperature exponent of ISR   0. 

dear Delta activation energy for ISRR   0. 

Eap Excitation energy for ISP   1.12 

Vbbe B-E breakdown voltage V 0. 

nbbe B-E breakdown emission coefficient   1. 

Ibbe B-E breakdown current   1e-06 

Tvbbe1 Linear temperature coefficient of VBBE   0. 

Tvbbe2 Quadratic temperature coefficient of VBBE   0. 

Tnbbe Temperature coefficient of NBBE   0. 

ebbe exp(-VBBE/(NBBE*Vtv))   0. 

dtemp Local Temperature difference ° 0. 

Vers Revision Version   1.2 

Vref Reference Version   0. 

引用: 

陈国强，“双极晶体管之设计与应用”，国立台湾科技大学资讯工程学研究所硕士论文，民国 94 年 

McAndrew 等。李永明，“双极公司间模型之研究”，国立台湾科技大学电子工程研究所硕士论文，民国 94年 12 月 

《VBIC 模型定义》，第 1.2 版，第 18 页。1999 年 9月。 
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5.4.16 R.电阻 

符号名称:RES, RES2 

Syntax: Rxxx n1 n2 <value> [tc=tc1, tc2, ...] [temp=<value>] 

该电阻在节点 n1和 n2 之间提供简单的线性电阻。可以用参数 tc 为每个电阻实例定义温度依赖性。阻力 R，将会是 

R = R0 * (1. + dt * tc1 + dt**2 * tc2 + dt**3 * tc3 + ...) 

其中 R0 是标称温度下的电阻，dt是电阻的温度和标称温度之间的差。 
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5.4.17 S. 电压控制开关 

Symbol Names: SW 

Syntax: Sxxx n1 n2 nc+ nc- <model> [on,off] 

Example: 

S1 out 0 in 0 MySwitch 

.model MySwitch SW(Ron=.1 Roff=1Meg Vt=0 Vh=-.5 Lser=10n Vser=.6) 

节点 nc+和节点 nc-之间的电压控制节点 n1和 n2 之间的开关阻抗。需要一个模型卡来定义交换机的行为。\示例\教育

\Vswitch。asc 以查看直接放置在示意图上作为 SPICE 指令的模型卡示例。 

电压控制开关模型的参数 

Name Description Units Default 

Vt  Threshold voltage  V  0.0  

Vh  Hysteresis voltage V  0.0  

Ron  On resistance  Ω 1.0  

Roff  Off resistance  Ω 1/Gmin 

Lser  Series inductance  H  0.0  

Vser  Series voltage  V  0.0  

Ilimit Current limit  A  Infin. 

根据滞后电压 Vh的值，开关有三种不同的电压控制模式。如果 Vh 为零，开关总是完全打开或关闭，这取决于输入电压是否

高于阈值。如果 Vh 为正，则开关显示滞后现象，就好像它是由在 Vt - Vh 和 Vt + Vh 有跳闸点的施密特触发器控制的。注

意，Vh 是跳闸点之间电压的一半，这与普通实验室命名法不同。如果 Vh为负，开关将在开关阻抗之间平稳过渡。过渡发生

在 Vt - Vh 和 Vt + Vh 的控制电压之间。平滑过渡遵循一个适合开关传导对数的低阶多项式。 

还有一个 2级电压控制开关，它是 1 级开关的高级版本，具有负滞后。2级开关从来没有完全打开或关闭。传导作为控制电

压 Vc 的函数是 

g(Vc) = exp(A * atan((Vc - Vt)/abs(Vh)) + B) 

这里： 

A = log(Roff / Ron) /  

B = log(1 / (Roff * Ron)) / 2 

此外，2 级开关到电流极限的过渡是渐进的，而不是突然的。在固定的控制电压下，I-V 曲线由方程给出 

I(V) = Ilimit * tanh(g(Vc) * V) 
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其中 Ilimit 为 2级开关的默认值为 10 安培。 

2 级开关通过指定“单向”标志或使用参数 Vser 指定电压降，支持只在一个方向上进行操作的选项。通过将参数指定为非

零，可以将正向传导和反向开路之间的过渡指定为平滑过渡。 
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5.4.18 T.无损传输线 

Symbol Name: TLINE 

Syntax: Txxx L+ L- R+ R- Zo=<value> Td=<value> 

L+和 L-是一个端口上的节点。R+和 R-是另一个端口的节点。Zo是特征阻抗。直线的长度由传输延迟 Td 给出。 

该元素只模拟一种传播模式。如果这四个节点在实际电路中都是不同的，那么可能会激发两种模式。为了模拟这种情况，需

要两个传输联机元素。参见示意图文件。\示例\教育\传输在线逆变器。看一个例子来模拟一个长度的同轴电缆的两种模

式。 
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5.4.19 U.统一的 RC-line 

Symbol Names: URC 

Syntax: Uxxx N1 N2 Ncom <model> L=<len> [N=<lumps>] 

N1 和 N2 是 RC 线连接的两个元素节点，而 Ncom 是连接电容的节点。MNAME 是模型名，LEN 是 RC 线的长度，单位是米。如果

指定了集总，则为在 RC 线建模中使用的集总段数。如果没有指定块，将猜测要使用的块的适当数量。 

URC 模型来源于 L. Gertzberrg 在 1974 年提出的模型。该模型是通过将 URC 线路的短路类型扩展到具有内部生成节点的集

总 RC 段网络来实现的。RC 段呈几何级数，向 URC 线的中部递增，K 为比例常数。 

URC 线是由严格的电阻器和电容器部分除非 ISPERL 参数给出一个非零值,在这种情况下,电容器是替换为反向偏压与零偏压

二极管结电容相当于电容更换,和饱和电流 ISPERL 安培每米的输电线路和一个可选的串联电阻相当于每米 RSPERL 欧姆。 

Name Description Units Default 

K  Propagation Constant  -  2.0  

Fmax  Maximum Frequency of interest  Hz  1G  

Rperl  Resistance per unit length  Ω 1K  

Cperl  Capacitance per unit length  F  1e-15 

Isperl Saturation Current per unit length A  0.0  

Rsperl Diode Resistance per unit length  Ω 0.0  
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5.4.20 V.电压源 

Symbol Names: VOLTAGE, BATTERY 

Syntax: Vxxx n+ n- <voltage> [AC=<amplitude>] [Rser=<value>] [Cpar=<value>] 

这个元件在节点 n+和节点 n-之间产生一个恒定的电压。在交流分析中，交流值作为源在分析频率处的幅值。可以定义串联

电阻和并联电容。等效电路为: 

 

电压源历来被用作 SPICE 中的电流表，并被用作电流控制元件的电流传感器。如果指定了 Rser，则电压源不能用作 F、H 或

W元件的感测元件。然而，任何电路元件的电流，包括电压源，都可以绘制出来。 

Syntax: Vxxx n+ n- PULSE(V1 V2 Tdelay Trise Tfall Ton Tperiod Ncycles 

时变脉冲电压源 

Name Description Units 

Voff  Initial value  V  

Von  Pulsed value  V  

Tdelay  Delay  sec  

Tr  Rise time  sec  

Tf  Fall time  sec  

Ton  On time  sec  

Tperiod Period  sec  

Ncycles Number of cycles(Omit for free-running 

pulse function) 

cycles 

Syntax: Vxxx n+ n- SINE(Voffset Vamp Freq Td Theta Phi Ncycles) 
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时变正弦波电压源 

Name Description Units 

Voffset DC offset V 

Vamp  Amplitude V 

Freq  Frequency Hz 

Td  Delay  sec 

Theta  Damping factor 1/sec 

Phi  Phase of sine wave degrees 

Ncycles Number of cycles(Omit for free-

running sine function) 

cycles 

对于小于 Td 或完成 ncycle 后的运行次数，输出电压为 

Voffset +鞋面* sin(*φ/ 180 页) 

否则电压由 

(Voffset +鞋面* exp()- time-Td *θ)*罪(2 * p *频率*(time-Td)+ p *φ/ 180) 

阻尼因子，是衰减时间常数的倒数。 

语法:Vxxx n+ n- EXP(V1 V2 Td1 Tau1 Td2 Tau2) 

时变指数电压源 

Name Description Units 

V1 Initial value V 

V2 Pulsed value V 

Td1 Rise delay time sec 

Tau1 Rise-time constant sec 

Td2 Fall delay time sec 

Tau2 Fall-time constant sec 

于小于 Td1 的时间，输出电压为 V1。对于 Td1 和 Td2 之间的时间，电压由 

V1 + (V2-V1) * (1-exp (- (time-Td1) / Tau1)) 

对于 Td2 之后的时间电压由 



LTspice XVII help 中文翻译版 

 

 

本文由微信公众号 电子帮 翻译而成，仅用于学习交流，不可用于一切商业目的活动！ 

V1 + (V2-V1) * (1-exp (- (time-Td1) / Tau1))——(V2-V1) * (1-exp (- (time-Td2) / Tau2)) 

语法:Vxxx n+ n- SFFM(Voff Vamp Fcar MDI Fsig) 

时变单频调频电压源 

Name Description Units 

Voff DC offset V 

Vamp Amplitude V 

Fcar Carrier frequency Hz 

MDI Modulation index - 

Fsig Signal frequency Hz 

电压由。给出 

Voff +鞋面* sin((2。* p * Fcar *时间)+ MDI *罪(2。* p * Fsig *时间)) 

语法:Vxxx n+ n- PWL(t1 v1 t2 v2 t3 v3…) 

任意分段线性电压源。 

对于 t1 之前的时间，电压是 v1。对于 t1 和 t2 之间的时间，电压在 v1 和 v2 之间线性变化。可以有任意数量的时间，电压

点。对于最后一次之后的时间，电压就是最后一次电压。 

语法:Vxxx n+ n- wavefile=<filename> [chan=<nnn>] 

这允许将.wav 文件用作 LTspice 的输入。<filename>是.wav 文件的完整绝对路径，或者是从包含模拟示意图或 netlist 的

目录计算的相对路径。双引号可用于指定包含空格的路径。wav 文件可能包含最多 65536 个通道，编号为 0到 65535。可以

将 Chan 设置为指定使用哪个通道。默认情况下，使用第一个通道 number 0。wav 文件被解释为具有从-1V 到 1V 的完整范

围。 

这个源只在.tran 分析中有意义。 
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5.4.21 W.电流控制开关 

Symbol Names: CSW 

Syntax: Wxxx n1 n2 Vnam <model> [on,off] 

Example: 

W1 out 0 Vsense MySwitch 

Vsense a b 0. 

.model MySwitch CSW(Ron=.1 Roff=1Meg It=0 Ih=-.5) 

通过指定电压源的电流控制开关的阻抗。需要一个模型卡来定义当前控制开关的行为。 

电流控制开关模型参数 

Name Description Units Default 

It  Threshold current  A  0.0  

Ih  Hysteresis current A  0.0  

Ron  On resistance  Ω 1.0  

Roff Off resistance  Ω 1/Gmin 

根据滞后电流 Ih的值，开关有三种不同的电流控制模式。如果 Ih 为零，则开关总是根据控制电流是否高于阈值而完全打开

或关闭。如果 Ih为正，则开关在其- Ih 和 It + Ih 处存在跳闸点电流的滞后现象。如果 Ih 为负，开关将在开关阻抗之间

平稳过渡。过渡发生在 It - Ih 和 It + Ih 的控制电流之间。平滑过渡遵循一个适合开关传导对数的低阶多项式。 
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5.4.22 X.子电路 

Syntax: Xxxx n1 n2 n3... <subckt name> [<parameter>=<expression>] 

子电路允许定义电路并将其存储在库中，以便以后按名称检索。下面是一个定义和调用分压器并在电路中调用它的示例。 

* 

* This calls the circuit 

X1 in out 0 divider top=9K bot=1K 

V1 in 0 pulse(0 1 0 .5m .5m 0 1m) 

* 

* This is the subcircuit definition 

.subckt divider A B C 

R1 A B {top} 

R2 B C {bot} 

.ends divider 

* 

.tran 3m 

.end 
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5.4.23 Z. MESFET 和 IGBT 晶体管 

Symbol Names: MESFET, NIGBT, PIGBT 

Syntax: Zxxx D G S model [area] [m=<value>] [off] [IC=<Vds, Vgs>] [temp=<value>] 

MESFET 晶体管需要模型卡来指定其特性。模型卡关键字 NMF 和 PMF 指定晶体管的极性。MESFET 模型来源于 H. Statz 等人的

GaAs FET 模型，SPICE 中的 GaAs FET 器件与电路仿真，电子器件学报，V34, 2, 1987 年 2 月，第 160-169 页。 

包括两个欧姆电阻，Rd和 Rs。电荷存储采用总栅电荷作为栅极漏极电压和栅极源电压的函数来建模，由参数 Cgs、Cgd 和

Pb 来定义。 

Name Description Units Default 

Vto  Pinch-off voltage  V  -2.0  

Beta  Transconductance parameter  A/V2 1e-4  

B  Doping tail extending parameter  1/V  0.3  

Alpha  Saturation voltage parameter  1/V  2.0  

Lambda Channel-length modulation  1/V  0.0  

Rd  Drain ohmic resistance  Ω  0.0  

Rs  Source ohmic resistance  Ω  0.0  

Cgs  Zero-bias G-S junction capacitance F  0.0  

Cgd  Zero-bias G-D junction capacitance F  0.0  

Pb  Gate junction potential  V  1.0  

Kf  Flicker noise coefficient  -  0.0  

Af  Flicker noise exponent  -  1.0  

Fc  Forward-bias depletion coefficient -  0.5  

Is  Junction saturation current  A  1e-14 

前缀为 Z 的器件也可以表示 IGBT 晶体管。MESFET 和 IGBT 之间的歧义消除是通过模型语句实现的。 

Syntax: Zxxx C G E MNAME [area] [m=<value>] [off] [temp=<value>] 

        .model MNAME NIGBT 

LTspice IGBT 的实现是基于线性技术公司的 Robert Ritchie 的原创工作。它使用了 NIST 的 Allen Hefner 等人的一系列论

文中的设备方程。除了一些例外，LTspice 的实现包括阈下传导和随机噪声机制。 

Name Description Units Default 

Agd  Gate-Drain overlap area  A/V2  5e-6  
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area  Active area  m2  1e-5  

BVF  Avalanche uniformity factor  -  1.0  

BVN  Avalanche multiplication exponent  -  4.0  

Cgs  Gate-Source capacitance per unit area  F/cm2  1.24e-8 

Coxd  Gate-Drain oxide capacitance per unit area F/cm2  3.5e-8  

Jsne  Emitter saturation current density  A/cm2  6.5e-13 

KF  Triode region factor  -  1.0  

KP  MOSFET transconductance  A/V2  0.38  

MUN  Electron mobility  cm2/(V 穝) 1500  

MUP  Hole mobility  cm2/(V 穝) 450  

NB  Base doping  1/cm3  2e14  

Tau  Ambipolar recombination lifetime  sec  7.1e-6 

Theta  Transverse field factor  1/V  0.02  

Vt  Threshold voltage  V  4.7  

Vtd  Gate-Drain overlap depletion threshold  V  1e-3  

WB  Metallurgical base width  m  9e-5  

subthres Subthreshold current parameter  -  0.02  

Kfn  Flicker noise coefficient  -  0.0  

Afn  Flicker noise exponent  -  1.0  

tnom  Parameter measurement temperature  °C  27  
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6 控制面板 

要进入控制面板，使用菜单命令 Tools=>控制面板。在这里，您可以配置 LTspice XVII 的许多方面。 
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6.1 压缩 

 

LTspice 在生成原始数据文件时压缩它们。压缩文件可以比未压缩文件小 50倍。这是有损压缩。控制面板的此窗格允许您

控制压缩如何有损地运行。 

Window Size(No. of Points):可压缩成两个端点的最大点数。设置为 0关闭波形压缩。 

Relative Tolerance:压缩数据与未压缩数据之间允许的相对误差。 

Absolute Voltage tolerance[V]:压缩算法允许的电压误差。 
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Absolute Current tolerance[A]:允许的电流误差为压缩算法。 

在程序调用之间不记得这些压缩设置，以鼓励使用默认值。它们可用于控制面板上的诊断目的。可以使用.option 语句中的

选项参数 plotreltol、plotvntol、plotabstol 和 plotwinsize 指定公差和窗口大小，这些参数作为 SPICE 指令放在示意图

上。 

在使用.four 语句或在使用 SPICE 指令对数据进行后期分析时使用 FFT 时，您可能希望转换压缩: 

.options plotwinsize = 0 
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6.2 默认保存 

当您没有显式地声明应该在模拟中保存哪些节点时，将使用这些设置。有用的设置有“保存设备电流”、“保存子电路节点

电压”和“保存子电路设备电流”。设备电压和内部设备电压仅供内部程序开发使用。 

 

Save Device Currents::检查此选项，以便绘制设备和终端电流。你还需要它能够绘制耗散图。 

Save Subcircuit Node Voltages:您将需要检查这个来绘制分层设计中的电压图。 
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Save Subcircuit Device Currents:您将需要检查这一点，以绘制分层设计中的电流。 

Don't save Ib(), Ie(), Is(), Ig():这只保存晶体管的集电极(漏)电流，以减少输出。data 文件的大小。这对集成电路

设计很有用，但它的使用意味着没有足够的数据来计算晶体管的损耗。 

Save Device Currents:检查此选项，以便绘制设备和终端电流。你还需要它能够绘制耗散图。 
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6.3 SPICE 

此窗格允许您为 LTspice 定义各种默认值。通过在任何模拟中指定.option 语句中的选项，可以在任何模拟中覆盖这些默认

值。通常您可以让这些选项保持原样。

 

你可能想要改变的一个默认值是 Trtol。大多数 SPICE 程序默认为 7。在 LTspice 中，默认值为 1，因此模拟极不可能在波

形中显示任何模拟工件。Trtol 对时间步长策略的影响大于直接影响仿真的准确性。对于晶体管级模拟，大于 1 的值通常是

更好的总体解决方案。你可能会发现如果你在不影响模拟精度的情况下增加 trtol，你会得到 2x的速度。你的 trtol 设置

是记住之间的程序调用。然而，大多数传统的香料耐受参数，gmin, abstol, reltol, chgtol, vntol 不记得之间的程序调
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用，以鼓励使用默认值。如果您想使用除默认值之外的其他值，则必须编写.option 语句来指定您想使用的值，并将其放置

在示意图中，或者将设置保存在一个文件和.inc 文件中。 

同样有趣的是使用了哪个求解器。LTspice 包含 SPICE 的两个完整实现。一个称为常规解算器，另一个称为备用解算器。备

用求解器使用不同的稀疏矩阵包，减少了舍入误差。通常，备用求解器的模拟速度只有普通求解器的一半，但内部精度要高

出 1000 倍。这可能是一个有用的诊断。没有.选项指定使用哪个解析器，必须在解析 netlist 之前进行选择，因为这两个解

析器使用不同的解析器。 

最大线程数设置为您的操作系统和 CPU 硬件支持的并发执行线程的最大数量。在任何给定的模拟中使用的实际数字取决于电

路的性质。虽然 LTspice 引入了随机冷却的线程 s1来定义多线程 SPICE 模拟的艺术状态，但是有些电路不能从多线程中获

益。LTspice 不会占用最终不会使模拟运行更快的其他线程。 

矩阵编译器默认为目标代码。这意味着，当 LTspice 解决您的电路时，它将动态地为您的电路编写优化的汇编语言清单。然

后，它将组装、链接并执行这段代码，而不是用 c++和手工编码的程序集混合编写的常规 LU 分解代码。 

选中“接受 3K4 为 3.4K”旁边的复选框，强制 LTspice 理解一个写为 4K99 的数字等于 4.99K。常规的 SPICE 实践不允许这

样做，但是在 LTspice 中可以根据流行的要求使用它。 

1]多线程求解器受到线程间通信定时的阻碍。LTspice 通过动态调整每个线程可用的缓存以使它们以相同的实时速度运行，

从而提高了线程执行的一致性。 
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6.4 绘图选项 

 

Allow direct component pin shorts:通常情况下，你可以通过元件直接拉出一根电线，线段短路引脚就会被删除。如果你

检查它，短路电线不会自动删除。 

Automatically scroll the view:选中此框后，在编辑示意图时，当您移动鼠标并关闭边缘时，示意图的视图将显示在您的

视图中。 

Mark text Justification anchor points:画一个小圆表示文本块的参考点。 
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Mark unconnected pins:在每个未连接的引脚处画一个小正方形，将其标记为未连接。 

Show schematic grid points:从启用可见网格开始。 

Orthogonal snap wires:拉线时，强迫拉线在垂直和水平段拉制。如果不勾选，导线可以以任何角度绘制，并且可以吸附在

任何网格上。在拉丝时，按住控制键可瞬间切换当前设置。 

Ortho drag mode:拖动时，强制将导线按垂直段和水平段拉出。如果不勾选，导线可以以任何角度拖动。按住控制键将在拖

动导线时瞬间切换当前设置。 

Cut angled wires during drags:在拖动命令中，如果单击导线的中间，非正交的导线将被分成两根连接的导线 

Undo history size:设置撤销/重做缓冲区的大小。 

Pen thickness:笔宽，以像素为单位。 

Draft with thick lines:增加所有线条的宽度。用于生成用于发布的图像。 

Show Title Block:供内部使用。 

Reverse Mouse Wheel Scroll:正常情况下，将鼠标滚轮拉向自己可以使纸张靠近。如果选中此选项，相同的鼠标语法将使

您的头向后拉得更远。 
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6.5 网表选项 

 

Convert 'μ' to 'u': “μ”转换为“u”:替换所有的实例“μ”“u”。有用香料模拟器生成网表,不懂'μ'字符的度量

乘数 1 e-6。 

Reverse comp. order:反向组合顺序:电路元件通常按它们被添加到示意图中的顺序排列。勾选此框将导致此顺序颠倒。 

Default Devices:默认设备:每当在 LTspice 示意图中使用二极管时，默认模型语句”。模型 D"被添加到 netlist 中以禁止

使用默认模型的消息。取消此选项将抑制包含此线路以及类似的双极、MOSFET 和 JFET 晶体管的模型语句。 
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Default Libraries:默认库:每当在 LTspice 示意图中使用二极管时，默认库即标准。.lib 语句在模拟中包含 dio。取消此

选项将抑制此库以及类似的双极、MOSFET 和 JFET 晶体管库语句的包含。 
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6.6 符号和库搜索路径 

 

此面板允许您输入比默认路径更多的路径来查找符号和库。在它自己的行上列出每个目录。 
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6.7 波形 

此窗格允许您配置波形查看器的某些方面。 
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6.8 操作 

 

在程序调用之间记住带有星号[*]的设置。 

Default Window Tile Pattern:默认窗口平铺模式:允许您为并排平铺的窗口设置首选项，而不是将一个窗口平铺在另一个

之上。 

Marching Waveforms:行进波形:检查仿真结果是否能在仿真过程中递增绘制。 

Generate Expanded Listing:生成展开列表:在将子电路展开到 SPICE 错误日志文件之后，转储平面网络列表。 
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Save all open files on start of simulation:在模拟开始时保存所有打开的文件:LTspice 在内存中模拟示意图，而不是

磁盘上的示意图。这个选项强制两者在每次模拟开始时同步。 

Automatically delete .raw files:自动删除.raw 文件:这允许波形数据文件在关闭模拟后自动删除。这极大地减少了

LTspice 使用的磁盘空间，但是需要在重新打开模拟时重新运行模拟。 

Background image:背景图像:选择主应用程序窗口框架的背景。默认是点画模式，这样背景就不会与空白示意图混淆。其他

的选择还包括达芬奇的一组发明的草图，或者用户提供的需要存储在路径位置%USERPROFILE%\LTspiceXVII.jpg 文件 

RAM for Fast Access Conversion:用于快速访问转换的 RAM:这允许您在将波形数据转换为快速访问文件格式时调整内存使

用。 

Directory for Temporary Files:临时文件目录:同步发布期间下载的更新文件的临时存储目录。 
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6.9 Hacks 

 

此窗格用于内部程序开发，但目前几乎已过时。 
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6.10 互联网选项 

 

控制面板的此窗格用于从 web 获得的增量更新。LTspice 经常使用新的特性和模型进行更新。使用菜单命令 Tools=>Sync 

Release 更新到当前版本。如果您有几个月没有更新，LTspice 将开始询问您是否需要检查更新。LTspice 在没有获得您的

许可的情况下绝不会访问 web。LTspice 不包含任何间谍软件或传输任何类型的数据，同时获得它需要更新的文件。 

不要缓存文件:不要缓存或使用机器上缓存的文件进行更新。 
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7 常见问题 

7.1 SPICE 差异 

那么为什么 LTspice 比其他 SPICE 程序更好呢? 

经济学。如果我为 EDA 公司编写 SPICE 程序，可能会获得数百万美元的收入。但是如果我为一家 IC公司写同样的程序，它

被用来设计和销售 IC，那么同样的模拟器就是 15 亿美元的收入。 

当然，但是 LTspice 和其他香料在技术上有什么不同呢?难道所有的 SPICE 都是基于 Berkeley SPICE 和本质上相同的解决方

案吗? 

LTspice 是 SPICE 在任何其他可用的 SPICE 程序上的一个显著改进版本。虽然这些改进大部分是专有的，但这里有一篇文章

讨论了 LTspice 和其他 SPICE 程序之间的一些差异: 

SPICE Differentiation, LT Journal of analoveinnovation, 2015 

注意这篇文章使用屏幕转储的 PSpice 软件在旧版本的基础上更好的解算器 LTspice 相比,但网表是机器可读,你可以运行在

当前版本的商业模拟器,(i)解决的问题仍然存在,(2)香料发展停在香料软件公司。 

很好。我理解那篇文章。非常清晰，真的。但当一家精品香料公司来我办公室推销他们的 10万美元/座的香料时，他们用了

一大堆我不懂的数字方法术语。你有那样的东西吗? 

当然，LTspice 包含以下原始方法: 

进程线程的随机冷却:消除线程间通信死锁——这是灯泡和激光之间的区别。 

节点缩减:模拟运行得更快、更准确(比如 FFT 比根据定义计算 DFFT 更快、更准确，因为累积的舍入错误更少，因为要做的

浮点运算更少)。 

预测合并:分析行为表达式。缓存重复的内容。统计分析用于条件评价。结果是，运行时解析的行为表达式的计算速度接近

于使用本机 c 代码编写的 SPICE 设备的计算速度。全局优化器基于图论。 

自编写汇编语言:由于动态内存分配，内存访问很慢，因为在编写软件时，malloc()的返回结果直到运行时才知道。因此，

在已知返回的 malloc()地址之后，LTspice 为每个在运行时运行的模拟编写一个惟一的解决程序。速度是 3x。 

机会主义的 32 位寻址:64 位程序需要 64 位指针。对于从编译器生成同等质量的目标代码，程序的 32 位版本将比 64位版本

运行得更快。然而，由于 LTspice 在调用 malloc()之前不会编写解决程序，所以如果 malloc()返回一个足够接近程序计数

器的地址(它几乎总是这样)，那么它可以使用 32位寻址。更小的代码不仅执行得更快，而且更适合 CPU 缓存，因此在 64 位

程序中使用 32 位寻址是一个巨大的优势。 

例程被优化为完全在 CPU 缓存中执行:编写快速数值方法的严格指导重点是在 CPU 内核上使用 CPU 缓存。 
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你怎么可能知道一个例程是在片内 CPU 缓存中运行还是在 PCB 上的 RAM 中运行? 

以前，我会切开电脑电源线的外层绝缘层，这样我就可以把安培计夹在一根导线上，测量不同算法的电流图。这在当前的机

器上不是很有效——即使您增加计算机的 SMPS 输入滤波器电容(以减少功率因数校正，因此功率图的一个小变化会导致 RMS

电流和针偏转的夸张变化)——所以我只是概述了代码。 

好的，我明白了。但是那个 GUI 呢? 

LTspice 的 GUI 基于输入示意图所需的键盘输入和鼠标移动的统计分析。除了 LTspice 的 GUI 在经验上的巨大成功之外，它

实际上是用于 schematic entry 的最简单的 GUI。  
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7.2 安装的问题 

如何安装 LTspice XVII? 

访问 http://www.linear.com 并下载 LTspiceXVII 文件。exe 到您的 PC 上的临时目录中。 

执行 LTspiceXVII 文件。exe 安装。您将需要以管理员的身份运行它。 

下载文件 LTspiceXVII。exe 是线性技术公司的数字签名。 

我下载了 LTspice 安装程序，但它告诉我它与我正在运行的 Windows 版本不兼容。我能得到一份在 Windows 版本下运行的拷

贝吗? 

你需要使用 Windows 7、8 或 10。Windows XP1 不会运行 LTspice XVII。如果您使用的是 Windows 7、8或 10，并且收到了

关于安装文件 LTspiceXVII 的错误消息。exe，然后在下载过程中损坏。如果服务器上的文件被修改(由于 web 站点维护)，

而您正在以较慢的连接下载它，则可能发生这种情况。你得重新下载。Windows 7 x64 是目前最流行的 LTspice XVII 平

台。 

1] LTspice IV 对 Windows XP 用户仍然可用，但 LTspice IV 不再更新。 
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7.3 程序更新 

如何获得最新版本? 

安装后，有两种方法可以获得最新版本。如安装问题中所述，您总是可以重新安装该程序。安装程序可以选择性地进行更新

或完全安装，这样您就不会丢失首选项设置。在安装之前，您不必删除旧版本。获得最新版本的另一种可能性是使用 Sync 

release 特性。 

我如何知道添加了哪些新特性? 

将文件更新到最新版本后，文件更改日志。txt 根安装目录,通常在 C:\Program Files\LTC\ LTspiceXVII \更新日志。有

详细的程序修订列表。 

在执行同步释放命令后，我可以回到旧版本吗? 

不。所有符号、模型和程序都用当前版本更新。组件数据库，标准。*，将自动与新文件合并。如果您添加了新的电感或电

容，您的设备将被保留并与更新后的新设备合并。 
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7.4 仿真变压器 

如何模拟变压器? 

起草耦合电感作为独立电感，然后添加一个互感语句作为 SPICE 指令放在原理图上。有关互感的更多信息，请参阅互感一

节。参与互感的电感器将用一个相位点绘制。 

下面的例子演示了一个带有方波输入的 1:3 匝比(1 到 9 电感比)的变压器。将互连系数设为 1，模拟无漏感变压器。 

 

不，那太容易了。你没有更复杂的吗? 
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肯定的: 

i)用直流 LCR 表测量绕组 L。在模拟中直接使用这些值。 

ii)用欧姆表测量绕组 ESR。在仿真中使用这些值的两倍，因为频率上的电阻高于直流值。我对铁氧体和开关的经验是，它

通常是两个更高的因素。 

iii)除大部分电感绕组外，其余绕组均短路，用直流 LCR 电感仪测量泄漏电感。调整耦合系数，使之与此匹配，或针对两个

绕组的情况: 

K =√1-Lleak /√(L1 * L2)) 

Lleak = sqrt(L1 * L2)*(1 K * K) 

iv)找出变压器的谐振频率，Q.为感应线圈最多的绕组指定一个 Cpar 和 Rpar 来匹配该谐振。 

(五)享受。 

非线性变压器呢? 

请参见安装为%主页%\文档\LTspiceXVII\示例\教育\非线性转换\ asc 的示例 
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7.5 第三方模型 

第三方模式 

本节解释向 LTspice XVII 中添加第三方模型的基础知识。 

基本上有两种类型的第三方 SPICE 模型，一种是用. model 语句描述的，另一种是用. subckt 定义的。 

模型描述是为像二极管和晶体管这样的本征器件设计的。model 语句给出了特定组件的参数。SPICE 已经知道该设备的行

为，只需要给出参数就可以完成指定组件的电气特性。 

另一方面，. subckt 语句给出的模型通过一组内部 SPICE 设备的电路来定义所建模的组件。例如，将 opamp 的 SPICE 模型

作为子电路给出。 

如何在 LTspice 中包含模型取决于模型是作为. model 语句还是. subckt 给出的。 

用.MODEL 语句定义的 NPN 晶体管的例子: 

1. 在示意图中添加符号 NPN 的实例。 

2. 将值“NPN”编辑为“BC547C”，以与目标. model 语句中使用的名称一致。 

3.现在要么 

3a)添加.MODEL BC547C…语句作为 schematic 上的 SPICE 指令。 

或 

如果你有 bipol 文件。库包含你的。型号 BC547C…(其他模型可能也在这个文件中)，然后添加 SPICE 指令”。包括 bipol。

解放"在你的示意图上。请注意,“bipol。" lib"必须是任何文件扩展名的完整名称，Windows 资源管理器默认不显示文件

扩展名。如果你有一个叫 bipol。lib 的文件。，可以在记事本中编辑/查看，Windows 资源管理器显示文件退出为

“bipol”。包含这个文件的 SPICE 指令是。公司 bipol.lib。txt" If you used， "。公司 bipol。你将得到一个错误信

息，该文件找不到。 

或 

您也可以添加.MODEL BC547C…通常安装在%主页%\文档\LTspiceXVII\lib\cmp\standard.bjt 上的文件的语句。如果你这样

做，你会自动看到模型作为一个选择是编辑 NPN 晶体管。如果你编辑这个标准。在 LTspice 之外的 bjt 文件，您必须重新启

动 LTspice 才能注意到该文件已经更改。 

一个 5脚 opamp 的例子。这将用.SUBCKT 语句定义: 

1. 将符号 opamp2 的实例添加到示意图中。 

2. 将示意图上的值“opamp2”编辑为“TL072”，以与. subckt 的名称一致。 

3.要么 

3a)粘贴“”。SUBCKT TL072…. end "定义为您的示意图的多行 SPICE 指令。 
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或 

如果你有一个叫“TI”的文件。包含子电路 TL072 的定义(它看起来像一条起始为”的线。)添加 SPICE 指令。包括 TI。解

放“到示意图。 

可以创建一个新的符号，并对其进行编程，以便在示意图上使用时自动包含仿真所需的模型。参见帮助小节 Schematic 

Capture=>创建新符号。 

可以根据任意第三方模型创建一个自动生成的符号，并对其进行编程，使其在示意图上出现时包含仿真所需的模型。参见帮

助小节 Schematic Capture=>创建新符号。对于大多数用户来说，这是添加定义为子电路的新模型的唯一方法，因为所有的

细节都是为您处理的。 

一个 3针 NPN 晶体管的例子，但定义了一个。subckt 语句: 

1. 在示意图中添加符号 NPN 的实例。 

2. 将光标移到新放置的 NPN 符号实例的主体上。按< Ctrl > RightMouseButton。将出现一个对话框。将前缀:QN 更改为

前缀:x。这将导致此符号实例作为子电路而不是固有双极晶体管 netlist。 

3.将值“NPN”编辑为“BFG135”，使之与. subckt 行中给定的名称一致。 

4. 然后要么 

4a)将.SUBCKT BFG135 线添加到示意图中 

或 

菲尔，如果你有文件的话。库包含你的。subckt BFG135…(其他的可能也在这个文件中)那么您必须添加一个 SPICE 指令 

将. subckt 模型添加到 LTspice 的一个方面是，您需要使用用于调用子电路的符号，并且模型同意相同的 pin/port 

netlist 顺序。上面的例子假设您所添加的第三方模型遵循流行的 pin 订单约定。 

进一步的相关信息见帮助小节 Schematic Capture 和 LTspice。LTspice 的基本思想是示意图捕获程序生成模拟器读取的网

络列表。导入第三方模型的任何方面都可以通过了解 SPICE netlist 语法以及 schematic capture 程序如何生成该语法来解

决。在 http://groups.yahoo.com/group/LTspice 的独立用户组中也有关于这个主题的教程。 

  



LTspice XVII help 中文翻译版 

 

 

本文由微信公众号 电子帮 翻译而成，仅用于学习交流，不可用于一切商业目的活动！ 

7.6 电感模型 

如何设计耦合电感? 

首先(i)画至少两个电感，然后(ii)定义两个电感之间的 K系数。参见互感部分。 

如何控制电感寄生电阻? 

默认情况下，LTspice 将向电感提供损耗，以帮助 SMPS 瞬态分析。对于 smp，这些损失通常没有什么后果，但如果需要，可

以关闭。在“Tools=> Control Panel=>Hacks!”页面上，取消勾选“如果没有 Rpar，则提供最小电感阻尼”，该设置将在

程序调用之间被记住。对于互感声明中没有提到的电感器，还有一个默认的 1 毫欧姆串联电阻。该 Rser 允许 LTspice XVII

将电感集成为诺顿等效电路，而不是 Thevenin 等效电路，以减少电路线性化矩阵的大小。如果不希望 LTspice 引入最小电

阻，则必须显式地为该电感设置 Rser=0。这将要求 LTspice 在瞬态分析中使用更笨重的等效电感器 Thevenin。 

我可以添加/编辑我自己的电感模型吗? 

打开文件%HOMEPATH%\Documents\LTspiceXVII\lib\cmp\standard.ind。添加或编辑电感模型。 
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7.7 MOSFET 模型 

LTspice XVII MOSFET 与标准 SPICE MOSFET 模型有何不同? 

除了标准的 SPICE MOSFET 模型之外，LTspice XVII 还包括一个没有在其他 SPICE 程序中实现的专有 MOSFET 模型。它直接

封装了垂直双扩散 MOS 晶体管的电荷行为。这使得电源设备可以用一个固有的 VDMOS 设备 LTspice 来建模，而不是像 SPICE

程序中那样使用子电路。详情请参阅 MOSFET 部分。 

我可以添加我自己的 MOSFET 模型吗? 

是的，您可以在%主页%\文档\LTspiceXVII\lib\cmp\standard.mos 文件中添加您自己的模型。此文件仅用于使用.model 语

句定义的设备，而不是子电路。如果你想使用子电路，请遵循以下步骤: 

将符号的组件实例的“Prefix”属性更改为“X”。不要更改符号，只要将符号的实例作为示意图上的组件即可。您可以通

过按住 control 键并右键单击组件的主体来访问该属性。 

编辑组件的“Value”属性，使其与您希望使用的子电路的名称一致。 

在示意图上添加 SPICE 指令，如“”。其中文件名是包含子电路定义的文件的名称。注意，这必须是任何文件扩展名的完整

名称，Windows Explorer 默认不显示文件扩展名。如果你有一个叫 mylib。sub 的文件。，可以在记事本中编辑/查看，

Windows 资源管理器显示文件存在为“mylib”。子“SPICE 指令包含这个文件是”。公司 mylib.sub。txt" If you used， 

"。公司 mylib。你会得到一个错误信息，那个文件找不到。 
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7.8 许可和发布 

我可以重新发布软件吗? 

是的，无论您是否是线性技术的客户，您都可以免费分发软件。有关更多细节，请参见许可部分。 

它是共享软件、免费软件还是演示软件? 

这个程序不是一个共享软件或演示。它是功能齐全的免费软件。这个软件的目的是帮助我们的客户使用我们的产品。它也可

以作为一个通用电路设计包与原理图捕获和 SPICE 仿真。我们鼓励使用该程序的学生熟悉模拟设计过程。我们不能保证支持

非线性技术相关的程序使用，但我们将修复所有的一般程序错误，并欣赏这样的报告。我们做了大量的内部测试，相信该程

序具有优越的收敛能力。没有已知的突出 bug。 

我可以联系谁在线性技术的帮助? 

对于所有软件问题，请发送电子邮件 LTspice@linear.com。线性技术公司不为一般 LTspice 使用问题提供电话支持。 

对于所有硬件问题，如线性技术集成电路的额外应用信息，请在正常的美国太平洋业务时间致电(408)954-8400 联系线性技

术应用部门。 
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7.9 电路效率计算 

电路效率计算 

我怎样才能得到电路的效率报告? 

您需要将关键字“steady”添加到.tran 命令中，例如，“”。TRAN <时间>稳定”。程序将通过检查开关宏模型的内部状

态来检测稳态。当开关调节器部分不是电路的一部分时，它就不工作了，因为稳态检测是在模型中实现的——通常是通过寻

找从误差放大器流出的电流降为零，作为一个开关周期的积分。电路中必须只有一个电压源。这将被标识为输入。电路中必

须只有一个电流源，但是可以使用名为 Rload 的电阻。这将被标识为负载。模拟完成后，您可以在“视图”菜单下选择“效

率报告”，查看示意图上的报告。 
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7.10 自定义符号 

我能创造我自己的符号吗? 

是的，你可以创造自己的符号。 

我如何创造我自己的符号? 

从菜单命令 File=>New Symbol 开始。 

我可以创建我自己的开关调节器模型吗? 

不是很容易。与 LTspice XVII 一起发布的开关调节器模型使用了一种新的硬件描述语言和新的固有 SPICE 设备，这些设计

用来封装 LTC 的开关调节器产品的行为。即使您成功地使用标准 SPICE 原语创建了一个模型，模拟的运行速度也会慢上几个

数量级。请注意，有些人已经用标准 SPICE 设备制作了这样的开关调节器模型。LTspice 可以运行这些模型，并且通常比它

们所针对的模拟器性能更好。 
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7.11 内存问题 

我需要多少内存来运行这个程序? 

如果可以运行 Windows，就可以运行 LTspice XVII。我们已经花费了大量的精力来最小化这个程序的内存需求。没有内存泄

漏。但是波形数据需要内存，这就是人们遇到麻烦的地方。在这方面，x64 操作系统将是最好的选择。 

仿真过程中波形存储在哪里? 

所有的波形数据都存储在磁盘上。只有绘制的跟踪被加载到 RAM 中。关闭行进波形可以减少对内存的需求。注意，对于大多

数分析类型，没有特定的文件大小限制。您可以生成和查看 gb大小的.raw 文件。 

如果我没有足够的磁盘空间来进行长时间的模拟呢? 

波形数据已被压缩，但它仍然与运行时间和保存的跟踪数成正比。保存内存的最简单方法是在模拟开始之前只选择要存储的

跟踪。 

好的，我已经做了所有的事情，但是内存还是不够用。我能做什么? 

在瞬态分析期间，您可以通过按“0”键交互式地丢弃过去的波形。这将重新触发模拟时间 t=0 作为当前时间。 
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7.12 模型兼容性 

开关调节器模型是否与 PSpice 模型和其他模型兼容? 

LTspice SMPS 宏模型是在新的专有本机 LTspice 设备和/或专有硬件描述语言的组合中实现的。虽然理论上可以开发通用

SPICE 或 PSpice 大分子模型，但由此产生的模拟速度是不可持续的。然而，LTspice 可以运行 PSpice 半导体和行为模型，

并且通常是一个性能更高的模拟器，因此您可以将 PSpice 模拟迁移到 LTspice。大多数 SPICE 用户已经从 PSpice 升级到

LTspice。 
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7.13 SPICE 网表 

如何创建 SPICE 网络列表? 

可以使用任何能够生成 ASCII 文件的文本编辑器创建 netlist。您可以使用命令 view =>SPICE netlist 查看 LTspice XVII

中任何示意图的 SPICE 网络列表。在这个视图中，您可以通过选择所有文本并键入 Ctrl-C 将 netlist 复制到剪贴板，从而

将 netlist 带到另一个编辑器。 

如何运行网络列表? 

首先打开文本文件，然后运行它。如果文件扩展名为“.cir”，LTspice XVII 将把该文件识别为一个网络列表 
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7.14 输出/合并波形数据 

出口/合并波形数据 

我可以将波形数据导出到其他应用程序吗? 

您可以将图形复制为位图，方法是将波形窗口设置为活动窗口并输入 Ctrl-C。然后，在接受剪贴板上的位图粘贴(如 Word

或 Paint)的应用程序中，键入 Ctrl-V。注意，这也适用于示意图的位图。这些图像还可以导出为 Windows 元文件(菜单命令

工具=>写入.wmf 文件)，后者将图像作为矢量图形写入.wmf 文件，该文件可以在各种桌面发布工具中导入。导出波形数据元

文件时，首先打开 Tools=>Control Panel=> waveform =>Font 并选择 Arial。默认的 System 在 CRT 上非常清晰，但它是一

种固定字体，在元文件中不能正确伸缩。 

这对位图有用，但我能把数据本身放到 Excel 这样的应用程序中吗? 

有一个导出实用程序(波形菜单:File=> export)，允许将数据导出到 ASCII 文件。还有一个由 Helmut Sennewald 编写的第

三方免费工具。它可以从独立用户组 http://groups.yahoo.com/group/LTspice 获得。这个实用程序允许各种形式的数据操

作，包括合并来自不同模拟运行的波形的能力。 

谁是 Helmut Sennewald? 

右边的人: 

 

Helmut Sennewald 也是独立的 LTspice 用户组的版主。 

但是，是否有办法将波形数据导出到其他应用程序，而不求助于第三方软件呢? 

是的。将波形窗口设置为活动窗口，使用菜单命令 File=>导出。 

但我希望数据以等间隔的时间步长。有办法做到吗? 
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是的。执行所需数据的 FFT。在 FFT 之前，数据被插值到等间隔的时间步长。现在对 FFT'ed 数据进行 FFT。这将恢复等间隔

时间步长数据并导出它。 

但是如果我做两次 FFT，我不会失去准确性吗? 

不。LTspice 的 FFT 算法是位精确到双精度的。 

但如果我不希望数据被插值到数个 FFT 箱中它是 2 的幂呢? 

然后输入要使用的箱子的数量。LTspice 使用了一种专用的 FFT 算法，可用于任意数量的箱子。 

LTspice 的 FFT 是位精确到双倍精度的，并且适用于任意数量的箱子，这是怎么可能的呢? 

这是商业秘密。 
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7.15 互联网选项 

提取开关模式电源回路增益 

模拟和为什么你通常不需要 

除非你的目标是制造一个振荡器[1]，否则负反馈回路的增益需要在频率低于单位之前发生太多的相位差。该方法可用于开

关电源的稳定性分析。尽管 SMPS 本质上是一个非线性电路，没有小信号线性等效电路，但在滤波后的开关输出上通常有一

个模拟反馈回路。 

确定 SMPS 的环路增益涉及两个问题:(i)从闭环系统中获得开环增益;(ii)通过对一个开关周期平均和/或使用傅立叶分析忽

略开关频率分量来忽略开关波形。第一个问题是大多数反馈回路稳定性分析中常见的问题。稳定性分析是基于开环响应，但

如果你打破反馈回路直接测量开环响应，电路就不再工作了，这就是为什么一开始要使用反馈。第二个问题是，SMPS 本质

上是一个非线性电路，线性反馈理论基本上局限于一个开关周期内的平均假设波形。 

确定线性闭环系统的开环响应是米德尔布鲁克方法[2]很好地解决的一个问题。该方法利用注入闭环系统的测试信号独立求

解电压增益和电流增益。然后将这两个增益进行卷积以得到真正的循环增益。如果反馈回路中的一个点可以被识别为低阻抗

驱动高阻抗，那么电流增益为零，只测量电压增益并将其识别为回路增益就足够了。这样的一个点通常可以在 SMPS 中找

到，因为您有一个驱动错误放大器输入的电源输出。 

SMPS 环路增益的实验室测量是通过 Venable 公司首创的商业仪器实现自动化的，现在也可以从其他公司获得。利用注入测

试信号和傅里叶分析的技术称为频响分析(FRA)。虽然这种方法在实验室是常规的，但并不是每个人都知道如何使用它的模

拟。本文将解释如何在 LTspice XVII 中执行 FRA。该方法使用 Middlebrook 方法的电压增益部分、.measure 语句进行傅里

叶变换、step 语句进行扫频，以及 LTspice 中允许绘制.measure 语句结果的特性。在阅读下面的步骤时，您可能希望参考

工作中的 FRA 示例，它们是通常安装在 directory 中的通用 LTspice XVII 版本的一部分 

% HOMEPATH % \文档\ LTspiceXVII \ \教育\联邦铁路局\例子 

步骤 1:确定 SMPS 反馈回路中一个低阻抗源驱动高阻抗输入的点。有两个地方是有用的，要么与 SMPS 控制器的反馈引脚串

联，要么在输出到电阻分压器顶部的反馈引脚之间。 

步骤 2:在这里插入一个电压源。这将是一个干扰反馈回路的时域正弦波。给它赋值为“sin (0 10m {Freq})”振幅的选择

(这里是 10mV)将影响精度和信号对噪声的影响方法。振幅越小，信号的噪声越低。但是如果振幅太大，系统就不是线性运

行的，频率响应就变得不那么相关了，因为频率不再是独立的。 

步骤 3:标签节点两端的电压源“A”和“B”反馈的方向应该从节点到节点 B。例如,如果电压源连接直接反馈销,节点 B是反

馈销和节点的另一边是一个电压源。 

步骤 4:将下面的.measure 语句作为 SPICE 指令粘贴到示意图上: 

.meas Aavg avg V(a) 

.meas Bavg avg V(b) 

.meas 为 avg (V(a)-Aavg)*cos(360*time*Freq) 

.meas Aim avg -(V(a)- aavg)*sin(360*time*Freq) 

.meas Bre avg (V(b)-Bavg)*cos(360*time*Freq) 
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.meas Bim avg -(V(b)- bavg)*sin(360*time*Freq) 

.meas GainMag param 20*log10(hypot(Are,Aim)/hypot(Bre,Bim)) 

.meas GainPhi param mod(atan2(Aim,Are)-atan2(Bim,Bre)+180,360)-180 

这些。measure 语句执行节点 A和 B 的傅里叶变换，然后计算合成的复电压的比值。其结果是系统的复杂开环增益。幅值以

分贝表示，相位以度表示。 

步骤 5:将下面的命令粘贴到 schematic 上的 simulation 命令上，作为 SPICE 指令: 

.param t0 = .2m 

.tran 0 {t0+10/freq} {t0} 

参数 t0 是系统达到稳态所需的时间长度。您可能需要运行一些模拟来确定 t0 的适当值。它作为.tran 命令的第三个参数出

现，这意味着模拟器应该开始保存数据。这将防止步骤 4中的.meas 语句在分析中使用该数据。这样做的原因是，初始瞬态

条件可能无法在可视为小信号响应的规则的小扰动范围内运行。 

注意，t0 同时出现在.tran 命令的第 2和第 3 个参数中。第二个参数是停止时间。启动和停止时间的差值选择为 10/freq，

即，扰动周期的积分数。理想情况下，傅里叶分析的周期应该是一个扰动周期和开关周期的积分，但这并不总是可能的。由

于环路增益必须降至不到团结在频率切换频率的一小部分,总有比扰动周期和一个积分切换周期摄动的循环次数与希望的错

误使用非整体转换的循环次数将小因为许多转换周期。 

步骤 6:选择执行分析的频率或频率。要实现单一频率，只需添加 SPICE 指令: 

.param 频率= 15 k 

并运行模拟。meas 语句的输出位于错误日志中，您可以在使用菜单命令 view =>SPICE 错误日志运行模拟之后查看该日志。

您可以在多个频率下运行模拟，方法是在原理图上放置以下 SPICE 指令: 

.step oct 参数 freq 50K 100K 

该指令告诉 LTspice 使用每个八度五个点，以 50kHz 到 100kHz 的频率运行模拟。要将其绘制为 Bode 图，在模拟完成后，执

行菜单命令 View=>SPICE Error Log，然后右键单击菜单“plot .step'ed .meas data”，此时 Bode 图将不会绘制任何数

据。因此，再次右键单击并执行菜单命令“可见跟踪”，然后选择增益。 

有了上面的技术，您可能已经准备好使用反馈循环的 Bode 分析来征服 SMPS 设计。我理解这种诱惑。如果能够遍历反馈回

路，识别产生极点和零的组件，制定移动哪些零以消除哪些极点的策略，并为补偿网络组件合成组件值，以实现稳定的反馈

回路，那将是有益的。但这正是你不能用这种技术或其他频域技术做的。让我解释一下原因。 

让我们考虑一个典型的固定频率、峰值电流模式切换器，如 in 

% HOMEPATH % \文档\ LTspiceXVII \ \教育\联邦铁路局\ Eg3.asc 例子 

控制器使用触发器，触发器由时钟脉冲设置，并打开开关，使电感电流上升。一旦峰值开关电流与误差放大器输出的电压成

正比，触发器就会复位，开关关闭，控制器处于空闲状态，直到下一个时钟脉冲再次设置触发器。由于平均电流与峰值电流

成正比，直到几何因素，如果我们平均超过一个时钟周期，这个触发器控制开关的行为就像一个跨导。即通过开关的电流与

误差放大器输出端的电压成正比。如果继续沿着反馈路径，我们有电感器和开关电流串联。由于开关是电流源，电感器的串
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联阻抗即使是无功的，也不会引起相移。这实际上是电流模式控制的要点，以及你为什么要买那个控制器。继续沿着反馈路

径，我们现在看到的是 smp 的输出。输出滤波器电容器(C4)产生一极。然后将输出除以反馈电阻分压器，并与反馈管脚上的

参考电压进行比较。被分割的输出和参考电压之间的差是误差电压。该误差电压经误差放大器放大后，成为从误差放大器流

出的电流。但是，决定开关电流的是误差放大器输出端的电压，而不是输出端的电流。因此，要完成对反馈回路的遍历，我

们需要将电流转换成电压。我们可以用一个电阻来做，这是可行的，但是更好的办法是用一个电容(C1)因为它可以最大化开

环直流增益，使输出保持在一个固定的电压。那个电容器构成了第二极。 

现在,由于每个极可能导致一个极其接近 90°的相移和控制器必须导致一些额外的延迟,有人可能会认为一些电路设计是必

要的,以确保一个稳定的反馈循环。但实际情况并非如此，尤其是使用铝电解帽输出滤波器电容器时，因为它有 ESR，这会

使响应为零。同时，由于我们买了补偿帽 C1 串联电阻 R1，这也使另一个零在响应。此外，控制器的延迟只占开关频率的很

小一部分。在环路交叉频率及以下，延迟可以忽略不计。这意味着循环是稳定的，不可能合成组件值，因为循环对所有组件

值都是稳定的。这个论点基本上是指出，一旦由电流模式 SMPS 的反馈回路调节的信号被一个开关周期的平均电流很好地描

述，这个回路就是稳定的。 

如果输出的滤波帽不是铝电解液，而是陶瓷电容器，那么陶瓷电容器的 ESR 不够高，不足以实质性地影响 smp 的稳定性。因

此，根据前面的讨论，回路响应现在是两个极点和一个零，所以它仍然是稳定的，独立于输出滤波器帽或 RC 电路的特定分

量值附加到误差放大器输出。但是，讨论上述分析的适用范围是适当的。上述电流模式 SMPS 稳定性描述的准确性存在下降

的影响。平均电流与输出电压变化时的峰值电流不成比例，因为占空比随输出电压变化而变化，因此纹波电流也随之变化，

因此触发控制器触发器的峰值电流不会在输出电压变化时产生相同的平均电流。这意味着，从误差放大器输出的电压到流入

电感器的电流的传递函数并没有被完美地描述为跨导，而是用实际阻抗进行了分路的跨导。这个阻抗通常是几个欧姆，虽然

与 MOSFET 的 on 电阻相比非常大，但它小于无穷大。从稳定的角度来看，这是不可取的，因为电感不再从电流源馈电，它的

电抗可以引起一些相位差。边坡补偿使这种情况进一步恶化。斜坡补偿是固定频率电流模式控制器在高占空比工况下发生的

次谐波振荡的一种修正。该技术需要在测量的开关电流中加入一个欺骗电流，并使用该电流来重置控制器的触发器。使用电

流以外的量来复位触发器的影响降低了输入电感器的电流源的阻抗，因此电感器的电抗会引起更多的相移。 

总的来说，我发现很难使电流模式的 smp 不稳定。例如，如果你使用的电感值太高了一两个数量级，那么电感器纹波电流变

得非常小，斜坡补偿的欺骗电流控制触发器复位。这将减少开关电源的阻抗驱动这个电感到 MOSFET Rds(on)的阻抗，因此

电感器在回路中创建另一个极点，从而导致不稳定。但在这种情况下，即使你用的是电流模式控制器，电源实际上是在电压

模式下运行。电压模式电源的小信号线性分析是非常有用的，因为除非设计了反馈回路来抵消其中的一个极点，否则电源将

会振荡，并可能在第一次打开时就爆炸。电流模式电源则完全不同。虽然可以对电流模式切换器进行小信号线性分析，但由

于只要电源确实在电流模式下工作，反馈回路就会保持稳定，因此用这种方法完成的工程并不多。 

我可以提供的最后一个建议是如何确保 smp 在当前模式下稳定运行。答案是从数据表首页的示意图开始。关键信息有电感

值、输出滤波器电容值和外部补偿分量值。一些数据表给出了计算这些值的方程，但我只是从这些值开始，然后使用时域模

拟来调整以评估响应。毕竟，频域分析的重点是改善时域响应。在电流模式切换器中，通常直接跳到时域模拟来检查超调，

因为稳定性已经实现。 

讨论仅限于最小相位系统。 

2] R.大卫·米德尔布鲁克，“反馈系统环路增益的测量”，《国际电子学报》(第 38 卷，第 1 期)。4，第 485-512 页，

1975 年 4 月)。 
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7.16 在 Linux 下运行 

你有这个程序的 Linux 版本吗? 

不。但是有报道称，LTspice XVII 确实在 WINE 下的 Linux 上运行。 

好吧，我从来没用过酒，我怎么装这个? 

请与 http://www.winehq.com 联系，查找系统当前版本的 WINE。 

复制适当的.rpm 文件到您的机器上，并从 nautilus 打开它。 

获取 LTspiceXVII 文件。从 http://www.linear.com exe。在 xterm 中，执行“wine LTspiceXVII”。exe"安装 LTspice。 

现在在你的桌面上将会有一个线性的技术标志。双击它以启动或键入“wine LTspiceXVII”。exe"从一个 xterm 开始程序。 

示意图字体在 WINE 下的缩放效果不如 Windows 流畅。这是为什么呢? 

WINE 用它找到的字体做到了最好。如果您告诉它如何从 Windows 系统中查找字体文件，它会做得更好。 

PWL 附加点编辑器看起来不像在 WINE 下面? 

尝试从您的授权 Windows 系统中使用本机 Windows .dll。然后从 WINE 调用 LTspice 的命令行是 WINE -dll 

commctrl,comctl32=n XVIIx64.exe。 

在 Linux 下运行的性能与在 Windows 下运行的性能相比如何? 

您询问的每个 Linux 用户都会告诉您，LTspice 在 Linux 下比在 Windows 下运行得更好。 

哇,太酷了!真的吗? 

不。 
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7.17 纸质手册 

纸质手册怎么样? 

这些帮助页面是手册。它们的设置使您可以将它们打印成一个完整的集合，但是在打印之前请考虑一下环境。 

那书呢? 

在亚马逊上，我看到了 10 本标题中有 LTspice 的书: 

 

Michio Shibuya、Gilles Brocard 和 Mihail Pushkarev 的书(书的封面没有上面的插图)质量很高。这个帮助文档的标题页

上的图形是由 Michio Shibuya 提供的。 
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7.18 教程 

教程呢? 

我还以为你不会问呢!请访问我同事的网站 http://www.simonbramble.co.uk。该网站有许多关于 LTspice 以及更广泛的模

拟电路设计领域的教程。推荐。 

不，不，我想看电影。我在哪里可以买到 LTspice 的电影? 

还有许多视频以及 http://www.linear.com/solutions/LTspice 博客。 

那些 LTspice 研讨会怎么样? 

线性技术不断提供有趣的设计研讨会。在这里查看活动日程安排。 
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7.19 独立的用户组 

那么用户组呢? 

在 http://groups.yahoo.com/group/LTspice 上有一个独立的用户组。该组有一个文件部分，其中包含额外的教程、库和示

例。撰写本文时，该组织有 59817 名成员。 

 

 

 

 

 

 

 

 

 

 

 


